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STRUCTUREPOINT EVALUATION SOFTWARE LICENSE AGREEMENT

BY CLICKING THE “I AGREE” ICON BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE
OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT
LIMITED TO, THE WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW.
IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE OR USER
DOCUMENTATION, EXIT THIS APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO
STRUCTUREPOINT.

STRUCTUREPOINT, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077, GRANTS THE CUSTOMER A PERSONAL,
NONEXCLUSIVE, LIMITED, NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION
SOLELY FOR TRIAL AND EVALUATION PURPOSES ONLY IN ACCORDANCE WITH THE TERMS AND CONDITIONS OF
THIS AGREEMENT. SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY
STRUCTUREPOINT DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF STRUCTUREPOINT (HEREAFTER DEALER).

WHILE STRUCTUREPOINT HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE ANALYTICAL
SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT CANNOT AND DOES NOT GUARANTEE ITS
PERFORMANCE, NOR CAN IT OR DOES IT BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES
IN CONNECTION WITH WHICH THIS SOFTWARE MAY BE USED. DEALER (IF ANY) HAS NOT PARTICIPATED IN THE
DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER GUARANTEES THE PERFORMANCE OF THE
SOFTWARE NOR BEARS ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH
WHICH THIS SOFTWARE IS USED.

STRUCTUREPOINT AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE FUNCTIONS
CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF CUSTOMER OR OPERATE IN COMBINATIONS
THAT MAY BE SELECTED FOR USE BY CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL
"BUGS" OR PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE SPECIFICATIONS.
CUSTOMER ACKNOWLEDGES THAT STRUCTUREPOINT IS UNDER NO OBLIGATION TO PROVIDE ANY SUPPORT,
UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR THE SOFTWARE OR USER DOCUMENTATION.

THE LIMITED WARRANTIES IN SECTION 6 HEREOF ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED.
EXCEPT AS SET FORTH IN SECTION 6, THE SOFTWARE AND USER DOCUMENTATION ARE PROVIDED ON AN
"AS-1S" BASIS.

IN NO EVENT SHALL STRUCTUREPOINT OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF
STRUCTUREPOINT OR DEALER (IF ANY) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY
CLAIM AGAINST CUSTOMER BY ANY THIRD PARTY; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF
THE SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR NON
PERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE SOFTWARE OR USER DOCUMENTATION,
INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S INABILITY TO
PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER DOCUMENTATION;
(4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILITIES; (5) STRUCTUREPOINT NOT PROVIDING
UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6)
LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION
CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE OR ABUSE BY CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING,
BUT NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE WORK RELATED TO ANY
EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND
FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL
STRUCTUREPOINT BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER
UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE SOFTWARE OR USER
DOCUMENTATION.

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN CUSTOMER AND
STRUCTUREPOINT AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND USER DOCUMENTATION TO BE
FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES
ALL PRIOR COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE AND ALL ORAL
AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY STRUCTUREPOINT'S OR DEALER'S (IF ANY)
REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS
OR WARRANTIES, SHALL NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT.

1. LICENSE RESTRICTIONS

a.  Except as expressly provided in this Agreement or as otherwise authorized in writing by STRUCTUREPOINT, Customer has
no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, translate or decompile the Software or User
Documentation in whole or in part; (2) disclose, publish, release, sublicense or transfer to another person any Software or
User Documentation; (3) reproduce the Software or User Documentation for the use or benefit of anyone other than
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Customer; or (4) modify any Software or User Documentation. All rights to the Software and User Documentation not
expressly granted to Customer hereunder are retained by STRUCTUREPOINT. All copyrights and other proprietary rights
except as expressed elsewhere in the Software or User Documentation and legal title thereto shall remain in
STRUCTUREPOINT. Customer may use the Software only as licensed by STRUCTUREPOINT on designated workstation
at Customer's site at any given time. Customer may not transmit the Software licenses electronically to any other workstation,
computer, node or terminal device whether via a local area network, a wide area network, telecommunications transmission,
the Internet or other means now known or hereafter created without prior written permission by STRUCTUREPOINT.

b.  Customer acknowledges that this is a limited license for trial and evaluation purposes only. This limited license shall
automatically terminate upon the earlier of: (1) ten executions of the Software on the computer on which it is installed; or (2)
fifteen days after the installation of the Software. Thereafter, Customer may only use the Software and Documentation if it
acquires a production license for the same.

TERM AND TERMINATION

c.  This Agreement shall be in effect from the date Customer clicks the “I AGREE” icon below or installs, copies or otherwise
uses the Software or User Documentation until: (1) it is terminated by Customer, by Dealer (if any) on behalf of Customer or
STRUCTUREPOINT or by STRUCTUREPOINT as set forth herein; or (2) the limited trial and evaluation license terminates.

d.  This Agreement may be terminated by STRUCTUREPOINT without cause upon 30 days' written notice or immediately upon
notice to Customer if Customer breaches this Agreement or fails to comply with any of its terms or conditions. This
Agreement may be terminated by Customer without cause at any time upon written notice to STRUCTUREPOINT.

BACKUP AND REPLACEMENT COPIES

Customer may make one copy of the Software for back-up and archival purposes only, provided STRUCTUREPOINT's copyright
and other proprietary rights notices are included on such copy.

PROTECTION AND SECURITY

a.  Customer shall not provide or otherwise make available any of the Software or User Documentation in any form to any
person other than employees of Customer with the need to know, without STRUCTUREPOINT's written permission.

b.  All Software and User Documentation in Customer's possession including, without limitation, translations, compilations,
back-up, and partial copies is the property of STRUCTUREPOINT. Upon termination of this Agreement for any reason,
Customer shall immediately destroy all Software and User Documentation, including all media, and destroy any Software that
has been copied onto other magnetic storage devices. Upon STRUCTUREPOINT’s request, Customer shall certify its
compliance in writing with the foregoing to STRUCTUREPOINT.

c.  Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons permitted access to the
Software or User Documentation, to enable Customer to satisfy its obligations under this Agreement with respect to use,
copying, protection, and security of the same.

d.  If STRUCTUREPOINT prevails in an action against Customer for breach of the provisions of this Section 4, Customer shall
pay the reasonable attorneys' fees, costs, and expenses incurred by STRUCTUREPOINT in connection with such action in
addition to any award of damages.

CUSTOMER'S RESPONSIBILITIES

The essential purpose of this Agreement is to provide Customer with limited use rights to the Software and User Documentation.
Customer accepts full responsibility for: (a) selection of the Software and User Documentation to satisfy Customer's business needs
and achieve Customer's intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) all results
obtained from use of the Software and User Documentation; and (d) the selection, use of, and results obtained from any other
software, programming equipment or services used with the Software or User Documentation.

LIMITED WARRANTIES

STRUCTUREPOINT and Dealer (if any) warrants to Customer that: (a) STRUCTUREPOINT and Dealer (if any) has title to the
Software and User Documentation and/or the right to grant Customer the rights granted hereunder; (b) the Software and User
Documentation provided hereunder is STRUCTUREPOINT's most current production version thereof; and (c) the copy of the
Software provided hereunder is an accurate reproduction of the original from which it was made.

LIMITATION OF REMEDY

a. STRUCTUREPOINT AND DEALER (IF ANY) HAS NO LIABILITY UNDER THIS AGREEMENT. CUSTOMER'S
EXCLUSIVE REMEDY FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF ANY
SOFTWARE OR USER DOCUMENTATION, STRUCTUREPOINT, DEALER (IF ANY), OR ANY OTHER CAUSE
WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT,
INCLUDING NEGLIGENCE, SHALL BE LIMITED TO CUSTOMER STOPPING ALL USE OF THE SOFTWARE
AND USER DOCUMENTATION AND RETURNING THE SAME TO STRUCTUREPOINT.

b. NEITHER STRUCTUREPOINT NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF THIS AGREEMENT,
INCLUDING, BUT NOT LIMITED TO, THE LIMITED WARRANTIES, AND THE LIMITATION OF LIABILITY
AND REMEDY, ARE A REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN

vi
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THE SOFTWARE AND USER DOCUMENTATION FROM STRUCTUREPOINT OR DEALER (IF ANY),
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED BY
STRUCTUREPOINT AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR ALLEGED
DAMAGES IN CONNECTION WITH THE USE OF THE SOFTWARE AND USER DOCUMENTATION. THE
ESSENTIAL PURPOSE OF THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO
ALLOCATE THE RISKS AS PROVIDED ABOVE.

8. U.S. GOVERNMENT RESTRICTED RIGHTS

This commercial computer software and commercial computer software documentation were developed exclusively at private
expense by STRUCTUREPOINT, 5420 Old Orchard Road, Skokie, Illinois, 60077. U.S. Government rights to use, modify, release,
reproduce, perform, display or disclose this computer software and computer software documentation are subject to the restrictions
of DFARS 227.7202-1(a) (September 2007) and DFARS 227.7202-3(a) (September 2007), or the Restricted Rights provisions of
FAR 52.227-14 (December 2007) and FAR 52.227-19 (December 2007), as applicable.

9. GENERAL

a.

No action arising out of any claimed breach of this Agreement or transactions under this Agreement may be brought by
Customer more than two years after the cause of such action has arisen.

Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted herein or the Software or
User Documentation by operation of law or otherwise without the prior written consent of STRUCTUREPOINT. Any attempt
to do any of the foregoing without STRUCTUREPOINT s consent is void.

Customer acknowledges that the Software, User Documentation and other proprietary information and materials of
STRUCTUREPOINT are unique and that, if Customer breaches this Agreement, STRUCTUREPOINT may not have an
adequate remedy at law and STRUCTUREPOINT may enforce its rights hereunder by an action for damages and/or
injunctive or other equitable relief without the necessity of proving actual damage or posting a bond therefor.

THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE GOVERNED BY THE UNITED
NATIONS CONVENTION ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS, THE APPLICATION OF
WHICH IS EXPRESSLY EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED INTO AND PERFORMED
ENTIRELY WITHIN THE STATE OF ILLINOIS AND APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT
APPLY TO THIS AGREEMENT.

THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE COUNTY OF COOK, STATE
OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN THE COUNTY OF COOK, STATE OF ILLINOIS. ANY
ACTION RELATING TO THIS AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED
IN COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO EXTRATERRITORIAL SERVICE OF
PROCESS.

Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to the benefit of the
personal and legal representatives, permitted successors, and permitted assigns of the parties hereto.

All notices, demands, consents or requests that may be or are required to be given by any party to another party shall be in
writing. All notices, demands, consents or requests given by the parties hereto shall be sent either by U.S. certified mail,
postage prepaid or by an overnight international delivery service, addressed to the respective parties. Notices, demands,
consents or requests served as set forth herein shall be deemed sufficiently served or given at the time of receipt thereof.

The various rights, options, elections, powers, and remedies of a party or parties to this Agreement shall be construed as
cumulative and no one of them exclusive of any others or of any other legal or equitable remedy that said party or parties
might otherwise have in the event of breach or default in the terms hereof. The exercise of one right or remedy by a party or
parties shall not in any way impair its rights to any other right or remedy until all obligations imposed on a party or parties
have been fully performed.

No waiver by Customer, STRUCTUREPOINT or Dealer (if any) of any breach, provision, or default by the other shall be
deemed a waiver of any other breach, provision or default.

The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral interpretation and any
ambiguity or uncertainty herein should not be construed against any party hereto.

If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any court or competent
jurisdiction, such decision shall not have the effect of invalidating or voiding the remainder of this Agreement, it being the
intent and agreement of the parties that this Agreement shall be deemed amended by modifying such provision to the extent
necessary to render it enforceable and valid while preserving its intent or, if such modification is not possible, by substituting
therefor another provision that is enforceable and valid so as to materially effectuate the parties’ intent.

Except as set forth herein, this Agreement may be modified or amended only by a written instrument signed by a duly authorized
representative of STRUCTUREPOINT and Customer.

License Agreements vii
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STRUCTUREPOINT SOFTWARE LICENSE AGREEMENT

BY CLICKING THE “I AGREE” BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE OR
USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT
LIMITED TO, THE WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW.
IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE THE SOFTWARE OR USER
DOCUMENTATION, EXIT THIS APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO
STRUCTUREPOINT FOR A FULL REFUND WITHIN THIRTY DAYS AFTER YOUR RECEIPT OF THE SOFTWARE AND
USER DOCUMENTATION.

STRUCTUREPOINT, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077, GRANTS THE CUSTOMER A PERSONAL,
NONEXCLUSIVE, LIMITED, NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION IN
ACCORDANCE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER DOCUMENTATION
IS SUPPLIED TO CUSTOMER EITHER BY STRUCTUREPOINT DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF
STRUCTUREPOINT (HEREAFTER DEALER).

WHILE STRUCTUREPOINT HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE ANALYTICAL
SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT CANNOT AND DOES NOT GUARANTEE ITS
PERFORMANCE, NOR CAN IT OR DOES IT BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES
IN CONNECTION WITH WHICH THIS SOFTWARE IS USED. DEALER (IF ANY) HAS NOT PARTICIPATED IN THE DESIGN
OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR
BEARS ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH WHICH THIS
SOFTWARE IS USED.

STRUCTUREPOINT AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE FUNCTIONS
CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF CUSTOMER OR OPERATE IN COMBINATIONS
THAT MAY BE SELECTED FOR USE BY CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL
"BUGS" OR PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE SPECIFICATIONS.
CUSTOMER ACKNOWLEDGES THAT STRUCTUREPOINT IS UNDER NO OBLIGATION TO PROVIDE ANY SUPPORT,
UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR THE SOFTWARE OR USER DOCUMENTATION.

THE LIMITED WARRANTIES IN SECTION 7 HEREOF ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED.
EXCEPT AS SET FORTH IN SECTION 7, THE SOFTWARE AND USER DOCUMENTATION ARE PROVIDED ON AN
"AS-1S" BASIS.

IN NO EVENT SHALL STRUCTUREPOINT OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF STRUCTUREPOINT
OR DEALER (IF ANY) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST
CUSTOMER BY ANY THIRD PARTY EXCEPT AS PROVIDED IN SECTION 8 ENTITLED "INFRINGEMENT"; OR (C) ANY
DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE OR USER DOCUMENTATION UNDER THIS
AGREEMENT; (2) THE PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE
SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, INACCURACIES,
FAILURES OR CUSTOMER'S INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE
SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILITIES; (5)
STRUCTUREPOINT NOT PROVIDING UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR
USER DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE
OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE OR ABUSE BY CUSTOMER, (c) ACTS OF
THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER
CORRECTIVE WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH
AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN
NO EVENT SHALL STRUCTUREPOINT BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY
OTHER UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE SOFTWARE OR USER
DOCUMENTATION.

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN CUSTOMER AND
STRUCTUREPOINT AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND USER DOCUMENTATION TO BE
FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES
ALL PRIOR COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE AND ALL ORAL
AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY STRUCTUREPOINT 'S OR DEALER'S (IF ANY)
REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS
OR WARRANTIES, SHALL NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT.

1. LICENSE RESTRICTIONS

a.  Except as expressly provided in this Agreement or as otherwise authorized in writing by STRUCTUREPOINT, Customer has
no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, translate or decompile the Software or User
Documentation in whole or in part; (2) disclose, publish, release, sublicense or transfer to another person any Software or
User Documentation; (3) reproduce the Software or User Documentation for the use or benefit of anyone other than
Customer; or (4) modify any Software or User Documentation. All rights to the Software and User Documentation not
expressly granted to Customer hereunder are retained by STRUCTUREPOINT. All copyrights and other proprietary rights
except as expressed elsewhere in the Software or User Documentation and legal title thereto shall remain in

viii
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STRUCTUREPOINT. Customer may use the Software only as licensed by STRUCTUREPOINT on designated workstation
at Customer's site at any given time. Customer may not transmit the Software licenses electronically to any other workstation,
computer, node or terminal device whether via a local area network, a wide area network, telecommunications transmission,
the Internet or other means now known or hereafter created without prior written permission by STRUCTUREPOINT.

b.  Customer acknowledges that the registration process for the Software results in the generation of a unique license code. Once
the license code is entered DURING THE INSTALLATION PROCESS, the Software will only work on the computer on
which the Software LICENSE is INITIALLY installed. If you need to deinstall the Software license and reinstall the Software
license on a different computer, you must contact STRUCTUREPOINT to obtain the necessary reinstallation procedures.

2. CHARGES AND PAYMENTS

All payments for the Software and User Documentation shall be made to either STRUCTUREPOINT or Dealer (if any), as
appropriate.

3. TERM AND TERMINATION

a.  This Agreement shall be in effect from the date Customer clicks the “I AGREE” below or installs, copies or otherwise uses
the Software or User Documentation until it is terminated by Customer, by Dealer (if any) on behalf of Customer or
STRUCTUREPOINT or by STRUCTUREPOINT as set forth herein.

b.  This Agreement may be terminated by STRUCTUREPOINT without cause upon 30 days' written notice or immediately upon
notice to Customer if Customer breaches this Agreement or fails to comply with any of its terms or conditions. This
Agreement may be terminated by Customer without cause at any time upon written notice to STRUCTUREPOINT.

4. BACKUP AND REPLACEMENT COPIES

Customer may make one copy of the Software for back-up and archival purposes only, provided STRUCTUREPOINT's copyright
and other proprietary rights notices are included on such copy.

5. PROTECTION AND SECURITY

a.  Customer shall not provide or otherwise make available any of the Software or User Documentation in any form to any
person other than employees of Customer with the need to know, without STRUCTUREPOINT's written permission.

b.  All Software and User Documentation in Customer's possession including, without limitation, translations, compilations,
back-up, and partial copies is the property of STRUCTUREPOINT. Upon termination of this Agreement for any reason,
Customer shall immediately destroy all Software and User Documentation, including all media, and destroy any Software that
has been copied onto other magnetic storage devices. Upon STRUCTUREPOINT’s request, Customer shall certify its
compliance in writing with the foregoing to STRUCTUREPOINT.

c.  Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons permitted access to the
Software or User Documentation, to enable Customer to satisfy its obligations under this Agreement with respect to use,
copying, protection, and security of the same.

d. If STRUCTUREPOINT prevails in an action against Customer for breach of the provisions of this Section 5, Customer shall
pay the reasonable attorneys' fees, costs, and expenses incurred by STRUCTUREPOINT in connection with such action in
addition to any award of damages.

6. CUSTOMER'S RESPONSIBILITIES

The essential purpose of this Agreement is to provide Customer with limited use rights to the Software and User Documentation.
Customer accepts full responsibility for: (a) selection of the Software and User Documentation to satisfy Customer's business needs
and achieve Customer's intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) all results
obtained from use of the Software and User Documentation; and (d) the selection, use of, and results obtained from any other
software, programming equipment or services used with the Software or User Documentation.

7. LIMITED WARRANTIES

STRUCTUREPOINT and Dealer (if any) warrants to Customer that: (a) STRUCTUREPOINT and Dealer (if any) has title to the
Software and User Documentation and/or the right to grant Customer the rights granted hereunder; (b) the Software and User
Documentation provided hereunder is STRUCTUREPOINT's most current production version thereof; and (c) the copy of the
Software provided hereunder is an accurate reproduction of the original from which it was made.

8. INFRINGEMENT

a.  STRUCTUREPOINT shall defend Customer against a claim that the Software or User Documentation furnished and used
within the scope of the license granted hereunder infringes a U.S. patent or U.S. registered copyright of any third party that
was issued or registered, as applicable, as of the date Customer clicked the “I AGREE” below or installed, copied or
otherwise began using the Software or User Documentation, and STRUCTUREPOINT shall pay resulting costs, damages,
and attorneys' fees finally awarded, subject to the limitation of liability set forth in Section 9 entitled "Limitation of Remedy,"
provided that:
1. Customer promptly notifies STRUCTUREPOINT in writing of the claim.
2. STRUCTUREPOINT has sole control of the defense and all related settlement negotiations.
3. If such claim has occurred or in STRUCTUREPOINT's opinion is likely to occur, Customer shall permit
STRUCTUREPOINT at its sole option and expense either to procure for Customer the right to continue using the Software or
User Documentation or to replace or modify the same so that it becomes noninfringing. If neither of the foregoing alternatives
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is reasonably available in STRUCTUREPOINT's sole judgment, Customer shall, on one month's written notice from
STRUCTUREPOINT, return to STRUCTUREPOINT the Software and User Documentation and all copies thereof.

b.  STRUCTUREPOINT shall have no obligation to defend Customer or to pay costs, damages or attorneys' fees for any claim
based upon (1) use of other than a current unaltered release of the Software or User Documentation, or (2) the combination,
operation or use of any Software or User Documentation furnished hereunder with any other software, documentation or data
if such infringement would have been avoided but for the combination, operation or use of the Software or User
Documentation with other software, documentation or data.

c.  The foregoing states the entire obligation of STRUCTUREPOINT and Customer’s sole remedy with respect to infringement
matters relating to the Software and User Documentation.

9. LIMITATION OF REMEDY

a. STRUCTUREPOINT'S AND DEALER'S (IF ANY) ENTIRE LIABILITY AND CUSTOMER'S EXCLUSIVE REMEDY
FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF ANY SOFTWARE OR USER
DOCUMENTATION, STRUCTUREPOINT, DEALER (IF ANY), OR ANY OTHER CAUSE WHATSOEVER, AND
REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE,
SHALL BE LIMITED TO THE AMOUNT PAID TO STRUCTUREPOINT OR DEALER (IF ANY) FOR THE
SOFTWARE AND USER DOCUMENTATION.

b. NEITHER STRUCTUREPOINT NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF THIS AGREEMENT,
INCLUDING, BUT NOT LIMITED TO, THE LIMITED WARRANTIES, AND THE LIMITATION OF LIABILITY
AND REMEDY, ARE A REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN
THE SOFTWARE AND USER DOCUMENTATION FROM STRUCTUREPOINT OR DEALER (IF ANY),
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED BY
STRUCTUREPOINT AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR ALLEGED
DAMAGES IN EXCESS OF THE AMOUNT OF THE LIMITED REMEDY PROVIDED HEREUNDER. THE
ESSENTIAL PURPOSE OF THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO
ALLOCATE THE RISKS AS PROVIDED ABOVE.

10. U.S. GOVERNMENT RESTRICTED RIGHTS

This commercial computer software and commercial computer software documentation were developed exclusively at private
expense by STRUCTUREPOINT, 5420 Old Orchard Road, Skokie, Illinois 60077. U.S. Government rights to use, modify, release,
reproduce, perform, display or disclose this computer software and computer software documentation are subject to the restrictions
of DFARS 227.7202-1(a) (September 2007) and DFARS 227.7202-3(a) (September 2007), or the Restricted Rights provisions of
FAR 52.227-14 (December 2007) and FAR 52.227-19 (December 2007), as applicable.

11. GENERAL

a.  No action arising out of any claimed breach of this Agreement or transactions under this Agreement may be brought by
Customer more than two years after the cause of such action has arisen.

b.  Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted herein or the Software or
User Documentation by operation of law or otherwise without the prior written consent of STRUCTUREPOINT. Any attempt
to do any of the foregoing without STRUCTUREPOINT’s consent is void.

c.  Customer acknowledges that the Software, User Documentation and other proprietary information and materials of
STRUCTUREPOINT are unique and that, if Customer breaches this Agreement, STRUCTUREPOINT may not have an
adequate remedy at law and STRUCTUREPOINT may enforce its rights hereunder by an action for damages and/or
injunctive or other equitable relief without the necessity of proving actual damage or posting a bond therefor.

d. THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE GOVERNED BY THE UNITED
NATIONS CONVENTION ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS, THE APPLICATION OF
WHICH IS EXPRESSLY EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED INTO AND PERFORMED
ENTIRELY WITHIN THE STATE OF ILLINOIS AND APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT
APPLY TO THIS AGREEMENT.

e. THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE COUNTY OF COOK, STATE
OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN THE COUNTY OF COOK, STATE OF ILLINOIS. ANY
ACTION RELATING TO THIS AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED
IN COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO EXTRATERRITORIAL SERVICE OF
PROCESS.

f.  Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to the benefit of the
personal and legal representatives, permitted successors, and permitted assigns of the parties hereto.

g.  All notices, demands, consents or requests that may be or are required to be given by any party to another party shall be in
writing. All notices, demands, consents or requests given by the parties hereto shall be sent either by U.S. certified mail,
postage prepaid or by an overnight international delivery service, addressed to the respective parties. Notices, demands,
consents or requests served as set forth herein shall be deemed sufficiently served or given at the time of receipt thereof.
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h.  The various rights, options, elections, powers, and remedies of a party or parties to this Agreement shall be construed as
cumulative and no one of them exclusive of any others or of any other legal or equitable remedy that said party or parties
might otherwise have in the event of breach or default in the terms hereof. The exercise of one right or remedy by a party or
parties shall not in any way impair its rights to any other right or remedy until all obligations imposed on a party or parties
have been fully performed.

i.  No waiver by Customer, STRUCTUREPOINT or Dealer (if any) of any breach, provision, or default by the other shall be
deemed a waiver of any other breach, provision or default.

j- The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral interpretation and any
ambiguity or uncertainty herein should not be construed against any party hereto.

k. If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any court or competent
jurisdiction, such decision shall not have the effect of invalidating or voiding the remainder of this Agreement, it being the
intent and agreement of the parties that this Agreement shall be deemed amended by modifying such provision to the extent
necessary to render it enforceable and valid while preserving its intent or, if such modification is not possible, by substituting
therefor another provision that is enforceable and valid so as to materially effectuate the parties’ intent.

Except as set forth herein, this Agreement may be modified or amended only by a written instrument signed by a duly authorized
representative of STRUCTUREPOINT and Customer.

April 2009
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Chapter 1

spColumn is a software program for the design and investigation of reinforced concrete sections subject to
axial and flexural loads. The section can be rectangular, round or irregular, with any reinforcement layout or

Introduction

pattern. Slenderness effects can be considered.

The program offers investigation of irregularly shaped, reinforced concrete column sections that may contain
openings or boundary elements. Widely used for design of shear walls, bridge piers as well as typical framing
elements in buildings, spColumn can investigate sections that are impossible to find on design charts or do by
hand calculations. You can obtain the P-M interaction diagrams from both uniaxial and biaxial runs, as well
as the M,-M, moment contour plots from biaxial runs for even the most irregular column and shear wall

sections. Slenderness effects producing magnified moments may be included in the investigation.

Program Features

ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02, CSA A23.3-04, and CSA A23.3-94
English and SI units

Design and investigation run options

Uniaxial or biaxial flexure combined with axial load

Rectangular, circular, and irregular section geometry

Non-slender and sway or nonsway slender columns

Complete P-M and M,-M, interaction diagrams

Customizable view of interaction diagrams

Superposition of interaction diagram from a different run

Factored, unfactored, axial, and control points loading

Binary (COL) and text (CTI) input file formats

Graphical input for irregular sections

Imports geometry, reinforcement, and loads from text files

Imports section shape and reinforcement from DXF files

Exports section shape and reinforcement to DXF files

Exports graphical reports (screen printouts) to EMF files

Exports P-M diagrams, M,-M, diagrams, and 3D failure surface to TXT and CSV files
GUI (Graphical User Interface) and batch mode (command prompt) runs

Reports neutral axis location and maximum steel strain corresponding to section capacity

Reports neutral axis location, net tensile steel strain, and strength reduction factors in text output

Program Capacity

10,000 reinforcing bars within a section.
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e 10,000 exterior points that define the geometric outline of the cross section (spSection module).
e 10,000 interior points that define an opening in the cross section (spSection module).

e 5,000 factored load entries, each consisting of an axial load, a moment about the x-axis, and a moment
about the y-axis.

e 50 service load entries, each consisting of dead, live, wind, earthquake, and snow axial loads, moments at
column top about the x and y axes, and moments at column bottom about the x and y axes.

e 50 load combinations.

System Requirements

Any computer running Microsoft Windows XP, Windows Vista, or Windows 7 operating system with 32 or
64 bit processing is sufficient to run the spColumn program. For instructions on how to troubleshoot system
specific installation and licensing issues, please refer to support pages on StructurePoint website at
www.StructurePoint.org.

Terms
The following terms are used throughout this manual. A brief explanation is given to help familiarize you
with them.
Windows refers to the Microsoft Windows environment as listed in System Requirements.
[] indicates metric equivalent
Click on means to position the cursor on top of a designated item or location and press and

release the left-mouse button (unless instructed to use the right-mouse button).

Double-click on  means to position the cursor on top of a designated item or location and press and
release the left-mouse button twice in quick succession.

Conventions
To help you locate and interpret information easily, the spColumn manual adheres to the following text
format.
Italic indicates a glossary item, or emphasizes a given word or phrase.
Bold indicates the name of a menu or a menu item command such as File or Save.
Mono-space indicates something you should enter with the keyboard. For example “c:\*.txt”.
KEY + KEY indicates a key combination. The plus sign indicates that you should press and hold the
first key while pressing the second key, then release both keys. For example, “ALT +
F” indicates that you should press the “ALT” key and hold it while you press the “F”
key. then release both keys.
SMALL CAPS Indicates the name of an object such as a dialog box or a dialog box component. For

example, the OPEN dialog box or the CANCEL or MODIFY buttons.

Installing, Purchasing and Licensing spColumn

For instructions on how to install, purchase, and license StructurePoint software please refer to support pages
on StructurePoint website at www.StructurePoint.org.

1-2 Introduction
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Chapter 2

Method of Solution

A - Definitions and Assumptions

1.

The analysis of the reinforced concrete section performed by spColumn conforms to the provisions of the
Strength Design Method' and Unified Design Provisions” and is based on the following assumptions.
a) All conditions of strength satisfy the applicable conditions of equilibrium and strain compatibility’

b) Strain in the concrete and in the reinforcement is directly proportional to the distance from the
neutral axis®

¢) The maximum usable (ultimate) strain at the extreme concrete compression fiber is assumed equal to
0.003 for ACI codes® and 0.0035 for CSA codes® unless otherwise specified by the user

d) A uniform rectangular concrete stress block is used. For ACI code’, the maximum uniform concrete
compressive stress, f., is 0.85f; and the block depth is B,c, where ¢ is the distance from the

extreme compression fiber to the neutral axis and P, is described in item 4 below. For CSA®, f, is
taken as:

f, =(0.85-0.0015f7)f. > 0.67f, , where f! is in MPa
Both f, and 3; can be modified by the user.

e) Concrete displaced by the reinforcement in compression is deducted from the compression block’

f) For the reinforcing steel, the elastic-plastic stress-strain distribution is used'®. Stress in the
reinforcing steel below the yield strength, f, , is directly proportional to the strain. For strains greater
than that corresponding to the yield strength, the reinforcement stress remains constant and equal to
f,.

g) Tensile strength of concrete is neglected''.

h) Reinforcement bars are located within section outline.

The modulus of elasticity of concrete, E_, is computed as follows (unless otherwise specified by the
user):

E, =57,000,/f! , for the ACI code'? where f! and E_ are in psi,
E, =4,700,/f! , for the ACI code'” where f! and E, are in MPa.

For the CSA standard, E_ =3,518,/f/ +7,355, where f! and E_ are in MPa.

! For CSA A23.3-04 (Ref. [6]) and CSA A23.3-94 (Ref. [7])

2 For ACI 318-11 (Ref. [1]), ACI 318-08 (Ref. [2]), ACI 318-05 (Ref. [3]) and ACI 318-02 (Ref. [4]); also see notes on ACI 318-08,
8.1.2 in Ref. [9]

* ACI 318-11, 10.2.1; ACI 318-08, 10.2.1; ACI 318-05, 10.2.1; ACI 318-02, 10.2.1; CSA A23.3-04, 10.1.1; CSA A23.3-94,10.1.1

* ACI 318-11, 10.2.2; ACI 318-08, 10.2.2; ACI 318-05, 10.2.2; ACI 318-02, 10.2.2; CSA A23.3-04, 10.1.2; CSA A23.3-94,10.1.2

> ACI318-11,10.2.3; ACI 318-08, 10.2.3; ACI 318-05, 10.2.3; ACI 318-02, 10.2.3

® CSA A23.3-04, 10.1.3; CSA A23.3-94,10.1.3

" ACI318-11, 10.2.6; ACI 318-08, 10.2.6, 10.2.7; ACI 318-05, 10.2.6, 10.2.7; ACI 318-02, 10.2.6, 10.2.6

8 CSA A23.3-04,10.1.1; CSA A23.3-94,10.1.1

° For consistency with Eq. 10-1 and 10-2 in ACI codes (Refs. [1], [3], [4]) and with Eq. 10-10 in CSA codes (Refs. [6], [7])

1" ACI 318-11, 10.2.4; ACI 318-08, 10.2.4; ACI 318-05, 10.2.4; ACI 318-02, 10.2.4; CSA A23.3-04, 8.5.3.2; CSA A23.3-94,8.5.32
" ACI 318-11, 10.2.5; ACI 318-08, 10.2.5; ACI 318-05, 10.2.5; ACI 318-02, 10.2.5; CSA A23.3-04, 10.1.5; CSA A23.3-94,10.1.5
2 ACI 318-11, 8.5.1; ACI 318-08, 8.5.1; ACI 318-05, 8.5.1; ACI 318-02, 8.5.1

B ACI318M-11, 8.5.1; ACI 318M-08, 8.5.1; ACI 318M-05, 8.5.1; ACI 318M-02, 8.5.1
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The modulus of elasticity of reinforcing steel'”, E_, is taken as 29,000 ksi (200,000 MPa) unless

s
otherwise specified by the user.
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Figure 2-1 Analysis of Reinforced Section

The ratio of the concrete compression block depth to the distance between the extreme compression fiber
and the neutral axis, [, is computed as follows (unless otherwise specified by the user):

0.65<B, =1.05—-0.05f! < 0.85, for the ACI code'® where f! is in ksi,
0.65<PB, =(149—1!)/140 < 0.85, for the ACI code'’ where f! is in MPa.
For the CSA standard'®, B, =0.97—0.0025f] > 0.67 , where f is in MPa.

Stress in the reinforcement is computed based on the strain at the centroid of each reinforcing bar.

All moments are referenced to the geometric centroid of the gross concrete section (neglecting the
reinforcement).

For the ACI codes, the nominal (unreduced) capacity of the section is first computed. Then, the nominal
capacity is reduced to the design capacity using the strength reduction factor, ¢, the value of which is

calculated based on the net tensile steel strain, €, , in the following way'’:

e For columns with spiral reinforcement per ACI 318-11 and ACI 318-08

" CSA A23.3-04, 8.6.2.3, Eq. 8.1 and CSA A23.3-94, 8.6.2.3, Eq. 8-6 (with y, = 2400 kg/m’)

15 ACI 318-11, 8.5.2; ACI 318-08, 8.5.2; ACI 318-05, 8.5.2; ACI 318-02, 8.5.2; ACI 318M-05, 8.5.2; ACI 318M-02, 8.5.2; CSA A23.3-
04,8.5.4.1; CSA A23.3-94,8.5.4.1

16 ACI 318-11, 10.2.7.3; ACI 318-08, 10.2.7.3; ACI 318-05, 10.2.7.3; ACI 318-02, 10.2.7.3

17 ACI 318M-11, 10.2.7.3; ACI 318M-08, 10.2.7.3; ACI 318M-05, 10.2.7.3; ACI 318M-02, 10.2.7.3

'8 CSA A23.3-04, 10.7.1(c); CSA A23.3-94, 10.7.1(c)

9 ACI 318-11, 9.3.2, 10.3.3, 10.3.4; ACI 318-08, 9.3.2, 10.3.3, 10.3.4; ACI 318-05, 9.3.2, 10.3.3, 10.3.4; ACI 318-02, 9.3.2, 10.3.3,
10.3.4

2-2

Method of Solution
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0.9 if €, >0.005 (tension controlled section)
0.20 (g, —f,/E,) N .
$¢=1075+——————= if f,/E, <& <0.005 (transition section)
0.005—f, /E
0.75 if &, <f, /E, (compression controlled section)

e  For columns with spiral reinforcement per ACI 318-05 and ACI 318-02

0.9 if €, > 0.005 (tension controlled sec tion)
0.20 (¢, ~f, /E,)
¢=40.70+ ———— = if f, /E, <¢g, <0.005 (transition section)
0.005-1, /E, vy
0.70 if &, <f, /E, (compression controlled section)

e  For other columns per ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02

0.9 if €, > 0.005 (tension controlled section)
0.25(8t—fy/Es) . N .
¢=10.65+———————= if f, /E  <g <0.005 (transition section)
0.005-1, /E
0.65 if g, <f,/E, (compression controlled sec tion)
pA
Pmax
¢
A (Mnapn) ¢(M p)
0.9 _= OPmax Compression

R~ 0.80Pumax controlled
0.75 or 0.7 4 SPiral”_ .-

0.65 $(Mn,Pn)

Other Transition

T > > T zone
|| & M
—= 0.005 (Ma,Pn)
Es ;
Tension
OPrmin controlled
Compression Transition zone Tension Prin
controlled Controlled

* Spiral sections in compression controlled zone: ¢ = 0.75 per ACI 318-11/08 and ¢ = 0.70 per ACI 318-05/02
Figure 2-2 Reduction factors for Flexural and Axial Capacity per ACI code

Figure 2-2 illustrates variation of the strength reduction factor with net tensile strain in extreme tension
steel and the impact of the strength reduction factor on the axial and flexural capacity interaction
diagram. It is worth noting that in the transition between compression controlled and tension controlled
zones, the nominal axial capacity, P,, decreases whereas the value of net tensile strain increases and so
does the strength reduction factor, ¢. Consequently, the resulting factored axial capacity (i.e. the product
of nominal axial capacity and the strength reduction factor), $P,, may either increase or decrease in the
transition zone depending on the rates of axial force decrease and strength reduction increase for the
section under consideration. Typically, the rate of axial capacity decrease dominates over the rate of
strength reduction increase and thus the factor axial load capacity decreases as well. For certain classes
of sections (e.g. sections having a narrowing in the middle such as hollow core section, T-shaped, L-
shaped, and I-shaped sections), however, the reverse may be true resulting in the factored axial load
capacity increase in the transition zone between compression controlled and tension controlled zones (see
Figure 2-3). This unusual increase in axial load capacity is not illustrated by interaction diagrams
produced by the program and is not considered for design and investigation of cross-sections. It will be
flagged to inform the user, however, when the program is run using Control Points as the load type.
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e For the CSA standards, the program calculates the factored resistance directly using the factored
compressive concrete strength®, ¢.f!, and the factored forces in reinforcement bars®', ¢.S,. The

material resistance factor for concrete, ¢, equals

0.6

for CSA A23.3-94

¢, =40.65 for CSA A23.3-04 (cast-in-place)
0.70 for CSA A23.3-04 (precast)

The material resistance factor for steel, ¢, is equal to 0.90.

Additionally, the design axial capacity (for all ACI and CSA standards) is capped® at 0.85 of the
maximum axial capacity for sections with spiral reinforcement or at 0.80 for sections with tie

reinforcement.

A

Balanced point
g =fJE,

Typical decrease in
/_\ axial capacity between
balanced and tension

control points

Tension control
point ¢, = 0.005

Balanced point
g = f/E,

Unusual increase in
axial capacity between
balanced and tension

control points
k Tension control
point g, = 0.005

Actual spColumn representation
of P-M interaction curve

Figure 2-3 Shapes of P-M interaction diagram in transition zone for ACI codes

In the investigation mode the program will calculate capacity for any provided area of reinforcement.
However, if the reinforcement area falls below the code-specified”® minimum of 0.01 times the gross
area, A,, then two options, Architectural or Structural, are available.

20 CSA A23.3-04,8.4.2,16.1.3; CSA A23.3-94,8.4.2
2 CSA A23.3-04, 8.4.3; CSA A23.3-94,8.4.3
2 ACI 318-11, 10.3.6; ACI 318-08, 10.3.6; ACI 318-05, 10.3.6; ACI 318-02, 10.3.6; CSA A23.3-04, 10.10.4; CSA A23.3-94, 10.10.4
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By default Architectural option is selected for which the capacity of the section is reduced. For the ACI
codes, the reduction results from multiplying the maximum concrete stress, f., by the ratio of

reinforcement area to 0.01A,. This produces the same effect as reducing the effective concrete area’ to
achieve ratio of reinforcement area to gross concrete area equal to 0.01. For the CSA standards®, the

factored axial and flexural resistances are multiplied by ratio O.5(l+pt / 0.01) for the 04 edition and
p,/0.01 for the 94 edition.

For Structural option, the section is treated “as is” without any reductions in capacity. This option is
provided for informational purposes only, since per all codes supported by spColumn, capacity of
compression members with reinforcement area less than 0.01A, has to be reduced and areas below
0.005A, are not allowed.

9. Under the Design option, the reinforcement ratio cannot be less than 1.0% if Structural column type is
selected in design criteria and 0.5% in case of Architectural column type. For Architectural type, the
capacity of the designed column is reduced as described above. Additionally, User Defined type is
provided in the design criteria, which allows designs with reinforcement ratios not less than 0.1%. No
reduction in capacity is applied for User Defined column type.

10. Maximum reinforcement ratio®® for Structural and Architectural options in both Investigation and
Design modes is 8%. For User Defined type in the Design mode the maximum reinforcement ratio is set
to 20%.

B — Conventions

1. Positive axial forces are compressive and negative axial forces are tensile.

2. Looking in plan at the section with z-axis pointing outwards, the positive x-axis points to the right and
the positive y-axis points up. For this section, vectors of positive bending moments have the same
orientation as their corresponding axes x and y. Thus, a positive bending moment about the x-axis, M,
produces tension at the top face of the section and compression at the bottom face. A positive bending
moment about the y-axis, My, produces tension at the left face of the section and compression at the right

face.
z
M, Y z
P / N
A :M\ X y
N
M, << < X
v 7
M, P
Top Bottom

Figure 2-4 Positive axial force and bending moments (internal forces)

3. If service loads are input, moment loads at the upper (top) and lower (bottom) ends of the column are
needed. Top and bottom moment loads of opposite signs produce single curvature bending. Top and
bottom moment loads of the same sign produce double curvature bending.

Positive moment loads at the upper end of the column coincide with positive bending moments.
However, at the lower end, positive moment loads produce effects opposite to positive bending moments.

3 ACI318-11, 10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-04, 10.9.1; CSA A23.3-94, 10.9.1
> ACT318-11, 10.8.4; ACI 318-08, 10.8.4; ACI 318-05, 10.8.4; ACT 318-02, 10.8.4

2 CSA A23.3-04, 10.10.5; CSA A23.3-94, 10.10.5

% ACI318-11,10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02, 10.9.1; CSA A23.3-04, 10.9.2; CSA A23.3-94, 10.9.2
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Therefore spColumn changes the sign of the service moment at the lower end to convert it from a
moment load to a bending moment.

Axial load is assumed to be constant so it is input only as for the upper end where positive axial load
coincides with positive axial force.

4. If factored loads are input, they are considered to be applied at a section pointing upwards so that they
have the same orientations as positive axial force and positive bending moments.

2|
M/

Figure 2-5 Positive moment loads (external forces)

»p M,

5. The convention for the slenderness input of beam and column dimensions and their orientation is
presented in Figure 2-6. Beams above the columns are shown. Same convention applies to beam below
the column.

z Y

Left X-Beam

Left Right

X
Y-Beam

o~
<
<

Right

Column

Figure 2-6 Slenderness Input Convention
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C - Section Investigation

1. The computations performed when investigating a section depend on the selected load mode:

a) Factored loads — for the axial load of each load point, the moment capacity and the ratio of design-
to-applied moment are computed. For a biaxial run, the computed M, and My moment capacities are
at the same angle as that produced by the applied My and My moments. In uniaxial case the program
also reports the depth of neutral axis and maximum steel strain corresponding to the calculated
moment capacity. For the ACI code, the value of strength reduction factor is also reported.

spColumn allows defining up to 50 load combinations. The user has full control over the
combinations. The program contains predefined (built into the program) default primary load
combinations for the supported codes. These default combinations are created when starting a new
project. The default load combinations of the Dead (D), Live (L), Wind (W), Earthquake (E) and
Snow (S) loads considered by the program are shown below. For the ACI 318-11, 08, 05, and 02

codes”’:
Ul
U2
U3
U4
Us
U6
u7
U8
U9
Ul10
Ull
Ul12
Ul3

1.4D

1.2D + 1.6L +0.5S

1.2D +1.0L + 1.6S

1.2D + 0.8W + 1.6S

1.2D +1.0L + 1.6W + 0.5S
0.9D + 1.6W

1.2D - 0.8W + 1.6S

1.2D +1.0L — 1.6W + 0.5S
0.9D - 1.6W

1.2D +1.0L +1.0E - 0.2S
0.9D +1.0E

1.2D +1.0L — 1.0E + 0.2S
09D - 1.0E

For the CSA A23.3-94 code?®:

Ul
U2
U3
U4
U5
U6
U7
U8
U9
Ul10
Ull
Ul2
Ul3
Ul4
Ul5
uUle6
u17

1.25D

1.25D+1.5L

1.25D + 1.5L + 1.5S

1.25D + 1.05L + 1.05W

1.25D + 1.05L + 1.05W + 1.05S
1.25D + 1.5W

0.85D + 1.5W

1.0D +1.0L + 1.0E

1.0D +1.0L + 1.0E + 1.0S

1.0D + 1.0E

1.25D + 1.05L — 1.05W

1.25D + 1.05L — 1.05W + 1.05S
1.25D - 1.5W

0.85D - 1.5W

1.0D+1.0L — 1.0E
1.0D+1.0L - 1.0E + 1.0S

1.0D - 1.0E

For the CSA A23.3-04 code”:

2 ACI 318-11, 9.2; ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2; (assuming W based on service-level wind load and E based on

ultimate-level forces)

2 CSA A23.3-94, 8.3.2 (conservatively assuming storage and assembly occupancies)

Method of Solution
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b)

¢)

d)

Ul = 1.4D

U2 = 1.25D+1.5L

U3 = 1.25D + 1.5L +0.5S
U4 = 1.25D + 1.5L + 0.4W
us = 1.25D + 1.5L — 0.4W
U6 = 0.9D + 1.5L

u7 = 09D + 1.5L +0.5S
Us = 0.9D + 1.5L + 0.4W
u9 = 09D + 1.5L - 0.4W
uUl10 = 1.25D + 1.58

Ull = 1.25D +0.5L + 1.5S
Ul12 = 1.25D + 0.4W + 1.5S
Ul13 = 1.25D - 0.4W + 1.5S
Ul4 = 0.9D + 1.5S

Ul5 = 09D +0.5L + 1.5S
Ule6 = 09D +0.4W + 1.5S
ul17 = 0.9D - 0.4W + 1.5S
Ul18 = 1.25D + 1.4W

ul19 = 1.25D + 0.5L + 1.4W
U20 = 1.25D + 1.4W + 0.5S
U21 = 1.25D - 1.4W

U22 = 1.25D + 0.5L — 1.4W + 0.5S
U23 = 1.25D - 1.4W + 0.5S
U24 = 0.9D + 0.5L + 1.4W
U25 = 0.9D + 0.5L + 1.4W
U26 = 0.9D + 1.4W +0.5S
u27 = 09D - 1.4W

U28 = 09D + 0.5L — 1.4W
uU29 = 0.9D - 1.4W +0.5S
U30 = 1.0D + 1.0E

U3l = 1.0D + 0.5L + 1.0E + 0.25S
U32 = 1.0D - 1.0E

U33 = 1.0D + 0.5L — 1.0E + 0.25S

Service loads — the program calculates the factored loads using the input load combinations. If
slenderness effects are to be checked and the column is found to be slender, the applied moments are
magnified according to Procedures E and F. For each calculated factored load, the same
computations described in (a) above are performed.

Control points — for several key points on the interaction diagram, the program calculates axial load
and moment capacity together with the neutral axis depth and maximum steel strain corresponding to
the respective moment capacity. For ACI code, strength reduction factor is also reported. The
following key points are used by the program: maximum compression, allowable compression, point
where steel stress is zero, point where steel stress is 0.5f,, balanced point, pure flexure and

maximum tension. For ACI code, an additional control point is introduced where maximum steel
strain is equal to 0.005 (tension control limit).

Axial loads — for each input axial load, the program calculates the positive and negative moment

capacities together with the corresponding neutral axis depths and maximum steel strains. For ACI
code, strength reduction factors are also reported.

¥ CSA A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2
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2. The program also computes the interaction diagram (uniaxial runs) or the three-dimensional failure
surface (biaxial runs) of the input section. The values of maximum compressive axial load capacity and
maximum tensile load capacity are computed. These two values set the range within which the moment
capacities are computed for a predetermined number of axial load values.

a) For uniaxial runs, positive and negative moment capacities about only the selected axis are
computed. Moment capacities about the orthogonal axis are ignored. To compute the moment
capacity at a certain level of axial load, the neutral axis angle is held constant, parallel to the selected
axis. The neutral axis depth is adjusted to arrive at the desired axial load capacity. This is done for
all the predetermined values of axial load.

b) For biaxial runs, the same predetermined values of axial load are utilized. For each level of axial
load, the section is rotated in 10-degree increments from 0 degrees to 360 degrees and the My and M,
moment capacities are computed. Thus for each level of axial load, an My-My contour is developed.
Repeating this for the entire range of axial loads, the three-dimensional failure surface is computed.

Also for each point on the interaction diagram or on the three-dimensional failure surface, the program
calculates the location of the neutral axis (expressed in terms of depth and angle of the neutral axis),
maximum steel strain, and (for ACI codes only) the strength reduction factor.

P
M,-M; slice M,
at constan A=arctan—>
My
P
— = %g\ [ <
= < BREY
Py
P-M slice at
constant A
Mx MY
P
M
red A
M;,
s
}\ =
s
S
o
o > M
g A
s
n
c
e
(a) Moment slice at constant load P, (b) Half of P-M slice at constant angle A

Figure 2-7 Interaction Surface for Combined Axial Load and Biaxial Bending
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D — Section Design

1.

Based on the specified minimum, maximum and increment specified for the section and the reinforcing
bars, the program selects the smallest section with the least amount of reinforcement for which the load-
moment capacity exceeds the applied loads. If service loads are input, they are factored using the input
load combinations. Depending on the design criteria the user selects, the least amount of reinforcement
the program searches for means either the smallest number of bars or the smallest steel area.

The program starts the design by trying the smallest section (minimum dimensions) and the least amount
of reinforcing bars. The program verifies that the ratio of provided reinforcement is always within the
specified minimum and maximum ratios. Furthermore, unless otherwise specified by the user®’, the bar
spacing is always kept greater than or equal to the larger of 1.5 times the bar diameter or 1.5 in. [40 mm)]
for ACI®' and 1.4 times the bar diameter or 1.2 in [30 mm] for CSA*.

A section fails the design if, for the design axial load, the ratio of design-to-applied moment is less than
1.0 (unless otherwise specified in the Design Criteria dialog box).

Once a section passes the design, its capacity is computed and the calculations explained in Procedure C
above are performed.

E — Moment Magnification at Ends of Compression Member

This procedure accounts for moment magnification due to second-order effects at ends of columns in sway
frames™’.

1.

If properties of framing members are input, spColumn computes the effective length factor, k, for sway
condition using the following equation™*:

2
(Tf/ks) VYaAVB _1ltan " —[ YA +V¥p T o
36 6 k

S S

where v is the ratio of £(EI/¢,) of columns to Z(EI/€) of beams in a plane at one end of the column,
y, and yp are the values of y at the upper end and the lower end of the column. For a hinged end, v
is very large. This happens in the case where Z(EI/ 8) of beams is very small (or zero) relative to the
Z(EI/¢,) of columns at that end. In this case, the program outputs 999.9 for the value of . The

moment of inertia used in computing y is the gross moment of inertia multiplied by the cracked section
coefficients® (specified in the Slenderness Factors dialog box).

For the ACI code®®, slenderness effects will be considered if k¢, /r>22.0. For the CSA standards, all
sway columns are designed for slenderness effects.

If the ratio k¢, /r exceeds 100, slenderness effects cannot be accounted for using moment magnification

procedure®’. A more exact method must be used. In this case, the program issues a warning message and
aborts design or investigation procedure except for calculations per ACI 318-11 and ACI 318-08 where
limit of k€, /1 <100 does not explicitly apply and the program continues calculations after showing the

warning message.

%% The user may select spacing greater than the default value to take into account tolerances for reinforcement placement (see ACI 117-

06, Ref [5]) and other project specific considerations.

3T ACI 318-11, 7.6.3; ACI 318-08, 7.6.3; ACI 318-05, 7.6.3; ACI 318-02, 7.6.3
32 CSA A23.3-04, Annex A, 6.6.5.2; CSA A23.3-94, Annex A, A12.5.2

% ACI 318-11, 10.10.7; ACT 318-08, 10.10.7; ACT 318-05, 10.13; ACI 318-02, 10.13; CSA A23.3-04, 10.16, CSA A23.3-94, 10.16

** Exact formula derived in Ref. [12] pp. 851 for Jackson and Moreland alignment chart
* ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-05, 10.11.1, 10.13.1; ACI 318-02, 10.11.1, 10.13.1; CSA A23.3-04,

10.14.1.2, 10.16.1; CSA A23.3-94, 10.14.1, 10.16.1

% ACT318-11, 10.10.1; ACT 318-08, 10.10.1; ACI 318-05, 10.13.2; ACI 318-02, 10.13.2
7 ACI 318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-04, 10.13.2; CSA A23.3-94, 10.13.2
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4. Factored moments, M, . and M, , due to dead, live, and snow loads assumed to cause no
appreciable sidesway™®, are calculated at the top and bottom ends of the column.
5. Factored moments, M, and M, due to lateral loads (wind and earthquake) assumed to cause
appreciable sidesway™, are calculated at the top and bottom ends of the column.
6. Flexural stiffness EI is calculated as*’:
- 0.2E I, + E I
1+ By
where E_ is the modulus of elasticity of concrete, Eg is the modulus elasticity of steel, I, is the gross

moment of inertia of the concrete section, I, is the moment of inertia of reinforcement. Assuming that
shear due to lateral loads is not sustained in most frames*', the B, is taken as zero (with the exception of
strength and stability of the structure as a whole under factored gravity loads described in Step 11).

7. The critical buckling load, P, is computed as¥:
n’El
(k1,)?

8. The sway moment magnification factor, 3, is computed as*:

C

1.0
& = E >1.0,
O 2P,
where the stiffness reduction factor, ¢, , is equal to 0.75.
P, is taken as the factored axial load for the load combination under consideration times the
ratio=P, /P, ,ie.** P, =P, (ZP, /P,).
2P, is taken as the critical buckling load for the load combination under consideration times the ratio
2P, /P,,ie. ZP, =P (ZP,/P,).
¢, and the ratios XP, /P, and XP /P, may be modified using the Slenderness Factors input box.

9. The magnified moments at the top and bottom ends of the compression member are computed as*’:

Mtop = Mns,top + 8slv[

Mbot = Mns,bot + 8slv[s,bot :

s,top *

10. The smaller and the larger factored end moments are then determined based on absolute values of
magnified top and bottom end moments

¥ ACI318-11,2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

¥ ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

0 ACI 318-11, 10.10.6 Eq. 10-14; ACI 318-08, 10.10.6 Eq. 10-14; ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10;
CSA A23.3-04, 10.16.3.2, 10.15.3 Eq. 10-18; CSA A23.3-94,10.16.3.2, 10.15.3.1 Eq. 10-18

1 ACT 318-11, R10.10.7.4; ACT 318-08, R10.10.7.4; ACT 318-05, R10.13.4.1, R10.13.4.3; ACT 318-02, R10.13.4.1, R10.13.4.3; Ref.
[10] pp 586 (first paragraph from the bottom)

*2 ACI 318-11, 10.10.6 Eq. 10-13; ACI 318-08, 10.10.6 Eq. 10-13; ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA
A23.3-04,10.16.3.2, 10.15.3.1 Eq. 10-17; CSA A23.3-94,10.16.3.2, 10.15.3 Eq. 10-17

# ACI 318-11, 10.10.7.4 Eq. 10-21; ACI 318-08, 10.10.7.4 Eq. 10-21; ACI 318-05, 10.13.4.3 Eq. 10-18; ACI 318-02, 10.13.4.3 Eq. 10-
18; CSA A23.3-04, 10.16.3.2 Eq. 10-23; CSA A23.3-94, 10.16.3.2 Eq. 10-23

* To minimize required input, the program uses one value of ratio =P,/ P, for all load combinations. However, the ratio can vary
depending on the combination under consideration. In this case, it will be conservative to use the highest value of the ratio.

# ACI 318-11, 10.10.7; ACT 318-08, 10.10.7; ACI 318-05, 10.13.3; ACI 318-02, 10.13.3; CSA A23.3-04, 10.16.2; CSA A23.3-94,
10.16.2
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M. = Mbot if |Mtop 2|Mbot|’
1 Mtop if |Mtop <|Mbot|’
M. = Mtop if |Mtop 2 |Mb0t|7
’ Mbot if |Mtop < |Mbot|'

While design codes define moment M, as always positive and the sign of moment M; depending on
single or double curvature bending46, spColumn retains actual signs of moments M; and M,. This
revision ensures proper comparison against negative and positive moment capacities of unsymmetrical
sections (see Figure 2-8).

11. Strength and stability of the structure as a whole under factored gravity loads*’ is ensured by checking
that the value of the moment magnification factor, J;. is positive and does not exceed 2.5.

The program performs this check for all load combinations that include only gravity loads with the
exception of the ACI 318-11 and ACI 318-08 codes for which the check is not performed and CSA
A23.3-94 where the check is performed only for the load combination of 1.25 dead load plus 1.5 live
load plus (1.5 snow or 0.0 snow), if this combination is present (default). The P, factor for the load
combination under consideration is equal to the maximum sustained factored axial load to the maximum
factored axial load.

F — Moment Magnification along Length of Compression Member

This procedure accounts for moment magnification due to second-order effect along the length of
compression members that are part of either nonsway®® or sway frames®. In nonsway frames, moment
magnification along length is neglected by the program if the condition in Step 3 below is satisfied.

In sway frames designed per ACI 318-02/05 and CSA A23.3-94/04, the magnification along the length is
neglected if*’:

& 35
r | P, '
A,

By rearranging and introducing k' = /P, /(fc’Ag) , this condition can be succinctly expressed as k¢, /r<35.

For columns designed per ACI 318-11 and ACI 318-08 codes, moment magnification along length is to be
considered for all slender compression members, i.e. columns in either nonsway or sway frames regardless of
the k'¢, /r ratio. Since various published examples of columns designed per ACI 318-11 and ACI 318-08 do
not combine moment magnification at ends and along length of columns in sway frames’', spColumn
optionally allows not considering moment magnification along the length of a column in a sway frame based
on engineering judgment of the user.

When moment magnification along the length of a compression member is considered, the following
procedure is followed:

1. The effective length factor, k, is either entered by the user or calculated by the program. The value of k
must be between 0.5 and 1.0 for moment magnification along length and the recommended™ value is

* ACT318-11,2.1; ACI 318-08, 2.1; ACT 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

7 ACT 318-05, 10.13.6; ACI 318-02, 10.13.6; CSA A23.3-04, 10.16.5; CSA A23.3-94, 10.16.5

* ACI318-11, 10.10.6; ACI 318-08, 10.10.6; ACI 318-05, 10.12; ACI 318-02, 10.12; CSA A23.3-04, 10.15; CSA A23.3-94, 10.15

# ACI 318-11, 10.10.2.2; ACI 318-08, 10.10.2.2; ACI 318-05, 10.13.5; ACI 318-02, 10.13.5; CSA A23.3-04, 10.16.4; CSA A23.3-94,
10.16.4

50 ACI 318-05, Eq. 10-19; ACI 318-02, Eq. 10-19; CSA A23.3-04, Eq. 10-25; CSA A23.3-94, Eq. 10-25

3! See Example 11.2 in Ref. [9], Example 12.4 in Ref. [11], and Example 12.3 in Ref. [10]

2 ACI 318-11, 10.10.6.3, R10.10.6.3; ACI 318-08, 10.10.6.3, R10.10.6.3; ACT 318-05, 10.12.1; ACT 318-02, 10.12.1; CSA A23.3-04,
10.15.1; CSA A23.3-94, 10.15.1
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1.0. Smaller values can be used if justified by analysis. If properties of framing members are input,
spColumn computes the effective length factor, k, for nonsway condition from the following equation™:

2
Vavp|m | (vatyp ), __mk | 2 o® _,
4 | g2 2 tan(n/k)) m/k 2k

Where  is the ratio of £(EI/¢,) of columns to (EI/€) of beams in a plane at one end of the column,

v, and yp are the values of y at the upper end and the lower end of the column, respectively.
Moments of inertia used in computing y factors are gross moments of inertia multiplied by the cracked
section coefficients™* (specified in the Slenderness Factors dialog box).

2. Moments at column ends, M; and M., are calculated, where M, is the moment with the smaller absolute
value and M, is the moment with the larger absolute value. For columns in nonsway frames, the end
moments will be equal to the factored applied first order moment. For columns in sway frames, the end
moments will be the moments M; and M, calculated in the procedure for moment magnification at ends
of compression member. While design codes define moment M, as always positive and the sign of
moment M, depending on single or double curvature bending®, spColumn retains actual signs of
moments M; and M, to ensure proper comparison of resulting magnified moments against negative and
positive moment capacities of unsymmetrical sections (see Figure 2-8). This revised interpretation does
not affect results of the moment magnification along length procedure because the procedure relies on
the M/M, ratio. spColumn follows the code definition which assumes the ratio to be positive if the
member is bent in single curvature and negative if bent in double curvature. If both moments are equal to
zero, the program conservatively assumes the ratio of M;/M, =1.0.

3. Second-order effects along length for columns in nonsway frames can be ignored if:

ﬂ < 34—12& <40 for ACI codes™,

r M,

and

% < M , for the CSA standards”’
r P /(f1A,)

where ¢, is the unsupported column length, r=/I,/A is the radius of gyration, and the ratio M, /M,
is always taken as greater than or equal to —0.5.

4. Ifthe ratio k¢, /r exceeds 100, slenderness effects cannot be accounted for using moment magnification

procedure>®. A more exact method must be used. In this case, the program issues a warning message and
aborts design or investigation procedure except for calculations per ACI 318-11 and ACI 318-08 where
limit of k&, /r <100 does not explicitly apply and the program continues calculations after showing the

warning message.

5. The factor C,, is computed as™:

M
C,=06+04—L,
2

%3 Exact formula derived in Ref. [12] pp. 848 for Jackson and Moreland alignment chart

% ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-05, 10.11.1, 10.12.1; ACI 318-02, 10.11.1, 10.12.1; CSA A23.3-04,
10.14.1.2, 10.15.1; CSA A23.3-94, 10.14.1, 10.15.1

3 ACI318-11,2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

¢ ACI 318-11, 10.10.1; ACI 318-08, 10.10.1; ACI 318-05, 10.12.2; ACI 318-02, 10.12.2

7 CSA A23.3-04, 10.15.2; CSA A23.3-94, 10.15.2

¥ ACI 318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-04, 10.13.2; CSA A23.3-94, 10.13.2

%Y ACI 318-11, 10.10.6.4; ACI 318-08, 10.10.6.4; ACI 318-05, 10.12.3.1; ACI 318-02, 10.12.3.1; CSA A23.3-04, 10.15.3.2; CSA A23.3-
94,10.15.3.1
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and for codes other than ACI 318-11 and ACI 318-08, C,, is taken as not less than 0.4.
If M, =M, =0, the program assumes C,, to be equal to® 1.0. This is consistent with the assumption
made above (in Step 2).

6. The sustained load factor B4, is computed as the ratio of maximum factored axial sustained load to the

maximum factored axial load for the load combination under consideration for compression members
either in nonsway®' or sway® frames. The value of B, is not taken greater than 1.0.

7. Flexural stiffness EI is computed as®:
El= 02EIL, +E]I
I+ Bdns
where E_ is the modulus of elasticity of concrete, E;is the modulus of elasticity of steel, I, is the gross

moment of inertia of the concrete section, and I, is the moment of inertia of reinforcement.
8. The critical buckling load, P, , is computed as™:
_ m°El
= .
(k&)

9. The magnification factor for moment along length, &, is computed as®:

C

=—m >
1 P, >1.0,
1—
(I)ch

where the stiffness reduction factor, ¢, , is equal to 0.75 (may be modified using the Slenderness Factors

input box) and P, is the factored axial load for the load combination under consideration.

10. The moment due to minimum eccentricity, e is computed as®:

min *

M. =P e where

min u “min *

€in =0.6+0.03 h, with h in inches,
€in =15+0.03 h, with h in mm,
and h is the section dimension (diameter for circular sections) in the direction being considered.
11. The factored magnified moment along the length of a compression member, M_, is the larger®” of M,

and OM, ;. . The program also calculates moment M, based on the smaller end moment, M, to account

for scenario when M, and M, are of different sign (double curvature bending). For an unsymmetrical
section, the smaller moment, M, may govern the design when the moment capacity on the negative side
of the interaction diagram is smaller than the moment capacity on the positive side (see Figure 2-8).

% ACT318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-02, 10.12.3.2

" ACI318-11, 10.10.6.2; ACI 318-08, 10.10.6.2; ACI 318-05, 10.11.1; ACI 318-02, 10.0; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

¢ ACI 318-11, 10.10.2.2, 10.10.6.2; ACI 318-08, 10.10.2.2, 10.10.6.2; ACI 318-05, 10.13.5; ACI 318-02, 10.13.5; CSA A23.3-04,
10.14.1.3(a), 10.16.4; CSA A23.3-94, B4 definition (a) in 10.0, 10.16.4

% ACI 318-11, 10.10.6.1 Eq. 10-14; ACI 318-08, 10.10.6.1 Eq. 10-14; ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10;
CSA A23.3-04,10.15.3 Eq. 10-18; CSA A23.3-94,10.15.3.1 Eq. 10-18

* ACI 318-11, 10.10.6 Eq. 10-13; ACI 318-08, 10.10.6 Eq. 10-13; ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA
A23.3-04,10.15.3.1 Eq. 10-17; CSA A23.3-94, 10.15.3 Eq. 10-17

% ACI 318-11, 10.10.6 Eq. 10-12; ACT 318-08, 10.10.6 Eq. 10-12; ACT 318-05, 10.12.3 Eq. 10.9; ACT 318-02, 10.12.3 Eq. 10.9; CSA
A23.3-04,10.15.3.1 Eq. 10-16; CSA A23.3-94, 10.15.3 Eq. 10-16

% ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318M-05, 10.12.3.2; ACI 318-02, 10.12.3.2; ACI 318M-
0210.12.3.2; CSA A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3.

7 ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-02, 10.12.3.2; CSA A23.3-04, 10.15.3.1; CSA A23.3-
94,10.15.3

2-14

Method of Solution



sfcolumn

BM] M] MZ 6MZ

Figure 2-8 Case of unsymmetrical section bent in double curvature (M; and M, of different sign)
with the smaller end moment, M;, governing the design

G - Ratio of Moments Due To Second-Order Effects to Moments Due To First-Order Effects

For calculations in accordance with ACI 318-11 and ACI 318-08, the value of total magnified moment
including second-order effects (combined magnification at ends and along length of compression member)
cannot exceed 1.4 times the corresponding moment due to first order effects®®. Columns with second-order
moment to first-order moment ratios exceeding 1.4 do not meet requirements of ACI 318-11 and ACI 318-08.

The ratio of second-order moment, My, to first-order moment My is calculated for both values (i =1, 2) of
magnified moment along length, Mci, i.e. based on M, and M,:

Mo g M| =M
M2ndi _ Mu| ‘
Mg | M,
Ist; o Cf if ‘Mui <|Mmin|

min

Cutoff value of M, is applied to Mui in order to avoid unduly large ratios in cases where Mui moments are
smaller than M,,;,.
If only magnification at ends is considered (i.e. when user chooses to bypass provision 10.10.2.2 of ACI 318-

11/08 and ignores second order effects along the length of a compression member in a sway frame), the ratio
of second-order moment, M,,q4, to first-order moment, M, is calculated at both ends (i =1, 2) as:

M2ndi — Mi — Mins +65Mis
Mlsti M ; Mins + Mis

Y

where M; are the magnified end moments M, and M,, and MLli are the corresponding factored applied moment

composed of the part that causes no appreciable sidesway, M;,s, and the part that causes appreciable sidesway,
M. If both M2ndi and Mlsti moments are equal to zero, the program will report the ratio equal to 1.0. If only

M, moment is equal to zero, the program will report the ratio as a large value.

% ACT318-11,10.10.2.1; ACI 318-08, 10.10.2.1
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Chapter 3

spColumn Interface

Main Window

Most windows have certain elements in common, such as a title bar and menus. Not all windows, however,
have every element. To learn more about how to use window elements, refer to your Microsoft Windows
manual. The following is a list of the spColumn window components.

$P spColumn - (Untitled) [M=E]

fle Input Sobe WView Options Help

[ER[E[=] [D]E [O[O[C] [Slelolole [ [ [FTsTClATw] [ RN ETETE [FlEE]

Ec = 3605 ksi
fc = 3.4 ksi
Betal = 0.85
fy = 60 ksi

Es = 29000 ksi

Heavis; AT 31811 Investigation

Control-Menu Box:
The Control-menu box is located in the upper-left corner of the window and includes commands for sizing,
moving, enlarging, restoring, and closing the window, as well as switching to other applications. To access
the Control-menu box using the mouse, click the left mouse button on the box; using the keyboard, press
ALT+* “(space).
Title Bar:
The Title bar displays the name of the application (spColumn in this case), along with the name of the current
data file in use. If the data have not been saved into a file, the word Untitled is displayed in the Title bar.
Menu Bar:
The Menu bar is located directly below the Title bar. It lists the available menus. A menu contains a list of
commands or actions you can execute.
Tool Bar:
The Tool bar is located directly below the Menu bar. It contains a collection of buttons (or icons) that provide
a shortcut to accessing the menu commands. The Tool bar buttons can only be accessed using the mouse.
Information Bar:

The Information bar is located on the left side of the spColumn window. The top part displays the column
cross section. The bottom part is a list of selected input data echo.
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Graphics Area:
The Graphics area covers most of the window. This is where the interaction diagram is shown.

Status Bar:

The Status bar is located along the bottom of the window. It displays important information such as units,
design code, cursor position, and helpful messages.

File Menu

The File menu is used for working with data files, printing results, and exiting the program.

New (CTRL+N)
. Mew Chrl+h
Clears any input data and returns the data to the default values so that a Open... O
new data file may be input. Save Ctrl+5
Save Bs...
Open (CTRL+0) Impart '
Export ]
Opens an existing spColumn data file.
Save (CTRL+S)
: i le01.col
Saves the changes you have made to the current data file under that ;Eti:gg:zz E:EEEEEEEZEEEE;Z'
same filename. 3 C\Program Files\Struc, . \Example03.col
4 C:\Program Files\Struc, . \Example04, col
Save As Exit

Names or renames a data file.

Import

Reads geometry, reinforcement or loads data from an ASCII (TXT) file, or imports section geometry and
reinforcement from a DXF file.

Export

Exports interaction diagram and 3D failure surface to Comma-Separated Values (CSV) files (readable by
most spreadsheet programs) or Tab-Delimited Text (TXT) files. Exports a column section to Drawing
Exchange Format (DXF) file (readable by most CAD programs). Exports graphical report (screen printout) to
Enhanced Metafile Format (EMF) file (readable by most graphics and word processing programs).

Revert

Discards any changes to the data and returns to the last version of saved data. This option will only be
available if the file has been modified since the last file save.

Print Results
Displays Print dialog box and prints the results in the text form to the selected printer.

Print Screen (CTRL+P)
Displays Print dialog box and prints the results similarly as they appear on the screen.

Recent Data File List
Provides quick access to up to four recently open data files.

Exit

Quits the spColumn program. If you have made any changes to your data and have not saved them, spColumn
will prompt you whether you want to save or abandon any changes you have made before you exit.
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Input Menu

The Input menu includes commands used to input the data needed to define a problem.

General Information General Information,

Material Properties...

Input labels to identify the input and select from several options that control the run.
Section
Reinforcement

Material Properties Slendermess

Loads

rvr T o

Input the material properties for concrete and reinforcement.
Flip/Rotate Section...

Section
Rectangular: Input the dimensions of a rectangular section.

Circular: Input the dimension of a circular section.

Irregular: Execute spSection to define an irregularly shaped section. See Chapter 6.

Reinforcement

All Sides Equal: Input a reinforcement pattern in which all the bars are of one size, and the number of bars is
the same on all four sides of a rectangular layout or are equally spaced for a circular layout. Available for
rectangular and circular sections.

Equal Spacing: Input a reinforcement pattern in which all bars are of one size and are uniformly spaced on
all four sides of a rectangular layout. Available for rectangular sections only.

Sides Different: Input a reinforcement pattern in which each one of the four sides of a rectangular section has
a certain number of bars and a certain bar size. Available for rectangular sections only.

Irregular Pattern: Input a reinforcement pattern in such a way that bars of any size can be placed anywhere
within the column section.

Confinement: Input confinement-related data such as the capacity reduction factors and the size of ties
associated with the longitudinal bar size.

Design Criteria: Input parameters that govern the design of the section such as column type, minimum and

maximum reinforcement ratio, bar selection criterion, minimum clear spacing, and design/required ratio.

Slenderness
Design Column: Input data needed for slenderness related to the column being considered.

Column Above/Below: Input data needed for slenderness related to the columns above and below the design
column.

X-Beams: Input data needed for slenderness related to beams perpendicular to the x-axis framing into the
design column.

Y-Beams: Input data needed for slenderness related to beams perpendicular to the y-axis framing into the
design column.

Factors: Input factors that affect slenderness calculations.

Loads
Factored: Input factored axial loads and moments. This command is available for non-slender columns only.
Service: Input service-level (dead, live, wind, earthquake, and snow) axial loads and moments about the

active axis. Moments are input at the top and at the bottom of the column. This command must be used for
slender columns.

The spColumn Window 3-3
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Control Points: If chosen, the program will compute key points on the interaction diagram. In addition, the
splice regions are shown on the interaction diagram. This option is available for short (non-slender) columns
under the investigation option only and for uniaxial runs only.

Axial Loads: Input a group of axial loads with an initial value, a final value, and an increment. This
command is available for uniaxial short (non-slender) columns only.

Load Combinations: Input the load factors and combinations used to combine the service loads.

Flip/Rotate Section
Flip an unsymmetrical section about an axis or rotate an irregular section (created in spSection).

Solve Menu

The Solve menu contains the command used to perform the design or investigation
and options that control inclusion of nominal capacity calculations, tracing through
the design process, and sending the output to a text file.

Execute FS

Inchude Mominal Diagram

v Results Filz

Execute (F5)
Executes the solver.

Include Nominal Diagram
Toggles INCLUDE NOMINAL DIAGRAM option on and off.

Design Trace
Toggles DESIGN TRACE option on and off.

Results File
Toggles RESULTS FILE option on and off.

View Menu

The View menu commands used to customize the display screen to suit your viewing needs, view the
interaction diagram at a given angle, view the contour for a given axial load, superimpose an interaction
diagram or a contour from another run, and view the results file.

Redraw Redraw
Redraws the displayed diagrams or contours. Copy Diagram to Clipboard Ctri+C
v Information Bar
Copy Diagram to Clipboard (CTRL+C) v Tool Bar
v Status Bar
Copies the displayed diagram or contour to clipboard so that in can be rid
pasted in other applications. MMy Diagram

v P-M Diagram - Ful
P-M Diagram - M pasitive

I nformatlon Bar P-M Diagram - M negative

Shows or hides the Information bar.

Tool Bar
Shows or hides the Tool bar. b Load Pt Labels
Status bar v Show Nominal Diagram
Shows or hides the Status bar. SHperimpose...
Results, .. F&

Grid
Shows or hides the grid.
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Mx-My Diagram
View a contour of the failure surface sliced at a constant axial load.

P-M Diagram - Full
View an interaction diagram sliced at a constant (M, M,) angle drawn for both positive and negative
moments.

P-M Diagram - M positive
View an interaction diagram sliced at a constant (My, M,) angle drawn for the positive moments only.

P-M Diagram - M negative
View an interaction diagram sliced at a constant (M, My) angle drawn for the negative moments only.

Next Load (Ctrl + Arrow Up)

View an M,-M; interaction diagram for the factored load next to the one displayed currently on the
interaction diagram.

Previous Load (Ctrl + Arrow Up)

View an M,-M; interaction diagram for the factored load previous to the one displayed currently on the
interaction diagram.

Next Angle

View a P-M interaction diagram at the (M,, M,) angle corresponding to factored load next to the one
currently in the graphics area.

Previous Angle

View a P-M interaction diagram at the (M, M,) angle corresponding to factored load previous to the one
currently in the graphics area.

Show Load Point Labels
Show/Hide Load Point labels of factored loads input.

Show Splice Lines
Show the P-M splice lines corresponding to f; = 0 and f; = 0.5f;,

Show Nominal Diagram

Show nominal (unfactored) capacity interaction diagram in addition to the design (factored) capacity
interaction diagram. Available only when Include Nominal Diagram option is selected in the Solve menu.

Superimpose
Superimpose a diagram from a previously saved run over the current diagram.

Results (F6)
View the results file after a successful run has been performed with the Solve | Results File option ON.

Options
The Options menu contains commands used to view or change spColumn’s default Startup Defals,..
settings and reinforcement bar set. Reinforcement. .

Startup Defaults
View or Edit application startup default settings.
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Reinforcement
View or Edit reinforcing bar set.

Help Menu
spCalumn Help...
SpCOIUmn Help spColumn Manual, ..
Lists all the available help topics about the program. Command Line Help...
Check for Updates, ..
SpCOIUmn Manual About spColuran...

Opens spColumn Manual in the default PDF viewer.

Command Line Help
Displays help on how to use command line parameters for running spColumn in batch mode.

Check for Updates
Checks if a newer version of the program is available. Internet connection is required.

About spColumn
Shows the version number of the program, the licensing information, and the copyright information. In the
case of a trial license, the expiration date is given as well as the locking code which is needed to obtain a
standalone license.
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Chapter 4

Operating the Program

This chapter is divided into sections that follow the order in which commands and options appear in the
program.

Creating New Data File

When spColumn is first loaded, the program is ready to obtain input for a new file. The data will not have a
file name associated with it; therefore, Untitled appears in the Title bar.

e Select File | New. This clears the screen and returns to the default settings of the program. If existing data
have been changed prior to selecting the New command, spColumn asks if you want to save the data. At
any time after starting a new file, use the File | Save As command to give the file a name.

Opening Existing Data File

You can open spColumn data files that were previously saved to disk. spColumn reads files that have been
saved in binary format (with COL extension) or text input format (with CTI extension).

e Select File | Open. A dialog box appears.

o All files with the COL extension contained in the current drive and directory are displayed in the FILE
NAME list box.

e To open a file that exists in another drive or directory, select the drive or directory you want from the
LOOK IN drop-down list.

e To open a file in spColumn Text Input (CTI) format®, use FILE TYPE list box to select this type.
e From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.

e Choose the OK button.

Open @@

Look jr: |_} Examples j & EE-
- | ﬂ xarnple0l,col @examplelﬁ.col
uﬁ ﬂ Exampledz.col @ examplel?.col

My Recent ﬂ Example03.cal @ exampleld.cal
Documents ﬂ Example04.col
ﬂ Example0s,cal
ﬂ Example0s.col
Desktop ﬂ Example0?.col
ﬂ Exarmpledd.col
ﬂ Example0d.cal
ﬂ Example10,cal
ﬂ Example11.cal
ﬂ Example12.col

2

\\.'

My Documents

-
l_-_‘J ﬂ Example13.col
[
o Cmmutiey J examplel4.col
ﬂ examplelS.col
y
My Metwork  File name: |ExampIeD1 .cal ﬂ pen |
Places
Files of type: |spEqumn Input Files [.col) ﬂ Cancel

% See Appendix for description of the CTI format
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Saving Data

To save the data with the same file name:

At anytime while editing a data file that has previously been saved under a file name, choose File | Save to
save the changes under the same file name. Selecting the File | Save command before giving the data file a
name displays the Save As dialog box.

To give the data a new or different file name or to change input file format:
e Select File | Save As. A dialog box appears.

e All files with COL extension contained in the current drive and directory are displayed in the FILE NAME
list box.

o To save the file to a drive or directory other than the default, select a different drive or directory drive
from the SAVE IN drop-down list.

e Use FILE TYPE list box to select either spColumn Input File (COL) or spColumn Text Input File (CTT).

e In the FILE NAME text box, type a new file name. If no file extension is specified, an extension will be
appended to the specified file name based on the selected file type.

e  Choose the OK button.

Save As @

Save jn; |_} Examples ﬂ &F Bl
- |

My Recent
Documents

Desktop

)

My Documents

oy

Iy Computer

|

“

>
My Netwark, File name:
Places

warnple0]. chi ﬂ Save |
Save as bpe: | peaColumn Text Input File [*.cti) j Cancel

Importing

Importing Data

Geometry, reinforcement or load data may be imported from a text file. The import file must be saved in pure
ASCII (text) format.”

Import Data (from text file)

e Select File | Import | Import Data... or press CTRL + I keyboard shortcut to @ Geomeiry;
display IMPORT DATA dialog box. " Reinforcement

" Service loads

e Select the type of data you want to import: SERVICE LOADS, FACTORED LOADS, f* Factored loads

REINFORCEMENT OR GEOMETRY. Coreel
e Choose the OK button. The Open Import file box is displayed.

™ See Appendix for description of the import file format
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o All files with the TXT extension contained in the current drive and directory are displayed in the FILE
NAME list box.

e To open a file that exists in another drive or directory, select the drive or directory you want from the
LOOK IN drop-down list.

e From the File Name list box, select the file to be opened, or simply type its name in the text box.

e  Choose the OPEN button.

Importing DXF Files
o Select File | Import | Import DXF.... to display Open Import file box.

e All files with the DXF extension contained in the current drive and directory are displayed in the FILE
NAME list box.

e To open a file that exists in another drive or directory, select the drive or directory you want from the
LOOK IN drop-down list.

e From the File Name list box, select the file to be opened, or simply type its name in the text box.
e Choose the OPEN button.

e The DXF IMPORT LAYER SELECTION dialog box is displayed.

spColumn - DXF Import Layer Selection

Seleck layer ta impart the section From.
Click Skip button to select layer aukomatically,

e Type the layer name (default is “0”) to import the section from and click the OK button. To search the
whole file, press the SKIP button or provide an empty name.

If the DXF file (or selected layer) contains a closed polyline entity (either LWPOLYLINE or POLYLINE) it
will be interpreted as the section outline. If multiple closed polylines are present then the fist two will be
automatically recognized as the outline and the opening and the rest will be ignored.

Reinforcing bars are derived from DXF circle entities (CIRCLE). If no closed polylines are present then the
first circle entity will be interpreted as a circular shape of the column and the rest will be interpreted as
reinforcing bars.

Dimensions of imported entities will be automatically converted to current project units based on DXF header
variable SINSUNITS.

Exporting Data

Once a successful run has been performed you may export points from the
interaction diagram or 3D failure surface to a Comma-Separated Values (CSV) file
or to a Tab Delimited Text file (TXT). These files can be read by most spreadsheet orinal Interaction Disgram...
and mathematical programs where data produced by spColumn can be further Marninal 30 Failure Surface...
analyzed and processed as needed by the user. Coordinates of the points (P, M,, Column Section b DXF Fie.

M,) are saved together with corresponding location of the neutral axis (depth and Graphical Report to EMF Fil..
angle), maximum steel strain, and (for ACI code) strength reduction factor. The

column section can be exported to a file in Drawing Exchange Format (DXF) format that is readable by most
CAD programs. A graphical report can be exported to a file in Enhanced Metafile Format (EMF) that is
readable by most graphics and word processing programs. The file will include column section, column
information, and the interaction diagram currently displayed on the screen presented the same way as in the
printout created by the default printer using the File | Print Screen command.

Factored Interaction Diagram...
Factored 30 Failure Surface...

e Select File|Export|Factored Interaction Diagram to export P-M or M,-M, diagram currently
displayed on the screen.
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To export 3D failure surface (biaxial runs only) select File | Export | Factored 3D Failure Surface.

Select File | Export | Nominal Interaction Diagram to export nominal (unfactored) P-M or M,-M,
diagram corresponding to the one currently displayed on the screen.

To export nominal (unfactored) 3D failure surface (biaxial runs only) select File | Export| Nominal
3D Failure Surface.

To export column section to DXF file select File | Export | Column Section to DXF File.
To export graphical report to EMF file select File | Export | Graphical Report to EMF File.

For interaction diagrams and 3D failure surface, use FILE TYPE list box to select either Comma-Separated
Values (CSV) file or Tab Delimited Text file (TXT). For sections, only DXF format is available and for
graphical reports, only EMF format is available.

In the FILE NAME text box, type the file name. If no file extension is specified, an extension will be
appended to the specified file name based on the selected file type.

Choose the OK button.

Export Current P-M Diagram

2X

Save jr |_} Examples j = E-

&

My Recent
D ocuments

?_.%
Desklop
My Documents

-
s
by Computer

2
by Metwork, File name:
Flaces

j Save
[

Cancel

i

Save as lype: |Eomma-Separated Walues Files [*.cav)

Printing Results

Once a successful run has been performed you may print the displayed diagram using File | Print Screen
command. If the Solve | Results File option was selected you may print the results file using File | Print
Results. spColumn sends the printout to the printer selected in the Print dialog box.

Select File | Print Results or File | Print Screen. A dialog box appears.
Select the printer to send the results to.
Use Print dialog controls to set up the printer options.

Choose the OK button to start the printing or choose the CANCEL to terminate the print job.
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& print

Gereral l

Select Printer

123 Microsoft Office Docurnent Image Wriker

Microsoft ¥PS Document Wriker

G on pca-sry-dc2

<

Status: Feady
Location:  Stucture Point Group Offices

Comment: Multifunction printer

FPage Range
o Al
" Selection

© r

&‘a OKI B4545 Metwork{Ok-B4545-2
a‘a PaperPort Black & White Image
3‘; PaperPort Color Image

>

™ Print to file  Preferences
Find Printer...

Mumber of copies: |1 El:

DI

FErint |

Cancel |

General Information

The General Information command allows you to define or change options that

will affect the rest of the input.

e Select Input | General Information. A dialog box appears.

e Enter the PROJECT, COLUMN, and ENGINEER labels.

e Select the units of measure, ENGLISH or METRIC.

e Select the axis about which the column capacity is to be computed: ABOUT

X-AXIS, ABOUT Y-AXIS, or BIAXIAL.

e Seclect the design code to conform to: ACI318-11, ACI 318-08, ACI 318-05,

ACI 318-02, CSA A23.3-04 or CSA A23.3-04.

e Choose a run option: INVESTIGATION or DESIGN.

e Specify whether slenderness effects are to be considered or not by checking
either YES or NO under the CONSIDER SLENDERNESS? option.

e  Choose the OK button.

Material Properties

General Information

Labels

X

Praoject:

Column: Engineer:

Unitz Fiun Option

& English & |rwestigation

" Metric " Design

Run Axiz Design Code

(& AboutAxis || @ AC ST

" Abaut Y-Axis " ACI 31808

" Biaial AT 31805
" ACI 318-02

Congider slenderness? © Yes * No

QK

" C54A23304
O C5AA23394

LCancel

e Select Input | Material Properties. A dialog box appears.

e Enter the concrete compressive strength, ', under STRENGTH, f’c. The modulus of elasticity, E., under
ELASTICITY, Ec; the constant stress intensity, f, at the maximum usable strain used to calculate the force
on concrete, under MAX STRESS, fc; the factor used to determine the depth of the stress block, under
BETA(1); and the maximum usable strain at the extreme concrete compression fiber, at the ULTIMATE
STRAIN are automatically computed and displayed. Modify any of the values if different that computed.

e For the reinforcing steel, enter the yield strength, f, under STRENGTH, fy, and the modulus of elasticity, E,

under the ELASTICITY, Es.

e Choose the OK button.
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Material Properties E|

Concrete Reinfarcing Steel

Strength, f'e: ki Strength, fy: E0 ksi

Elasticity, Ec: 3805 ks Elasticity, Es:  |29000  ksi

Max stress, fo |34 ksi
Betal1]: 085
Ultimate strain: |0.003

Qg Lancel

Section / Rectangular

Input for the Investigation Option:
e Select Input | Section | Rectangular. A dialog box appears.

e Enter the width and depth of the rectangular section using WIDTH (ALONG

Rectangular Section E|

Width [along =) |10 in
X) and Depth (dlong ¥ [200  in

DEPTH (ALONG Y) respectively. Note that width is measured along the x-axis and

depth is measured along the y-axis.

e Choose the OK button.

Input for the Design Option:
e Select Input | Section | Rectangular. A dialog box appears.

e Enter the starting and ending values for each dimension (width and
depth) along with an increment for each dimension under START, END
and INCREMENT columns along WIDTH (ALONG X) and DEPTH (ALONG
Y). Note that the starting and ending values may be the same (in which
case the increment must be zero).

Rectangular, Section

Stant End  Increment

Wwidth [along =) |10 20 2 in
Depth [along ). |20 30 2 in

ok Lancel |

e Choose the OK button.

Section / Circular

Input for the Investigation Option:
e Select Input | Section | Circular. A dialog box appears.

e Enter the diameter of the column section.

e  Choose the OK button.

Input for the Design Option:
e Select Input | Section | Circular. A dialog box appears.

o Enter the starting and ending values the diameter along with an
increment. Note that the starting and ending values may be the same (in
which case the increment must be zero).

e Choose the OK button.

Reinforcement / All Sides Equal

Circular Section F‘5__<|

Diamneter: in

Lancel

Circular Section

Start End Increment

Diameter: |20 a0 2 in

ok Lancel |

The Input | Reinforcement | All Sides Equal command allows you to enter

the total number of bars in the

column section. The program attempts to divide the bars equally between the four sides of a rectangular

46
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layout then equally space them on each side. Corner bars are associated with the top and bottom sides, and if
the total number of bars is not a multiple of four, the top and bottom sides get the extra bars. For a circular
layout, the program attempts to equally space the bars.

Input for the Investigation Option:

AlL Sides Equal ]
Select Input | Reinforcement | All Sides Equal. A dialog box

appears. Mo. of barg: ’4— ey L

* Rectangular

Bar size: #a -

Enter the total number of bars in the section. It must be at least 4 and " Circular

must be a multiple of 4 for a rectangular layout. For a circular layout it | eareever 15 in
Coverto

can be any number not less than 4.

rsz " Longitudinal bars

Select the bar size.

Enter the clear cover and specify whether it is to the transverse (ties) = Concel_|

or to the longitudinal bars.

Select a bar layout, CIRCULAR or RECTANGULAR. The default is Circular for a circular section and
Rectangular for a rectangular section.

Choose the OK button.

Input for the Design Option

Select Input | Reinforcement | All Sides Equal. A dialog box

AlL Sides Equal '
appears. dl ]
o et Cover to
o . . . P axirnum
Enter the minimum and maximum total number of bars in the Novotbas [I— FT— @ Transverse bars
: . o. of bars: ‘S T
section (must be at least 4 and must be a multiple of 4 for a Longitudinal bars
rectangular layout). Barsie:  [#3 —| |[#18 x| - BarLayout
) * Rectangular
.. . . . Clear cover. 1.4 in
Select the minimum and maximum bar sizes along with the clear £ Circular
cover.
ak. Lancel |

Enter the clear cover and specify whether it is to the transverse
(ties) or to the longitudinal bars.

Select a bar layout, Circular or Rectangular. The default is Circular for a circular section and Rectangular
for a rectangular section.

Reinforcement / Equal Spacing

The Input | Reinforcement | Equal Spacing command allows you to enter the total number of bars in the
column section. The program attempts to place the bars equally spaced on all four sides of a rectangular
layout. Corner bars are associated with the top and bottom sides and if the total number of bars is not a
multiple of 4, the program does not accept the input.

Input for the Investigation Option:

Select Input | Reinforcement | Equal Spacing. A dialog box - .
Equal Spacing §|

appears. i
. . Caver to

Enter the total number of bars in the section NO. OF BARS. (Must be | Me-afbars: |4 G e

at least 4 and a multiple of 4). Barsze |88 | | Longiuding bars

Select the bar size. Oeemier ||EN|

Enter the clear cover and specify whether it is to the transverse (ties) 0K Cancel

or to the longitudinal bars.

Choose the OK button.
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Input for the Design Option:
e Select Input | Reinforcement | Equal Spacing. A dialog box appears.
X

Equal Spacing

Minimum — Masimum — Cover to

No. of bars: |4 L (% Transverse bars
#1 | |#18 || O Longitudinal bars
Clear cover: |1.5 in

Bar size:

LCancel |

e Enter the minimum and maximum total number of bars in the section under MINIMUM and MAXIMUM
corresponding to NO. OF BARS. (must be a multiple of 4).

e Select the minimum and maximum bar sizes.
o Enter the clear cover and specify whether it is to the transverse (ties) or to the longitudinal bars.

e  Choose the OK button.

Reinforcement / Sides Different

Input for the Investigation Option:

e Select Input | Reinforcement | Sides Different. A dialog box

appears.
PP Sides Different

3
e  Enter the number of bars to be placed on each of the top, bottom
(on the top and bottom, number of bars needs to be at least 2),
left and right sides (on the left and right, the number of bars may
be any number) of the rectangular section. Note that corner bars

are associated with the top and bottom sides.

Top Bottorn  Left Right

Mo, of bars: |8 |4 |5
[#18 ~| [ms ~||ms ~|[ms ~|

[1.5 [15

Bar size:

Clear cover: |1 5 |1 5 in

Cover to

e Select the bar size and enter the clear cover for each of the top,
bottom, left and right sides of the section.

¢ Transverse bars  { Longitudinal bars

e Specify whether the clear cover entered is to the transverse (ties) mx (Epee]

or to the longitudinal bars.

e  Choose the OK button.

Input for the Design Option:
e Select Input | Reinforcement | Sides Different. A dialog box

appears.

X

Sides Different

In the Top and Bottom group, enter the minimum and maximum
total number of bars to be placed on the top and bottom sides,

along with the bar size and the clear cover. The number of bars |"* " e e o o
must be greater than 4 and a multiple of 2. Corner bars are |Basze | |4z ~[|wmz «| [0 -f[0s o]
associated with the top and bottom sides. Clear caver. | [15 in 15 i

Covwer to

Select the minimum and maximum bar size and enter the clear
cover.

Repeat the steps above for the Left and Right sides.

Specify whether the clear cover entered is to the transverse (ties)
or to the longitudinal bars.

Choose the OK button.

Top and Bottom

Minirnurn b asirnum

Left and Right

Hinirmurn b awirum

@ Tiansverse bars ¢ Longitudinal bars

oK

LCancel
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Reinforcement / Irregular Pattern

The Input | Reinforcement | Irregular Pattern command allows you to specify any number of bars (up to
10,000) to be placed anywhere within the column section. Each bar may have any cross-sectional area. This
command is available with the Investigation option only.

e Select Input|Reinforcement | Irregular Pattern. If the section is

irregular, The spSection window, where the section reinforcement may [ i ELIL U uAT LN

be graphically input, is displayed. Otherwise, a dialog box appears. Area wiood  Y-Cood
o Enter the bar area, along with its x- and y-coordinates. EAz |i:'5 |i:'5
e Choose the INSERT button. The data are added to the list box. [[(nset | Modiy | Deete |
e  Repeat the steps above for each entry. | No. Area X v
e To edit an entry, select it from the list box, modify its values in the text é % 4:5: 1425

boxes, and choose the MODIFY button. To change the area for several
bars at once, select those bars from the list box, enter the new area in the
AREA text box, and choose MODIFY.

e To delete a bar entry, select it from the list box and choose the DELETE
button. Ok Cancel

e  Choose the OK button.

Reinforcement / Confinement

e Select Input | Reinforcement | Confinement. A dialog box appears.

e Select the type of bar confinement: TIED (default), SPIRAL, or Other. The capacity reduction factors
change depending on the selection.

e To modify the capacity reduction factors, choose OTHER for confinement type.

For the ACI code:
Phi(a) is the reduction factor for allowable compression, .
Confinement E|
Phi(b) is the strength reduction factor for tension controlled failure
( ) & ’ Canfinement: A
Phi(c) is the reduction factor for compression controlled failure. Capacity Reduction Factors, Phi
For the CSA code: Ayial compression [a): l_
Tension-controlled Failure (b): l_
Phi(a) is the reduction factor for allowable compression, Compression-sontioled fane (¢} [065
Phi(s) is the material resistance factor for steel, Tioies
Phi(c) is the material resistance factor for concrete. #3 x| teswith [110 ] bars or smaler.
. . . . . . . . #4 | ties with larger bars.
e Specify the tie size associated with the particular longitudinal bar
sizes. The code requirements are used as defaults. | Carce |

e Choose the OK button.

Note that if confinement is selected as TIED or SPIRAL than the program will automatically adjust the factors
when the user changes the design code. However, if OTHER confinement is selected, the factors will not be
adjusted.

Reinforcement / Design Criteria

e Select Input | Reinforcement | Design Criteria. A dialog box appears. This command is available with
the Design option only.
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o Specify whether the column is to be considered STRUCTURAL
(default), ARCHITECTURAL, or OTHER. Notice that the minimum and
maximum reinforcement ratios change depending on the selection.

Design Criteria E|
Colurin Type Reinfarcement R atio
o Stuchral Mimimurn: l_ X
e Choose whether bar selection is to be based on MINIMUM NUMBER OF " Architectural Masiarn: [T %
BARS (default) or on MINIMUM AREA OF STEEL. ¢ Userdsfined

e To modify the limiting reinforcement ratios, choose OTHER. Enter the Bar Selection
minimum and maximum reinforcement ratios in the corresponding | | & Minimum number of bars

text boxes. ™ Minimumn area of steel
e Enter the minimum clear bar spacing and the design-to-required ratio. Minimum clear spacing between bars; |15 in
Diesign/F equired ratio: 'T
e  Choose the OK button.
s LCancel |
Slenderness / Factors
e Select Input | Slenderness | Factors. A dialog box appears. Note: this g EG—_— X

command is available for slender columns only.
" Code defaults +

e  The default values, per the design code, for the stiffness reduction factor (used
to compute the moment magnification factors) and the cracked section
coefficients for beams and columns are displayed. To modify these values,

Stiffress reduction factor: |0.75

Cracked-section coefficients

select the USER-DEFINED option and enter your values. Bearms (clb} 035
Columns [clc): 0y

e  Choose the OK button.

s | LCancel |

Slenderness / Design Column

e Select Input | Slenderness | Design Column. A dialog box appears. The x-axis or y-axis data groups
may be disabled depending on the active run axis. Note: this command is available for slender columns
only.

e Enter the clear column height in the corresponding text box.

e Specify whether the column is braced against sidesway or not by selecting or clearing the NONSWAY
FRAME option.

e For a sway column, enter the ratio of the sum of JUESERem
the critical load of all story columns to the critical | s s
load of the column under consideration, Clear beight:  [225  ft Clear height:  [225 1
(SuM PC)/Pc. Also, enter the ratio of the sum of " Nansway frams € Monsway frame
the factored axial load of all story columns to the @ Swap frame & Sway frame
factored axial load of the column under Sway crieria Sway ciiteria
consideration, (SUM PU)/PuU. Check 2" ORDER (GumPelPel 1 [SumPelPel [T
EFFECTS ALONG LENGTH option to consider (Sum PulPul 1 (SumPuldPu: [T
Z“d order effects along length Note: thIS Option iS ¥ 2'vd order effects along length v 2'nd order effects along length

available for ACI 318-11 and ACI 318-08 codes

. . - . - Effective length factars Effective length factors
only. For more information, see discussion in n - o o
. e . te 'k f te 'k fach
section F — Moment Magpnification along Length of o lasia e TR
Compression Member in Chapter 2— Method of £ etk i e =
kinz): |1 kis): 1 kinz) 1 k= 1

Solution.

e In the EFFECTIVE LENGTH FACTORS group, specify oot Eoiiis

whether the k factor(s) are to be user-input or
computed by the program, by seclecting the oK Carcel |
corresponding option.

e Ifyou chose INPUT K FACTORS, enter the effective length factors for nonsway and sway conditions, k(ns)
and k(s), respectively.
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e Repeat the steps above for each active axis.

e Choose the OK button.

Slenderness / Columns Above and Below

e Select Input | Slenderness | Columns Above/Below. A dialog box appears. Note: this command is
available for slender columns only for which the COMPUTE k FACTORS option is selected in the DESIGN
COLUMN dialog box.

Columns Above and Below g|
Column &bove Column Below
™ Mo column specified ™ Mo column specified

Heightic/el 19 4 Heightese)  [19 4
Width (along 2} 12 4y Width (along >} [12 4y
Depth [along v): ’T i Depth [along ) ’T i
Concrete,  fo ’4— ksi Concrete,  fie ’4— ki

Ec 3605 g Ec: [3605 g
Copy to Column Below | Copy to Column Above |
ak. LCancel |

e In the COLUMN ABOVE group, specify whether or not a column above the design column exists, by
selecting or clearing the NO COLUMN SPECIFIED OPTION.

e [f a column above exists; enter the center-to-center height, the width (along the x-axis), the depth (along
the y-axis), the concrete compressive strength, and the concrete modulus of elasticity of the column
above in the corresponding text boxes. For circular sections, enter zero for the DEPTH and input the
section diameter in the WIDTH box. If zero is entered for both Width and Depth, the dimensions of the
design column will be automatically used.

e Repeat the same for the column below or, if the column above and the column below are the same,
choose the Cory TO COLUMN BELOW button.

e  Choose the OK button.

Slenderness / X-Beams

e Select Input | Slenderness | X-Beams. A dialog box appears. Beams defined using this command span
perpendicular to the x-axis. Note: this command is available for slender columns only for which the
COMPUTE K FACTORS option is selected in the DESIGN COLUMN dialog box and the RUN AXIS is BIAXIAL
or uniaxial ABOUT X-AXIS. X

X-Beams (perpendicular to X)

e From the BEAM LOCATION group, choose the appropriate option.
The data group below updates depending on the selection.

Beam Location:

v ahove Left " Above Right
e For the selected beam, specify whether or not a beam exists, by ® Bl L ® [l g
selecting or clearing the NO BEAM SPECIFIED OPTION. Beam Above Lsft

[~ Mobeam speciied  Copy From Beam Right

e If a beam exists; enter the center-to-center span length, width, , _
Span [cfc] |18 ft f'e: |4 ki

depth, concrete compressive strength, concrete modulus of

elasticity, and moment of inertia (if different than computed) of the || " 12 LI 505
beam. Depth: 18 in Inetix [3375 g
e Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, = ol |
ANCEl
and BELOW RIGHT. = =

e  Choose the OK button.
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Slenderness / Y-Beams

Select Input | Slenderness | Y-Beams. A dialog box appears. Beams defined using this command span
perpendicular to the y-axis. Note: this command is available for slender columns only for which the
COMPUTE K FACTORS option is selected in the DESIGN COLUMN dialog box and the RUN AXIS iS BIAXIAL

or uniaxial ABOUT Y-AXIS.

From the BEAM LOCATION group, choose the appropriate option.
The data group below updates depending on the selection.

For the selected beam, specify whether or not a beam exists, by
selecting or clearing the NO BEAM SPECIFIED OPTION.

If a beam exists; enter the center-to-center span length, width,
depth, concrete compressive strength, concrete modulus of
elasticity, and moment of inertia (if different than computed) of the
beam.

Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT,
and BELOW RIGHT.

Choose the OK button.

Loads / Factored

Beam Location:
(* Above Left
(" Below Left

Beamn Above Left

[~ Mobeam speciied  Copy From Beam Right

Span[cfc) |18 ft f'e: |4 ksi
“idth: 12 in Ec: [3605 ks
Depth: 15 i Inertia; |3375 w4

oK

Y-Beams (perpendicular to Y}

" Above Right
" Below Right

Lancel |

X

Whether designing or investigating a short (non-slender) column, factored loads consisting of applied axial
loads and moments about the active axis may be input.

Select Input | Loads | Factored. A dialog box appears.

Enter the factored axial load in the LOAD text box.

Based on the active axis, enter the factored moment about the x-axis, X-
MOMENT, the factored moment about the y-axis, Y-MOMENT, or both.

Choose the INSERT button. The data are added to the list box.

Repeat the steps above for each factored load entry.

To edit an entry, select it from the list box, modify its values in the text

boxes, and choose the MODIFY button.

To delete an entry, select it from the list box and choose the DELETE

button.

Choose the OK button.

Loads / Service

Factored Loads g|
Load #-Moment ‘f-toment
[kNm) [N
[ lnset | Modiy | Delete |
| Na. P x My
1 1750 60 100

2 2000 52

ok LCancel

200

When designing or investigating a short or slender column, service level loads consisting of dead, live, lateral
(wind and earthquake), and snow axial loads and moments at both column ends about the active axis may be
input. These loads are then factored and combined based on the load combinations.

Select Input | Loads | Service. A dialog box appears.

For each of the load cases: Dead, Live, Wind, Earthquake (EQ), and Snow, enter the axial load and the

applicable moment (about x or y) at the column top and bottom.

4-12
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e Enter the percentage of the sustained part of the load in each load case (by default only Dead Load is
assumed to be 100% sustained). These percentages will be used to arrive at sustained axial load ratio By
to calculate moment magnification factor along length of the column”'.

e Choose the INSERT button. The data are added to the list box.
e Repeat the steps above for each entry.

e To edit an entry, select it from the list box, modify its values in the text boxes, and choose the MODIFY
button.

e To delete an entry, choose it from the list box and choose the DELETE button.

e  Choose the OK button.

Service Loads Fz|
Azial Load [kip]— -~ #-Moments [k-ft) -bdoments [k-ft] Sustained Load [%]
@ Top (@ Bot @ Top @ Bot
Dead: | [330 |32 |-54 [ [ [100
Live: | [140 |20 |36 [ [ o
wind: | |0 |50 |50 [ [ o
E@: | [0 |0 |0 | | o
Snaw: | [0 o o [ [ o
Inzert | Modify | Delete |

|N0. [P, i, kixb, Myt Mob] for each caze

1 D 0, [ 140

ok Lancel

Load / Control Points

A non-slender column may be investigated without inputting any loads. The capacity of the section is
computed along with other section capacity parameters. This command is not available for slender columns
or under the Design option.

e Select Input | Loads | Control Points.

In the output file, key points (e.g. balanced point and pure bending) on the interaction diagram are listed.
For each point, the axial load and bending moment capacities, along with the corresponding neutral axis
depth, distance from extreme compression fiber to centroid of extreme layer of longitudinal tension steel,
net tensile strain in extreme layer of longitudinal tension steel at nominal strength, and strength reduction
factor (ACI only) are listed. For a biaxial run, these points are listed for bending about positive and
negative X and Y axes.

For ACI code, the program flags the unusual increase in axial load capacity in transition zone between
the balanced point and the tension control point (see Figure 2-3).

"'For moment magnification at ends of a column in a sway frame, the value of B is assumed to be zero and is not affected by sustained
load factors (see Chapter 2, Page 2-11, Footnote 41)

Operating the Program 4-13



sfcolumn

For uniaxial runs, the bar splice requirements for columns

Loads / Axial Loads

are indicated on the interaction diagram.

When investigating a short column (uniaxial runs only), grouped factored applied axial loads may be input.
The corresponding moment capacity for each load is computed and output. This command is not available

under the DESIGN option, for biaxial runs, or if the column is slender.

e Select Input | Loads | Axial Loads. A dialog box appears.

e To input a range of axial loads, enter the initial, final and increment
values in the corresponding text boxes. To input a discrete (single) axial | I
load, enter its value in the INITIAL text box, and enter zero in the FINAL

and INCREMENT text boxes.
e Choose the INSERT button. The data are added to the list box.

e Repeat the steps above for each axial load entry you may have.

e To edit an entry, select it from the list box, modify its values in the text

boxes, and choose the MODIFY button.

e To delete an entry, choose it from the list box and choose the DELETE

button.

Axial Loads X

Initial load Final load Increment

140 2
[kip) [kip) [kip)
Inzert | Modify | Delete |
| Mo, Initial Final Inc
1 E47.5 a a
2 250 300 10

oK LCancel
o  Choose the OK button.
Loads / Load Combinations

spColumn allows you to specify up to 50 load combinations. The yuE—G—_—G:— X
service load input under the load cases (dead, live, wind, earthquake, Doe e wind - o
and snow) are combined based on these combinations. A minimum of R e e e
one combination must be input.

p m odify | Delete | Defau\ts|

e Select Input | Loads | Load Combinations. A dialog box appears.
For a new file, the default combinations per the selected code are
shown in the list box.

e To add a new combination, enter the load factors or multipliers for
each load case, DEAD, LIVE, WIND, Earthquake (EQ), and SNOW.

e  Choose the INSERT button. The data are added to the list box.

e Repeat the steps above for each load combination. Up to fifty
combinations may be defined.

e To edit an entry, select it from the list box, modify its values in the
text boxes, and choose the MODIFY button.

e To delete an entry, choose it from the list box and choose the
DELETE button.

e Choose OK when done.

Flipping / Rotating the Section

| Combo Dead Live
1.

“wiind EQ Sniow

4
uz o 1.2 1 B 1] 1] 05
Ui 12 1 1] 1] 16
U4 1.2 o 08 1} 1E
us 1.z 1 16 1] 0.5
Ug 09 1] 18 1] 1]
ur 1.z 1] 0.8 1] 16
ug 1.2 1 1.6 1] 05
us 03 1] -1.6 1] 1]
Ut 1.2 1 1] 1 0.2
Uil 08 1] 0 1 1]
2 1.2 1 1] 1 0.2
U3 08 1] 1] 1 1]

Cancel |

This command is available for Irregular sections and for sections with Sides Different or Irregular

reinforcement.

e Select Input | Flip/Rotate Section. A dialog box appears.

™ ACI 318-11, Fig. R12.17; ACI 318-08, Fig. R12.17; ACI 318-05, Fig. R12.17; ACI 318-02, Fig. R12.17; CSA A23.3-04, 12.17.3;

CSA A23.3-94,12.17.3
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Select one of the options: FLIP SECTION ABOUT X-AXIS, FLIP SECTION ABOUT

Y-AXIS, or ROTATE SECTION. The last option is available for irregular
sections only.

" Flip section about -aws

If ROTATE SECTION is selected, enter the angle of rotation (clockwise is | ¢ BEotatessstion

pOSitiVC). 1] degrees measured clockwize.
Choose the OK button
: oK Cancel

Executing a Run

From the program

Select Solve | Results File. This is an option that may be turned ON or OFF by choosing it again. With
this option ON, an output file will be created while the program is solving. The output file is a text file
that contains an echo of the input along with slenderness calculation output, load combinations, and the
critical points on the interaction diagram.

Select Solve | Include Nominal Diagram. This is an option that may be turned ON or OFF by choosing
it again. With this option ON, calculations of nominal (unfactored) capacity interaction diagram will also
be included in the calculations so that the nominal diagram can be viewed and exported in addition to the
design (factored) capacity diagram.

Select Solve | Design Trace (design option only). This is an option that may by turned ON or OFF be
choosing it again. With this option ON, if designing a column section, the program will pause at each
cross section and reinforcement layout it tries, and display the cross section with its bars in the
Information bar.

Select Solve | Execute. If more data are needed to solve the
problem, an error box appears and you will be prompted for the
required data. If all the needed data are input, the solver portion of

spColumn will start executing. The Solving box appears with a o
progress indicator. Click Cancel to terminate the solution process. _

After a successful run, the interaction diagram or the contour plot [ cocs |
is displayed in the Graphics area of the window.

Dreriving Interaction Diagram

From command prompt

spColumn run can also be executed in batch mode from the command line prompt. Input data file, output data
file, and run options can be passed to the program via parameters. For instance typing spColumn
/1i:Examples\Example0l.col will run spColumn and solve the column defined in input file
Example01.col.

or CAWINDOWS s ystem 37 omd. exe

ructure Poin ks
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Multiple cross-sections can be designed and analyzed by executing spColumn with multiple input files using
batch (BAT) files (see Examples.bat in the spColumn program folder). Combined with Column Text Input
files (CTI), this feature can be used for automation spColumn runs for projects involving large numbers of

cross-sections.

Help on how to use command line parameters can be obtained by typing spColumn /? at the command

spColumn Command Line Halp @

prompt.

L viinepii]

Parameters:

iz Input dats file name

Jo Lbpue data file nane

Jarch If reinfarccrment ratio iz bodaw 1%, cansder courmn as arzhitzckural
Jaten TF reircnrrerment Fakin is helnw 1%, candder conmn a5 sknochird

Jwind I npLt file warsion prios ko 3,50 is detedted, consider lateral loads as wind loads
leq IF mpLt file warsion prios to 3,50 is detedted, consider lateral loads as earthquake loads

Jrom Includs nominal nteraction dizgram in export
Idsf Exaort colurn section ko DKF Sile tha: cen bz importec into A0 progran

teachm  P-M diagrams seaarstely for each Factored load point
ieachp  Mx-IMy diagrams separately for each Fadored load point
ieach P-M and Mx-My diagrams separatzly For each Factored load poin:

il P11 diggrans Mo all surbed and grooped angles ol “aclored resula Linamenl

pall Mx-My diagrams For all sorted and grauped evels of Factorec axal laad

1al P-IA and Mx-My diagrams Far all sorted and grouped resul:ant moments and avial oads
Jeti Exaort input data ko spZolumn Text Input fie

Thelp Shaw chis hep

17 Sl s lep

Examples:

spZolurnr fi:npk,col

iiinpLk.col foioubput,cat fiad fdf fosyv
i:Cs\pradyinput. cal Jor Dy projloutput. ot femf
spZolumr fitnpLt.col fo:oukput,odt fad femf:dl fwind farch

* o spZolumr [fi inpat_ile] [fcioutpue_fie] Jfarch|istn] [iwind|jeq’ [fiad] [fcs«| =t [fnom] [fdxF] [femf[:eachp| :eachm|each|:pall imall:2l]]

flad Ex2ort Interzctlcn dagram to [AD file that can be superimposed In spColumn
Jeze Exaart interckicn dagram ko Zomme Scparated Yalues Flc that can be imparbed nke spreadshzck pregram
Tht Fxanrt interzrticn dagram ba Tah-Nelimi-ed Test fie that rar beimporked nbn spreadsheet neegram

Temf Exaort graphical reports b EMF Fles that czn be Imported Inbo g-apalcs and word processing software
For uriax al runs, single P-M d agram is exported, For aiaxial, ons P-M and one Mz-My diagrams are ezportad,

Viewing Results

Once a successful run has been performed with the Solve | Results File option ON, you may view the results

file.

o Select View | Results. spColumn executes the spView program, an applet that enables viewing of text-

based files.

e  Use the scroll bars or the cursor keys to navigate through the file.

o  Select Exit to quit spView and return to spColumn. Changing the Startup Defaults

Changing Startup Defaults

You can change some default settings that spColumn uses when it is started or
when the File | New command is executed.

e Select Options | Startup Defaults. A dialog box appears.

o Enter the full path of the directory to which spColumn defaults when
opening a data file.

e Seclect the system of units, design code, and reinforcement to be used as
defaults whenever a new file is started.

e Enter the name of the program to be used by spColumn when viewing
results. By default, spColumn uses spView.

e Enter the number of lines per page to be used in formatting the results file.

e Choose the SAVE button to save these options in the registry.

Startup Defaults E|

[iata directony:

|c:\F'rogram FilezhStructurePointhzpColumn

Spstem of units:  |English -

Design code: AC1 31811 =z

Reinforcement:  |ASTM AB1S -
Teut file viewer: | spview

Mo. of linez per printed page: an

LCancel |
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Changing Reinforcement Bar Set

e Select Options | Reinforcement. A dialog box appears.

To select a different set:

e From the BAR SET drop-down list, select the set to be used.

Reinforcement g|
e Choose the OK button. ——
. . Uzer-defined Save..
To create or modify a user-defined set Foad
e From the BAR SET drop-down list, select USER-DEFINED. The ADD, _ ) _
d MODIFY buttons are enabled g R
DELETE an u : e & s [36
. . . o i in"2 i
e To edit an entry, select it from the list box, modify its values, and choose yv = " - -
odify | Delete |
the MODIFY button. .
|Size Db Ab wh
e To delete an entry, select it from the list box and choose the DELETE ¥3 035 0011 0376
#4 05 0.z 0.668
button. H5 0625 03 1043
45 075 044 15D
e To add an entry, enter the bar size, diameter, area and unit weight in the WL A e
corresponding text box, and choose the ADD button. The data are added to R S
the list box. #11 141 18 5313
#14 1693 225 765
. . 3 57 13.6
e A user-defined set may be saved to disk for use in other files. To do so,
choose the SAVE button after inputting the bars. The bar set is saved to the

file specified by the user. To retrieve a saved set, choose the READ button.

e  Choose the OK button. oK. Cancel

Superimposing Diagrams

After executing a run and selecting the File | Save command, the program saves the diagram data in a
separate file that has the same file name as the input file, with an IAD extension. If calculations of nominal
interaction diagram are included, the program stores also the nominal diagram data in an additional IAD file
named as the input file name suffixed with “-nominal.iad”.

The IAD interaction diagram file may be later read by the program and two diagrams (of different files) may
be superimposed for the purpose of comparison. Note that the RUN AXIS (uniaxial or biaxial) of the two files
must be the same.

e Select View | Superimpose option. The open dialog box appears.

o All files with the IAD extension contained in the current drive and directory are displayed in the FILE
NAME list box. To open a file that exists in another drive or directory, select a different drive or directory
drive from the LOOK IN drop-down list.

e From the FILE NAME list box, select the file to be opened, or simply type its name in the text box.

e Choose the OK button. If the data is successfully read, the diagram from the IAD file (shown dotted) is
superimposed over the currently displayed diagram.

e To clear the superimposed diagram, uncheck the View | Superimpose option.

Viewing Diagrams

By default, the program displays diagrams based on the design (factored) section capacity. Display of
diagrams based on the nominal (unfactored) strength is controlled by the View | Show Nominal Diagram
option which is available when calculations of nominal diagram are activated using the Solve | Include
Nominal Diagram option.
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For a uniaxial run, the program computes and displays the P-M interaction diagram. For a biaxial run, the
program computes the three-dimensional failure surface (P, My, My). The failure surface can be viewed in one
of two ways:

a) P-M interaction diagram (vertical slice at an angle measured from Mx)

b) M,-M, contour curve (horizontal slice at a constant axial load).

Whenever the mouse cursor moves over the Graph area, the axial load, moment, and eccentricity are
displayed in the Status bar.

Viewing Interaction Diagram

Select View | P-M Diagram - Full. A dialog box appears.

You may also select View | P-M Diagram — M positive or View | P-
M Diagram — M negative to view the interaction diagram only for
positive or negative moments.

Specify whether you want to enter an angle or the values of the
moments that produce a view angle by selecting either the ANGLE or
MOMENTS option, respectively.

If the ANGLE option was selected, select an angle from the list, use the
scroll bar to pick an angle, or simply enter the value in the text box.

If the MOMENTS option was selected, enter the values of My and M,
which define the view angle. The value of that view angle is computed
and shown in the ANGLE text box.

* Angle (M, My): " Moments:

0 degees 309 b
#1 5@ - keft

#2 13
#3 &7 My

k-ft
1
0

[v List Duplicate Poirts

Cancel

To display all load points and their numbers check the LiST POINT NUMBERS option. To display unique

angle values only, leave the option unchecked.

Choose the OK button.

You may browse through the angles by using View | Next angle and View | =

Previous angle respectively.

Viewing Contour

N
Select View | Mx-My Diagram. A dialog box appears. #4526
Select an axial load from the list, use the scroll bar to pick a load, or simply enter _

the value in the text box.

To display all load points and their numbers check the LIST POINT NUMBERS | & i puplcate Paints
option. To display unique axial load values only, leave the option unchecked.

Choose the OK button.

View Contour §|

Design Awial load:

0 kip 1086

-269

Cancel

You may browse through the loads by using View | Next Load and View | Previous Load respectively.
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Chapter 5

Examples

Example 1 - Capacity of a Square Column

For a column section” which is 16” x 16” and reinforced with 4-#8 bars, calculate the load moment
capacities for the following load conditions:

Case 1: Bar stress near tension face of member equal to zero, (f; = 0). General Information X
Case 2: Bar stress near tension face of member equal to 0.5f,, (f; = 0.5f)) Fﬁi'?:li
Case 3: At limit for compression controlled sections. (g5 = 0.002) IspColumn Manual Exemple 1
Column: Engineer:
Case 4: At limit for tension controlled sections. (g, = 0.005) |PCaMNotes 6.4 |5F
Given a concrete of 4000 psi and reinforcing steel of 60,000 psi. Units Run Option
. . . & Eng & Investigati
1. From the File menu, choose New. Any input data is cleared and the = ;ng"Sh mrestigston
efric " Design
default values are restored. ) i
i Run Az Dezsign Code
2. From the Input menu, choose General Information. & mboutidxis || ACI 31811
e Input the PROJECT header. N s
" Biawial " ACI 318-05
e Select English units and ACI 318-11 code. AL 31802

™ CSAAZ33-04

e Select About X-axis for run axis, Investigation for run option and No OS54 AZ1304

for Consider slenderness? Conzider slendemess? ez & Mo

e Choose OK.

ak LCancel

3. From the Input menu, choose Material Properties.

e  Accept the default properties as they match those in the problem statement
e  Choose OK.

Material Properties El

Cotcrete Reinfarcing Steel

Strength, fc: ,E!_ kesi Strength, fy: ,EU_ ki
Elasticity, Ec: (3605 ks Elasticity, E<:  |23000 ks
Max shess, fo ,T ksi

Betall] [nes

Ultimate strait: W

oK Cancel

4. From the Input menu, choose Section | Rectangular.
e  For the section WIDTH (ALONG X), input 16

e  For the section DEPTH (ALONG Y), input 16.

73 Based on Example 6.4, pp 6-33 from Notes on ACI 318-08 Building Requirements for Structural Concrete with Design Applications,
Edited by Mahmoud E. Kamara, Lawrence C. Novak, and Basile G. Rabbat, Tenth Edition, 2008, Portland Cement Association.
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e Choose OK.

All Sides Equal 3

Mo, of bars: Bl Lepant

* Rectangular

) Bar size: e -
Rectangular Section Pz| ' Girculan
Clear cover: |1.5 in
‘width [along X): in
Cover to

Depth [along ). |16 in

& Transverse bars Longitudinal bars

oK | LCancel | 0K LCancel

From the Input menu, choose Reinforcement | Equal Spacing.
e Input 4-#8 bars under NO. OF BARS.

e Input 1.5 in for the CLEAR COVER and select TRANSVERSE BARS. under COVER TO.

e Choose OK.

From the Input menu, choose Loads | Control Points.
From the Solve menu, choose Execute.
e The P-Mx contour is displayed in the Graphics area.

From the View menu, choose Results.

e Page through the results file.

e Choose File | Exit to quit the spView program and get back to spColumn.
From the File menu, choose Print Results.

e Select the printer to send the text results to.

e Choose PRINT.

10. From the File menu, choose Print Screen.

e Select the printer to send the graphical results to.

e Choose PRINT.

Examples
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(Pmax) 700 T (Pmax)

fs=0 1 fs=0

fs=0.5 fs=0.5fy

16 x 16 in

Code: ACI 318-11
Units: English
Run axis: About X-axis

Run option: Investigation

Slenderness: Not considered -180 180
Column type: Structural
Bars: ASTM A615

Date: 06/11/11 [N P )
(Pmin) (Pmin)

Time: 21:58:03

spColumn v4.80. Licensed to: StructurePoint. License |ID: 00000-0000000-4-25900-25900

File: C:\Program Files\StructurePoint\spColumn\Examples\Example01.col

Project: spColumn Manual Example 1

Column: PCANotes 6.4 Engineer: SP

f'c =4 ksi fy =60 ksi Ag = 256 in"2 4 #8 bars

Ec = 3605 ksi Es = 29000 ksi As =3.16 in"2 rho =1.23%

fc = 3.4 ksi Xo =0.00in Ix = 5461.33 in™4
e_u=0.003 infin Yo =0.00in ly = 5461.33 in"4
Betal = 0.85 Min clear spacing = 10.25 in Clear cover = 1.88 in

Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65
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STRUCTUREFPOINT - spColumn wv4.30
License ID:

Licengsed to: StructurePoint.

(THM)

00000-0000000-4-25900-253900

CiA\Program Files\StructurePointhspColumntEzamplesi\Examplell.col

General Information:

File Name:

C:3\Program Files‘\StructurePointispColumni\Examples\Examplell.col

Project: sgpColumn Manual Example 1
Column: PCRNotes 6.4 Engineer: SP
Code: ACI 318-11 Units: English
Run Option: Investigation Slenderness: Not considered
Run Axis: K-axis Column Type: Structural
Material Properties:
f'c = 4 ksi £y = 60 ksi
Ec = 3605 ksi Es = 25000 ksi
Ultimate strain = 0.003 in/in
Betal = 0.85
Section:
Rectangular: Width = 16 in Depth = 16 in
Gross section area, Ag = 256 in"2
Iz = 5L461.33 in~4 Iy = 5461.33 in~4
rz = 4.6188 in ry = 4.6188 in
o = 0 in Yo = 0 in
Reinforcement:
Bar Set: ASTHM A6lL
Size Diam (in) Area [(in™2) Size Diam {in) Area (in™Z2) Size Diam (in) Area (in"2)
# 3 .38 0.11 # 4 0.50 0.20 # b 0.63 0.31
# 6 0.75 0.44 # 07 0.88 0.&e0 # 8 1.00 0.79
# 9 1.13 1.00 # 10 1.27 1.27 # 11 1.41 1.56
# 14 1.69 2.2h # 138 2.26 4.00
Confinement: Tied; #3 ties with #10 bars, #4 with larger bars.
phif(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65
Layout: Rectangular
Pattern: All Sides Equal (Cover to transverse reinforcement)
Total steel area: As = 3.16 in"™2 at rho = 1.23%
Minimum clear spacing = 10.25 in
4 #8 Cover = 1.5 in
Control Points:
Axial Load P X-Moment Y-Moment NA depth Dt depth eps t
Bending about kip k-ft k-ft in in
X B Max compression 682.0 0.00 0.00 43.90 13.63 -0.00207
B Allowable comp. 545,86 72,20 0.00 15.581 13.63 -0.00041
B fs = 0.0 467.6 102.64 0.00 13.63 13.63 -0.00000
B fz = 0.5*fy 331.8 135.43 0.00 10.13 13.63 0.00103
@ Balanced point 238.9 148.49 0.00 3.06 13.63 0.00207
@ Tension control 188.7 172.04 0.00 5.11 13.63 0.00500
@ Pure bending -0.0 91.03 0.00 Z.24 13.63 0.01L23
@ Max tension -170.6 -0.00 -0.00 0.00 13.63 9.9359%
-¥% @ Max compression 682.0 0.00 0.00 43.90 13.63 -0.00207
B Allowakle comp. 545,86 ~T2.20 -0.00 15.81 13.63 -0.00041
@ fs = 0.0 487,86 -10z2.64 0.00 13.63 13.63 0.00000
@ fz = 0.5*%fy 331.8 -135.43 0.00 10.13 13.63 0.00103
@ Balanced point 238.9 -148.49 0.00 .06 13.63 0.00207
@ Tension control 188.7 -172.04 -0.00 5.11 13.63 0.00500
@ Pure bending -0.0 -51.03 -0.00 2.24 13.63 0.01L28
@ Max tension -170.6 -0.00 -0.00 0.00 13.63 9.9359%5
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Example 2 - Investigation of a Slender Nonsway Column

Determine the adequacy of a 4” x 20” column’ with 3-#11 bars on each 14” side in a nonsway frame with a
clear height of 22°6”. Use k=1.0.

The concrete used is 6000 psi and the reinforcing steel is 60,000 psi.

General Information E|
The factored load values for the column under consideration are as follows: Labels
. . Praject:
P (klp) 115 klpS |spEOIumn tanual Example 2
. . Colurmn: Engineer:
Top M,y (kip-ft) 279 ft-kips [wiang 15.18.5 [sP
Bottom M, (kip-ft) -279 ft-kips
Unitz Fun Option
+ Englizh * |rnvestigation
. . . " Metic " Design
From the File menu, choose New. Any input data is cleared and the default A :
un Az Design Code
values are restored. " About¥deis || &3
. i g [ |
1. From the Input menu, choose General Information. About s AT 1808
+ Biawial AL 31805
e Input the PROJECT header. " ACI 31802
. " CSAAZ3304
e Select ENGLISH units and ACI 318-11 code. N ——
e Select Biaxial for run axis, Investigation for run option and Yes for | Considersiendemess? & ‘es ¢ No
Consider Slenderness?
QK Lancel
e Choose OK.

2. From the Input menu, choose Material Properties.
e Input 4.5 for the CONCRETE STRENGTH. Change the REINFORCING STEEL STRENGTH to 50. Other
properties are computed and will be accepted.

e  Choose Ok.

Material Properties E|

Concrete Reinforcing Steel

Strength, f'e: ki Strength, fy: 50 ksi
Elasticity, Ec:  |3823.6 ksi Elasticity, Es: {23000 ksi

Max stress, foo [3.825 kai
Betal1): 0.825
Ultimate strain: |0.003

Ok LCancel |

From the Input menu, choose Section | Rectangular.
e Input 20 and 14 for the section width (along X) and depth (along Y).

e Choose OK.

7 Based on Example 15.8.5 from Reinforced Concrete Design by Chu-Kia Wang, Charles G. Salmon, and Jose A. Pincheira, Seventh
Edition, 2007, John Wiley and Sons, Inc.
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Rectangular, Section [‘S__<|
Wwidth [slong =) B in
Depth [along Y] |14 in

Sides Different

Biar size:

LCancel |

Mo, of bars:

3
Top  Battom  Left Riight
B 2 I 1
[#11 ~] J#11 ~| a1 ~] [#11 +]
[2005  in

Clearcover: [2005  [2005 2005

Cover to

" Tiansverse barz % Longitudinal bars

ju] LCancel

3. From the Input menu, choose Reinforcement | Sides Different.

Choose OK.

4. From the Input menu, choose Slenderness | Design Column.

Choose OK.

Input 22 .5 for the column CLEAR HEIGHT.

Check NONSWAY FRAME and select INPUT ‘K’ FACTORS.

Design Column E|
Hediz - Bis
Clear height: Clear height: ~ |225 ft
* Monsway frame & Monsway frame
" Sway frame " Sway frame
Sway critenia -Swayp criteria -
[SumPel/Pey [ [SumPe)Pel [1
BumPuAPuL [ BumPuPu; [T
Effective length factors i~ Effective length factors
" Compute k' factors " Compute k' factors
(* |nput 'k’ fackors: @ |nput 'k factors:
kst 1 kisk [T kinsh [T kst [T
Copy to Y-Axis Copy to Az
Ok LCancel |

From the Input menu, choose Loads | Service.

Input 2-#11 bars for TOP and BOTTOM and 1-#11 for LEFT and RIGHT. Input 1.5 in for the cover
and select LONGITUDINAL BARS.

Under LIVE, input 71.875 for the AXIAL LOAD, O for the X-MOMENTS @Top, O for the X-
MOMENTS @BoT, 174.375 for the Y-MOMENTS @ToP and -174.375 for the Y-MOMENTS

(@BOTTOM, respectively.

In column SUSTAINED LOAD keep default setting for dead load equal 100%.

Choose INSERT to add the entry to the list box.

Choose OK .

5-6
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Service Loads

Live:
wind:
EQ:

Show

Dead:

X

Arial Load [kip]— - =-Moments [k-ft] ¥-Moments [k-ft] Sustained Load [%]
@ Top & Bot @ Top & Bat

[ o [ o [ 100

[71.875 o o [174375  |174.375 o

[0 o [0 o [0 [0

[0 o [0 o [0 [0

[0 o [0 o [0 [0

Inzert | Madify | Delete |

|NU. [P, bdut, bdmb, bMyt, Myb] for each case

ak Cancel ‘

6. From the Input menu, choose Loads | Load Combinations.

If the list displays thirteen combinations, choose only the second load combination U2 and delete all
the others by selecting them and using DELETE. Choose OK.

Dead Live “wind EQ Snow

1.2 + |16 + |0 + |0 + |05
Insert Modify ‘ Delete | Defaulls|

‘ Combo Dead Live Wind EQ Show

oK Cancel

7. From the Solve menu, choose Execute.

8.

The solver of the program is started and, upon completion, displays the interaction diagram of the
section with the load point plotted within the diagram.

From the View menu, choose Results.

Page through the results file.

Examples
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e Choose FILE | EXIT to quit the spView program and get back to spColumn.
9. From the File menu, choose Print Results.

e Select the printer to send the text results to.

e Choose PRINT.
10. From the File menu, choose Print Screen.

e Select the printer to send the graphical results to.

e  Choose PRINT.
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P (kip)
(Pmax) 1000 + (Pmax)

O O T
y
o) +x 0 T
@] O
20x 14 in iR
Code: ACI 318-11 1 —+2
UnItS. EngIISh I | | | | | | | | | | | | | | |
I T T T T T T T T T T T T T T 1
Run axis: Biaxial -400 400

Run option: Investigation T M (887) (k-ft)

Slenderness: Considered
Column type: Structural 1
Bars: ASTM A615

Date: 06/19/11 (Pmin) (Pmin)

Time: 20:06:01

spColumn v4.80. Licensed to: StructurePoint. License |D: 00000-0000000-4-25900-25900

File: C:\Program Files\StructurePoint\spColumn\Examples\Example02.col

Project; spColumn Manual Example 2

Column: Wang 15.18.5 Engineer: SP

fc=4.5ksi fy =50ksi Ag =280 in"2 6 #11 bars

Ec = 3824 ksi Es = 29000 ksi As =9.36in"2 rho = 3.34%

fc = 3.825 ksi Xo =0.00in Ix =4573.33 in™4
e_u=0.003 infin Yo =0.00in ly = 9333.33 in"4
Betal = 0.825 Min clear spacing = 2.88 in Clear cover = 2.01 in
Confinement: Tied kx(nonsway) = 1 kx(sway) = N/A
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65 ky(nonsway) = 1 ky(sway) = N/A
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20%x 14 in f

500 +

My (k-ft)

Mx (k-ft)

Code: ACI 318-11

Units: English

Run axis: Biaxial

Run option: Investigation
Slenderness: Considered
Column type: Structural
Bars: ASTM A615

Date: 06/19/11

Time: 20:03:52

B

=115 kip

-500 —-

500

spColumn v4.80. Licensed to: StructurePoint. License |D: 00000-0000000-4-25900-25900

Project; spColumn Manual Example 2
Column: Wang 15.18.5

fc=4.5ksi fy =50ksi

Ec = 3824 ksi Es = 29000 ksi
fc = 3.825 ksi

e_u=0.003 infin

Betal = 0.825

Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

File: C:\Program Files\StructurePoint\spColumn\Examples\Example02.col

Engineer: SP

Ag =280 in"2

As =9.36in"2

Xo =0.00in

Yo =0.00in

Min clear spacing = 2.88 in
kx(nonsway) = 1

ky(nonsway) = 1

6 #11 bars

rho = 3.34%

Ix =4573.33 in™4

ly = 9333.33 in"4
Clear cover = 2.01 in
kx(sway) = N/A
ky(sway) = N/A

5-10
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STRUCTUREPOINT - spColumn v4.80 (TM)
Licensed to: StructurePoint. License ID: 00000-0000000-4-25%00-25200
C:\Program Files\StructurePoint\spColumn\Examples\Example02.col

General Information:

File Name: C:\Program Files\StructurePoint\spColumn\Examples\Example02.col
Project: spColumn Manual Example 2

Column: Wang 15.18.5 Engineser: SP

Code: ACI 318-11 Units: English

Run Option: Investigation Slenderness: Considered
Run Axis: Biaxial Column Type: Structural

Material Properties:

f'c = 4.5 ksi fy = 50 ksi

Ec = 3823.68 ksi Es = 29000 ksi
Ultimate strain = 0.003 in/in

Betal = 0.825

Section:
Rectangular: Width = 20 in Depth = 14 in
Gross section area, Rg = 280 in"2
Ix = 4573.33 in™4 Iy = 5333.33 in™4
rx = 4.04145 in ry = 5.7735 in
Xo = 0 in Yo = 0 in

Reinforcement:

Bar Set: ASTM AelS

Size Diam (in) Area (in"2) Size Diam (in) Area (in"2) Size Diam (in) Area (in"2)
# 3 0.38 0.11 # 4 0.5 0.20 # 5 0.e3 0.31
¥ 6 0.75 0.44 7 0.88 0.60 # 8 1.00 0.79
¥ 9 1.13 1.00 # 10 1.27 1.27 # 11 1.41 1.56
£ 14 1.69 2.25 # 18 2.26 4.00

Confinement: Tied; #3 ties with #11 bars, #4 with larger kars.
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

Layout: Rectangular
Pattern: Sides Different (Cover to longitudinal reinforcement)
Total steel area: As = 9.36 in”2 at rho = 3.34%

Minimum clear spacing = 2.88 in
Top Bottom Left Right
Bars 2 #11 2 11 1 #11 1 #11
Cover(in) 2.005 2.005 2.005 2.005

Service Loads:

Load Bxial Load Mx @ Top Mx @ Bot My @ Top My @ Bot

No. Cass kip k-ft k-ft k-ft k-ft
1 Dead 0.00 0.00 0.00 0.00 0.00
Liwe 71.88 0.00 0.00 174.38 -174.38
Wind 0.00 0.00 0.00 0.00 0.00

EQ 0.00 0.00 0.00 0.00 0.00
Snow 0.00 0.00 0.00 0.00 0.00

Sustained Load Factors:

Load Factor
Case (%)
Dead 100
Live 0
Wind 0
EQ 0
Snow 0

Load Combinaticns:

Ul = 1.200%Dead + 1.600*Live + 0.000*Wind + 0.000*EarthQuake + 0.500%Snow

Page 2
06/19/11
08:00 PM

Examples
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STRUCTUREPOINT - spColumn v4.80

Licensed to:

StructurePo

(TM)

int. License ID:

00000-0000000-4-259%00-25900

C:\Program Files\StructurePoint\spColumn\Examples\Example02.col

Slenderness:

X-axis: Nonsway column.

Y-axis:

Design
ABbove
Below

X-Beams
Location

Below

Y-Beams
Location

Height
ft

(no
(no
(no
(no

Length
ft

(no
({no
(no
({no

Length
ft

Facto

Nensway column.

0.000
0.000

Moment Magnification Factors:

stiffness reduction factor,
Cracked-section coefficients:

0.
0.

X-axis

2*Ec*Ig + Es*Ise
2*Ec*Ig + Es*Ise

(X-
(Y-

Ld/Comk SumPu(kip)

Y-axis

Page 3
06/19/11
08:00 PM

Width Depth I f'e Ec
in in in~4 ksi ksi
20 14 4573.33 4.5 3823.68
20 14 ©333.33 4.5 3823.68
specified...)
specified...)
specified...)
specified...)
Width Depth I f'c Ec
in in in~4 ksi ksi
specified...)
specified...)
specified...)
specified...)
Width Depth I f'e Ec
in in in~4 ksi ksi
specified...)
specified...)
specified...)
specified...)
rs:
Psi (bot) k (Nonsway) k{sway) klu/r
0.000 1.000 (N/R) 66.81
0.000 1.000 (N/R) 46.77
phi(K) = 0.75
cI{beams) = 0.35; cI(columns) = 0.7
axis) = 6.83e+006 kip-in~2
axis) = 2.16e+007 kip-in"2
At Ends ————-—————-————————- —————————————————— Along Length -——-
Pc(kip) SumPc(kip) Betads Deltas Pulkip) k'lu/r Pc(kip) Betad
(N/R) (N/R2)  (N/R) (N/R) 115.00 (N/R) 24,3% 0.000
At Ends ————————————-——-—- —————————————————— Along Length --——-—
Pc(kip) SumPc(kip) Betads Deltas Pu(kip) k'lu/r Pc(kip) Betad
(N/R) (N/R)  (N/R) (N/R) 115.00 (N/R) 2919.31 0.000

Factored Mome

nts due to

First-Order and Second-Order Effects:

Minimum sccentricity,
Minimum sccentricity,

Ex,min
Ey,min

NOTE: Each loading combination includes the following cases:

First line - at column top
Second line - at column bottom
¥-axis -—-———————————- 1st Oorder —-—-——-—-—-————— - Ratio -
Load Mns Ms Mu Mmin Znd/1lst
Combo k-ft k-ft k-ft k-ft
1ul 0.00 (N/B) 0.00 9.78 1.1%9
0.00 (N/A) 0.00 .78 1.19%
Y-axis ——-——————————- 1st Oorder ——-—-—-—-—-—--—-———o - Ratio -
Load Mns Ms Mu Mmin 2nd/1st
Combo k-ft k-ft k-ft k-ft
1ul 275.00 (N/B) 279.00 11.50 Mi= 275.00 254.47 1.055
279.00 (N/B) 279.00 11.50 M2= 27%9.00 294.47 1.055
5-12 Examples
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STRUCTUREPOINT - spColumn v4.80 (TM)
Licensed to: StructurePoint. License ID: 00000-0000000-4-25900-25%00
C:\Program Files\StructurePoint\spColumn\Examples\Example02.col

Factored Loads and Moments with Corresponding Capacitles:

NOTE: Each loading combination includes the following cases:

First line - at column top
Second line - at column bottom
Load Pu Mux Muy PhiMnx FhiMny PhiMn/Mu NA depth Dt depth eps_t
No. Combo kip k-ft k-ft k-ft k-ft in in
1 1ul 115.00 11.7z2 294.47 13.38 336.38 1.142 5.73 18.33 0.00674
2 115.00 11.72 294 .47 13.38 336.38 1.142 5.73 18.33 0.00674

*%% End of output **¥

Page 4
06/19/11
08:00 PM
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Example 3 - Design of a Slender Column in a Sway Frame

Design a square column” with a clear height of 16 ft. The column is sway and subjected to dead, live and
wind loads as shown below.

Dead Live Wind
P (kip) 380 140 0
Top My (kip-ft) 32 20 50
Bottom M (kip-ft) 54 36 50

The column is to be checked for the following load combinations:

Ul=12D+1.6L
U2=12D+05L+1.6 W

The calculations in the reference are done based on the load combination U2.

General Information @

In practice, the ratio 2P,/ P, would have to be calculated before the problem .
can be attempted, using a trial value of £P./P.. Here, the value of XP,/P_ used Project:
is 28.67 based on the reference value of P,. There are 14 interior columns, 18 | |sCslumnManusl Exarple 3

exterior columns and 4 corner columns. Therefore, the value of lc:'“m o lES"F?i"ee"
. . . . azzoun 12,
YP/Py =14+ 18 *2/3 + 4 * 1/3 =27.33 irrespective of the load combination
belng used. Lnits Fun Optior
. . . iy i g igati
1. From the File menu, choose New. Any input data is cleared and the | . ;"gt'fSh = '[;We,ﬂ'ga“m
elnc . Egn
default values are restored. _ -
i Run Axiz 1 Design Code
2. From the Input menu, choose General Information. & Aboutidwis || 4 ACI 31811
e Input the PROJECT header. ot | 5E JAEL TRl
© Biavial AL N G05
e Select English units and ACI 318-11 code. " ACI 31802

™ CSAAZIZ04

e Select About X-Axis for run axis, Design for run option and Yes for ~ CoAA23394

Consider slenderness?

e Choose OK.

Consider slenderness? & Yes Mo

QK LCancel

3. From the Input menu, pick Material Properties.

e Input 5 for the concrete strength. Other properties are computed and will be accepted.

e Choose OK.

Material Properties E|
Concrete Reinforcing Steel

Strength, f'c: E ksi Strength, fu E0 kzi
Elasticity, Ec:  |4030.5 ksi Elasticity, Es:  |29000 k=i

Max stress, fo: (425 ksi
Beta(1]: 08
Ultirnate strain: |0.003

ak LCancel

4. From the Input menu, pick Section | Rectangular.

> Based on Example 12.4, pp 409, from Structural Concrete: Theory and Design by M. Nadim Hassoun and Akthem Al-Manaseer,
Fourth Edition, 2008, John Wiley and Sons, Inc.
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5.

Input 18 and 18 for the WIDTH (ALONG X) and DEPTH (ALONG Y) under both START and END

options.

Choose OK.

Rectangular, Section

Start End  Increment

‘width [along ) 18 0 in
Depth [along Y): |18 18 ] in

oK

LCancel |

From the Input menu, choose Reinforcement | Equal Spacing.

Input 8-#10 bars and 1.5 in for the cover and select TRANSVERSE BARS.

Choose OK.

All Sides Equal

Minimurn  M.aximum

Mo of bars: 40

Bar size: m m
Clear cover: |1.5 in

oK

X

Cover to
(% Transverse bars
" Longitudinal bars

Bar Layout
* Rectangular
™ Circular

LCancel |

From the Input menu, choose Slenderness | Design Column.
Input 16 for the column CLEAR HEIGHT.

Check SWAY FRAME

Under SWAY CRITERIA, input 28.67 and 27 . 33 for the XPc/Pc and ZPu/Pu, respectively.

Leave 2"° ORDER EFFECT ALONG LENGTH option checked (default)

Select COMPUTE ‘K’ FACTORS.

Choose OK.

Design Column

E fective length factors

Hodwis iz

Clear height: ft Clear height: I_ ft

" Monsway frame 4 sway frame

0+ Sway frame {3

Sway criteria Swway criteria-

{Sum Pe)/Pe) [28.67 SumPelPe) |05

[Sum Pul/[Pul: W [5 um Pul/[Pul: I—

W 'nd order effects along length ¥ 2 order ef lona lenatt

Effective length factors

&+ Compute 'k factars =
& Input 'k factors: & |np fa
klnsl: |0 kis): |1.40¢ kins): kfz]: ]
Qg Lancel ‘

7. From the Input menu, choose Slenderness | Columns Above/Below.

Examples
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Clear the NO COLUMN SPECIFIED option.

Input 11 for the column height (center-to-center) under HEIGHT (C/C) and leave the other data as is.

Choose Copy to Column Below.

Choose OK.

Columns Above and Below

Column Above Calurnn B elow

™ Mo column specified

Height [/c): Iﬂ_ it Height [c/c): ’11_ it
width (along =k 187 iy Width (along 5 18 iy
Diepth [along ) IT i Diepth [along Y] 'F fim
Concrete,  fo I5— ki Concrete,  fo ’5— ksi

Ec: 4030 jg Ec: [4030. g
Copy ta Column Below | Copy to Column Above |
ak Lancel |

X

8. From the Input menu, choose Slenderness | X-Beams.

Choose ABOVE LEFT.

Leave the other data as it is.

Clear the NO BEAM SPECIFIED option.
Input 20 for the span (center-to-center) under SPAN(C/C).
Input 0.00 and 0.00 for the WIDTH and DEPTH, respectively.

Input 21436 . 6 for the moment of inertia under INERTIA.

Choose ABOVE RIGHT and click on Cory FROM BEAM LEFT.
Choose BELOW LEFT and click on COPY FROM BEAM ABOVE.
Choose BELOW RIGHT and click on CoPY FROM BEAM ABOVE.

Choose OK.

X-Beams (perpendicular, to X) PZ|

Beam Location:

" Above Right
" Below Left " Below Right

Beam &bove Left

[~ Mo beam specified  Copy From Beam Right

Span [c/c): 20 ft f'e |5 kesi
“wiidth: ] in Ec: |4030.57 ksi

Depth: 0 in  Inertia; |21436.6 "4

Ok LCancel |

9. From the Input menu, choose Loads | Service.

Under DEAD, input 380, 32 and -54 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS
respectively.

5-16
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Under LIVE, input 140, 20 and -36 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS,

respectively.

Under WIND, input O, 50 and -50 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS,

X

respectively.
Service Loads
Axial Load [kip]—— %-Moments [k-ft] -Maoments [k-ft) Sustained Load [%)
@ Top (@ Bot @ Top @ Bot

Dead: | [380 |32 | 54 [ [ [100

Live: | [140 |20 |-35 [ [ o

wind: | |0 |50 |50 [ [ o

e | o o o | | o

Snaw: | [0 o o [ [ o

Irzert | Modify | Delete |

|N0. [P. b=k, bxb, bwt, Myb] for each caze

LCancel |

Under SUSTAINED LOAD keep the default settings of 100% for dead and 0% for all other load cases.

Choose INSERT to add the entry to the list box.

Choose OK.

10. From the Input menu, choose Loads | Load Combinations.

If the list displays thirteen combinations, leave the first and
second as they are. Delete the remaining combinations

using DELETE.

11. From the Solve menu, choose Execute.

The solver of the program is started and, upon completion,
displays the interaction diagram of the section with the

load points plotted within the diagram.

12. From the View menu, choose Results.

13.

14.

Page through the results file.

Choose Exit to quit the spView program and get back to

spColumn.

From the File menu, choose Print Results.

Select the printer to send the text results to.

Choose PRINT.

From the File menu, choose Print Screen.

Load Combinations

3

Dead Live ‘wind EQ Shiow

st | Modiy | Delete | Defauts |
| Combo Dead Live wind EQ Show
16 i 0.5

12

ok Cancel

Examples
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e Select the printer to send the graphical results to.

e Choose PRINT.

Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

kx(nonsway) = 0.802213

P (kip)
1600
(Pmax) | | (Pmax)
c O O O Il
@ Y O
1«
fs=0 T fs
®; O
© o0 0 O fs=0.5fy ++ fs=0.5fy
st
18 x 18 in 1
COde. ACI 318-11 L | | | Il | | Il | | Il | | | | | |
Units: English -500 500
Run axis: About X-axis T Mx (k-ft)
Run option: Design 1
Slenderness: Considered
Column type: Structural T
Bars: ASTM A615 |
Date: 06/22/11 (Pmin) (Pmin)
Time: 18:41:10 -1000 =
spColumn v4.80. Licensed to: StructurePoint. License |D: 00000-0000000-4-25900-25900
File: C:\Program Files\StructurePoint\spColumn\Examples\Example03.col
Project: spColumn Manual Example 3
Column: Hassoun 12.4 Engineer: SP
fc =5 ksi fy =60 ksi Ag =324 in"2 12 #10 bars
Ec = 4031 ksi Es = 29000 ksi As =15.24in"2 rho =4.70%
fc =4.25 ksi Xo =0.00in Ix = 8748 in"4
e_u = 0.003 infin Yo =0.00in Iy = 8748 in"4
Betal =0.8 Min clear spacing = 3.06 in Clear cover = 1.88 in

kx(sway) = 1.38998

5-18
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STRUCTUREPOINT - spColumn v4.80 (TM)
Licensed to: StructurePoint. License ID: 00000-0000000-4-25900-25%00
C:\Program Files\StructurePoint\spColumn\Examples\Example03.col

General Information:

File Name: C:\Program Files\StructurePoint\spColumn\Examples\Example03.col
Project: spColumn Manual Example 3

Column: Hassoun 12.4 Engineer: SP

Code: ACI 318-11 Units: English

Run Option: Design Slenderness: Considered
Run Axis: X-axis Column Type: Structural

Material Properties:

f'ec =5 ksi fy = 60 ksi
Ec = 4030.51 ksi Es = 29000 ksi
Ultimate strain = 0.003 in/in
Betal = 0.8
Section:
Rectangular: Width = 18 in Depth = 18 in
Gross section area, Rg = 324 in"Z
Ix = 8748 in™4 Iy = 8748 in"4
rx = 5.19615 in ry = 5.19615 in
¥o = 0 in Yo = 0 in
Reinforcement:
Bar Set: ASTM AelS
Size Diam (in) Area (in"2) Size Diam (in) Area (in"2) Size Diam (in) RArea (in"2)
# 3 0.38 0.11 # 4 0.5 0.20 # 5 0.63 0.31
# 8 0.75 0.44 ¥ 7 0.88 0.60 # 8 1.00 0.7%9
# 9 1.13 1.00 # 10 1.27 1.27 # 11 1.41 1.58
# 14 1.69 2.25 £ 18 2.26 4.00
Bar selection: Minimum number of bars
Asmin = 0.01 * Ag = 3.24 in”2, BRAsmax = 0.08 * Ag = 25.92 in"2
Confinement: Tied; #3 ties with #10 bars, #4 with larger bars.
phi(a) = 0.8, phi(k) = 0.9, phi(c) = 0.65
Layout: Rectangular
Pattern: A1l Sides Equal (Cover to transverse reinforcement)
Total steel area: As = 15.24 in"2 at rho = 4.70%
Minimum clear spacing = 3.06 in
12 #10 Cover = 1.5 in
Service Loads:
Load BAxial Load Mx @ Top Mx @ Bot My @ Top My @ Bot
No. Cass kip k-ft k-ft k-ft k-ft
1 Dead 380.00 32.00 -54.00 0.00 0.00
Live 140.00 20.00 -36.00 0.00 0.00
Wind 0.00 50.00 -50.00 0.00 0.00
EQ 0.00 0.00 0.00 0.00 0.00
Snow 0.00 0.00 0.00 0.00 0.00
Sustained Load Factors:
Load Factor
Case (%)
Dead 100
Live 0
Wind 0
EQ 1]
snow 0
Load Combinations:
Ul = 1.200%Dead + 1.600%Live + 0.000*Wind + 0.000%EarthQuake + 0.500*Snow

uz2

1.200%Dead + 0.500%Live + 1.600*Wind + 0.000%*EarthQuake + 0.500*Snow

Page 2z
06/22/11
06:40 PM

Examples
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STRUCTUREPOINT - spColumn v4.80 (TM)
Licensed to: StructurePoint. License ID: 00000-0000000-4-25900-25%00
C:\Program Files\StructurePoint\spColumn\Examples\Example03.col

Slenderness:

Sway Criteria:

X-axis:

Sway column. SumPc 28.67 * Pc SumPu 27.33 * Pu
Second-order effects along length considered

0.830
0.927

- Rati
2nd/1

Page 3
06/22/11
06:40 PM

o
st

Height Width Depth I f'e Ec
Column Axis ft in in in~4 ksi ksi
Design X 16 18 18 8748 5 4030.51
Bhove h:4 11 18 18 8748 5 4030.51
Below b4 11 18 18 8748 5 4030.51
X-Beams Length Width Depth I f'ec Ec
Location ft in in in~4 ksi ksi
Bbove Left 20 0 4] 21436.86 5 4030.51
Bbove Right 20 0.0001 0.0001 21436.6 5 4030.51
Below Left 20 0.0001 0.0001 21436.6 5 4030.51
Below Right 20 0.0001 0.0001 21436.6 5 4030.51
Effective Length Factors:
Bxis Psi(top) Psi (bot) k (Nonsway) k (Sway) klu/r
b:4 1.252 1.252 0.802 1.3%0 51.36
Moment Magnification Factors:
Stiffness reduction factor, phi(K) = 0.75
Cracked-section coefficients: cI(beams) = 0.35; cI(columns) = 0.7
0.2*Ec*Ig + Es*Ise (X-axis) = 2.02e+007 kip-in"2
X-axis ------———————mm—m - At Ends ———--—--——-—--—--- o ———m— oo Along Length
Ld/Comb SumPu(kip) Pc(kip) SumPc (kip) Betads Deltas Pu(kip) k'lu/r Pc(kip) Betad
10l 18584.40 2792.45 80059.54 0.000 1.448 680.00 (N/B) 5018.30 0.671
u2 14375.58 27%2.45 80059.54 0.000 1.315 526.00 (N/R) 4490.56 0.367
Factored Moments due to First-Order and Second-Order Effects:
Minimum eccentricity, Ex,min = 1.14 in
NOTE: Each loading combination includes the following cases:
First line - at column top
Second line - at column bottom
¥-axis -~ 1st Order ———--———- 2nd Order —-—-—-———-
Load Mns Ms Mu Mmin Mi Mc
Combo k-ft k-ft k-ft k-ft k-ft k-ft
10l T70.40 0.00 70.40 64.60 Ml= 70.40 71.32
122.40 0.00 122.40 64.60 M2= 122.40 124.00
1 02 48.40 80.00 128.40 49.97 Ml= 153.58 168.6%9
82.80 g80.00 162.80 49.97 M2= 187.98 206.47
Factored Loads and Moments with Corresponding Capacitles:
Design/Reguired ratic PhiMn/Mu >= 1.00
NOTE: Each loading combination includes the following cases:
First line - at column top
Second line - at column bottom
Load Pu Mux PhiMnx PhiMn/Mu NA depth Dt depth eps_t Phi
No. Combo kip k-ft k-ft in in
1 101 €80.00 T71.32 311.55 4.368 12.43 15.49 0.00074 0.650
2 €80.00 124.00 311.55 2.51z2 12.43 15.4% 0.00074 0.650
3 1 vz 526.00 168.69% 344 .47 2.042 10.76 15.49% 0.00132 0.650
4 526.00 206.47 344.47 1.668 10.76 15.4% 0.00132 0.650

*%% FEnd of output ***

5-20

Examples



sfcolumn

Example 4 - Investigation of Concrete Shear Wall

Investigate the axial load and moment capacity of a shear wall’® for a given location of the neutral axis. Use
4-ksi concrete and 60-ksi reinforcing steel.

ﬂ 15in ‘F 144in—ﬂ 15in %
Center

—qE h=12in -
h=15in line Neu_tral
axis
U X4— | —PpX o 9
o .. [J [] [] [J ° ° .. [
Y o o° 2 L e ] ° ° oo o
a 0 0 f 0 0 O
x,n 53 ~ N N < T3
o ~
A Bk 8 8 o 8 g 8 Bab
sty o N o o o o o o o N
©
=]
__—15
I o
1 Fc=24 ir‘r#
0.015 :

Strain Diagram

1. From the Start Menu, go to All Programs | StructurePoint | spColumn and run Design Assistant”’.

2. Design Assistant uses macros to export data to text files. If a macro warning is displayed when opening
Design Assistant, make sure macros are enabled in order for the exporting function to work properly.

3. Choose Example 4 Tab in the spreadsheet.
Input the data shown below:

e  Under OVERALL SECTION WIDTH IN X, input 15.

e  Under OVERALL SECTION HEIGHT IN Y, input 144.

e  Under WEB WIDTH, input 12.

e  Under WEB HEIGHT, input 114.

e  Under NUMBER OF BOUNDARY BARS IN X, input 3.

e  Under NUMBER OF BOUNDARY BARS IN'Y, input 3.

e  Under NUMBER OF WEB BARS PER LAYER, input 8.

e  Under WEB BAR SPACING, input 18.

e  Under COVER, input 2.5.

e  Under REINFORCEMENT AREA PER BOUNDARY BAR, input 0.79.

e  Under REINFORCEMENT AREA PER WEB BAR, input 0.31.

76 Based on Example 4-4, pp 333, from Seismic and Wind Forces Structural Design Examples by Alan Williams, Third Edition, 2007,
International Code Council.

"7 Design Assistant is a Microsoft Excel spreadsheet that can be used to facilitate creation of spColumn text import files for a variety of
sections including dumbbell shaped and C-shaped shear walls.
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B Microsoft Excel - Templates
E_] File Edit Wiew Insert Formak Took Data  Window Help  Adobe POF
inEEREo 0 Bif- |0 B zu
nEER
- &
a | B | E [ o [ E T F T & [ H ] [ T S O T T -
1 Input__ | Output |
| 2 | Mote: 1Mo units are used. Itis the user's responsibility to maintain the consistenay of units.
3 2.00a not delete or move output data cells. Cthervise the exparted data might be incorrest.
4
5
8 Ouerall Section Widthin %] 16 Export Geometry Geometry Fieinforcement
7 Overall Seation Heightin 7 14 % ¥ Boundan] = Tt ek % ¥
B Web width] 12 ECCH B T 5000 | 3500 T 3500 | Ga00
3 web Height] 11t Export Reinforeme 7500 | 72000 2 5000 | 53500 2 3500 | #5.000
[ humber of Boundan Barsin %] 3 7500 [ 57.000 3 0000 | 63500 3 3500 | 27000
n Humber of Boundan Barsin ¥] 3 " eo00 | sromo 4 0000 | 53500 4 3500 | 9000
B humber of Web Bars per Layer] % eoo0 | -57.000 5 5000 | 3500 5 3500 | -9.000
3 Web Bar Spacing| 18 7500 | 57000 6 5000 | 53500 6 3500 | -2r.o00
# Cover| 28 7500 | 72000 7 5000 | 4500 7 3500 | -4s.000
& | Feinforcement Area per Boundary Bar] 073 7500 | -7z000 ] 5000 | 4500 ] 3500 | 63000
® Reinforeement Area per Web Bar] 021 7500 [ 57000 3 5000 | 63500 3 2500 | 3000
[ | " 5000 | 57.000 [ 5000 | 53500 10 3500 | 45000
| 6000 | §7.000 1 0000 | 63500 1 3500 | z7.000
B 7500 | 57.000 [ 0000 | 53500 © 3500 | 2000
|20 7500 | 72000 [ 5000 | 63500 © 2500 | -s.000
21 1 5000 | 53500 # 3500 | -2r000
oo | [ 5000 | 64500 I3 3500 | -45000
23 | & 5000 | 64500 ® 3500 | 63000
2 7 w
|2 | [ ®
B [ [
= 20 20
E 21 21
29 22 22
Ea 23 2
ER 2 2
[ 32 | % 25
E 6 2
34 0 T2 54 6 13 15 56 54 T2 2 27
Ea 2 2
Ea 29 23
37 | 30 30
1 3 E
E 2 32
|40 3 £
EN k 3 3
ez | 2 3
43 * * b
W 4 ¢ M Read Me Y Exampled J Examples f Exampled £ Example10 f Sxamph | < >
Ready

5. Press Export Geometry Button and Save Geometry File box appears. Save the file as Example4-
Geo.txt

Save Geometry, File

Savein: |_) Examples j &= ﬁ '

My Recent
Documents

|

=]
Il

skt

=

&

My Documents

;

&

My Computer
“P} File name: | j Save
-
My Metwork  Save as bpe: |Tsxl Files [*.tat] ﬂ Cancel
Places

6. Press Export Reinforcement button and Save Reinforcement File dialog box appears. Save the file as
Example4-Reinf.txt

5-22 Examples



sfcolumn

Save Reinforcement File @

Save in |Lf) Examples ﬂ = E-
2. E] Exampled-Geo
My Recent
Documents
€
Deskiop

My Documents

58

My Computer

- File name: |Examp\e4ﬂe\nf j Save
My Network  Save as lype: |Text Files [* txt] j Cancal
Flaces

Save and close the Design Assistant spreadsheet.
8. From the Start Menu, go to All Programs | StructurePoint | spColumn and run spColumn
From the File menu, choose New. Any input data is cleared and the default values are restored.

10. From the File menu, choose Import | Import Data. Import Data (from text file) dialog box appears.
Make sure that Geometry radio button is checked, choose OK

Import Data (from text file)

" Reinforcement
™ Service loads
(™ Factored loads

LCancel

11. Open Import File box appears. Select Example4-Geo. txt file and choose Open. The shear wall
geometry appears on the spColumn screen.

Open Import file Iilf'gl

Look jn: |lﬂ Examples j o ef B~

‘_\?§ % Emple4

My Recent
Dacuments

e0
inf
7=
L
Desktop
by Documents

My Computer

bty Network — File pame: ‘Examp\edﬁeo j Open I
Places
Files of tupe: [ Teut Files [t =l Cancel

12. From the File menu, choose Import | Import Data. Import Data (from text file) box appears. Press
Reinforcement radio button, then Choose OK

Import Data {from text file)

ol

™ Factored loads
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13. Open Import File box appears. Select Example4-Reinf.txt file and choose Open. The shear wall
reinforcement appears on the spColumn screen as well.

Open Import file @

Look jn: ‘L:‘)Examples j B B

e

My Recent
Documents

Desktop

=| Exampled-Geo

My Documents

My Computer

My MNetwork — File pame: ‘Exampled-ﬂe\nf j Open
Places
Files of type: [ Text Files [“t) Bl Cancel

14. From the Input menu, choose General Information Tab. Input Project Information and leave all other
options in their default settings of ACI 318-11 design code. Choose OK

General Information g|

Labels-
Froject:

|spEOIumn I anual Example 4

Colurmr: Engineer:
|AlanEx 4.4 SF
Unitz Fun Option
* English @ Irwestigation
" Metric -

i~ Run Axiz 1 Design Code

* About X-Asis

(" About-duis " ACI 31808

" Biawial ™ ACI 31805
7 ACI 31802
" C5AA233-04
7 CEAAZIS 04

Consider slenderness? © Yes & No

Ok | Lancel ‘

15. From the Input menu, choose the Material Properties tab. VERIFY CONCRETE STRENGTH, fc’, and

REINFORCING STEEL STRENGTH, fy, values are entered as 4 ksi, and 60 ksi respectively. Leave all other
options in their default settings. Choose OK

Material Properties f'5_<|

Concrete Rieinforcing Steel

Strength, fe: ’E!— ksi Strength, fy: IBU— ksi
Elasticity, Ec: [3605  ksi Elasticity, Es: {23000 ksi
an stress, fo: 'T ksi

Beta(l] [ogs

Ultirnate strair: W

0K LCancel |

16. From the Input menu, choose Reinforcement | Confinement Tab.
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e  From the CONFINEMENT drop-down menu choose OTHER.
e Input AXIAL COMPRESSION (a) as 0.85.

e Input COMPRESSION CONTROLLED FAILURE (c) as 0.7.

e Leave all other options in their default settings. Choose OK

Confinement E|

Confinement: | Other -

Capacity Reduction Factors, Phi

Awial comprezzion (a]: 0.85
Tenzion-contralled failure [B]: 049

Compression-controlled failure (] |07

Tie Sizes

#3 | tieswith |#10 | bars or smaller.
#4 | ties with larger bars.

LCancel

17. From the Input menu, choose Loads | Axial Loads Tab.
e Input 649.5 for the INITIAL LOAD. The initial axial load was selected
through trial and error procedure in order to match neutral axis depth | iiialload  Finalload  Increment
of 24 in. given in the example. D D
[kip) [kip) [kip)
e  Choose INSERT. Then, choose OK Tt | o | Dol |
18. From the Solve menu, choose Execute. [No. el Final Ine
e C(Click No when the warning message is displayed saying
“Reinforcement ratio is less than 1%. Consider column as
architectural (i.e. fc is reduced by reinforcement ratio?)”.
e The solver of the program is started and, upon completion, displays
the interaction diagram of the section.
19. From the View menu, choose Results. oK Cancel
e Page through the results file.
e  Choose EXxit to quit the spView program and get back to spColumn.
20. From the File menu, choose Print Results.
e Select the printer to send the text results to.
e Choose PRINT.
21. From the File menu, choose Print Screen.
e Select the printer to send the graphical results to.
e  Choose PRINT
Examples 5-25
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Ve P (kip)
e 6000 +
T (Pmax) Lo (Pmax)
Y,
Hx
.. i) !
fs=0 1 fs=0
. fs=0.5 1 fs=0.5fy
15 x 144 in
Code: ACI 318-11
Units: English
Run axis: About X-axis 1
Run option: Investigation
Slenderness: Not considered
Column type: Structural f 1 1 f 1 f f f 1 !
-12000 12000
Bars: ASTM A615 Mx (k-ft)
Date: 06/22/11
Time: 18:46:02 (Pmin) 1000 (Pmin)
spColumn v4.80. Licensed to: StructurePoint. License |D: 00000-0000000-4-25900-25900
File: C:\Program Files\StructurePoint\spColumn\Examples\Example04.col
Project; spColumn Manual Example 4
Column: Alan Ex 4.4 Engineer: SP
fc =4 ksi fy =60 ksi Ag=1818in"2 32 bars
Ec = 3605 ksi Es = 29000 ksi As =17.60in"2 rho =0.97%
fc = 3.4 ksi Xo =0.00in Ix = 3.36209e+006 in"4
e_u = 0.003 infin Yo =0.00in ly = 24853.5 in"4
Betal =0.85 Min clear spacing = 1.31 in Clear cover = N/A
Confinement: Other
phi(a) = 0.85, phi(b) = 0.9, phi(c} = 0.7

5-26

Examples



sfcolumn

STRUCTUREPOINT - spColumn v4.80 (TM)
Licensed to: StructurePoint. License

ID: 00000-0000000-4-2

59%00-25900

C:\Program Files\StructurePoint\spColumn\Examples\ExampleO4.col

General Information:

File Name: C:\Program Files\StructurePoint\spColumn\Examples\Example04.col

Project: spColumn Manual Example

Column: Alan Ex 4.4

Code: ACI 318-11

Run Option: Investigation

Run Axis: H-axis

Material Properties:

f'e = 4 ksi

Ec = 3605 ksi

Ultimate strain = 0.003 in/in

Betal = 0.85

Section:
Exterior Points
No. X (in) ¥ (in) No.

1 -7.5 72.0 2
4 6.0 57.0 5
7 7.5 -72.0 8
10 -6.0 -57.0 11

Gross section area, Ag = 1818 in”"

Ix = 3.36209e+00& in™4

rx = 43.0039 in

Xo = 0 in

Reinforcement:

Bar Set: ASTM R615

Size Diam (in) Area (in"2) Size
$# 3 0.38 0.11 # 4
¥ & 0.75 0.44 £ 7
$ 9 1.13 1.00 § 10
# 14 1.69 2.25 £ 18

Confinement: Other; #3 ties with #
phi(a) = 0.85, phi(b) = 0.9, phi

Pattern: Irregular
Total steel area: As = 17.60 in"2

4
Engineer: SP
Units: English
Slenderness: Not considered
Column Type: Structural
fy = 60 ksi
Es = 29000 ksi
¥ (in) Y (in) No X (in) ¥ (in)
7.5 72.0 3 7.5 57.0
6.0 -57.0 6 7.5 -57.0
-7.5 -72.0 9 -7.5 -57.0
-6.0 57.0 12 -7.5 57.0
2
Iy = 24853.5 in"4
ry = 3.6974 in
Yo = 0 in

Diam (in) Area (in"2)

Size Diam (in) Area (in"2)

Minimum clear spacing = 1.31 in
Area in"2 X (in) ¥ (in) Area
0.79 5.0 69.5
0.79 0.0 558.5
0.79 5.0 64.5
0.79 5.0 -55.5
0.79 -5.0 -69.5
0.79 -5.0 -64.5
0.31 3.5 27.0
0.31 3.5 -27.0
0.31 -3.5 63.0
0.31 -3.5 S.0
0.31 -3.5 -45.0
ZAxial Load and Corresponding Moment
Load PhiPn PhiMnx NA
No kip k-ft
1 649.5 8395.14

-5395.14

*%% End of output ***

0.50 0.20 # 5 0.63 0.31
0.88 0.60 # 8 1.00 0.7%
1.27 1.27 # 11 1.41 1.586
2.26 4.00
10 bars, #4 with larger bars.
(c) = 0.7
at rho = 0.97% (Note: rho < 1.0%)
in™2 X (in) Y (in) Area in"2 X (1in) Y (in)
0.79 5.0 59.5 0.79 0.0 €9.5
0.79 -5.0 69.5 0.79 -5.0 59.5
0.79 -5.0 64.5 0.79 5.0 -69.5
0.79 0.0 -68.5 0.79 0.0 -59.5
0.79 -5.0 -589.5 0.79 5.0 -64.5
0.31 3.5 €3.0 0.31 3.5 45.0
0.31 3.5 9.0 0.31 3.5 -9.0
0.31 3.5 -45.0 0.31 3.5 -63.0
0.31 -3.5 45.0 0.31 -3.5 27.0
0.31 -3.5 -9.0 0.31 -3.5 -27.0
0.31 -3.5 -63.0
Capacities:
depth Dt depth eps_t Phi
in in
24.00 141.50 0.01489 0.5%00
24.00 141.50 0.0146% 0.9200

Page 2z
06/22/11
06:45 PM
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Chapter 6

spSection Module

spSection is an add-on module to the spColumn program. It enables the user to investigate irregularly shaped
reinforced concrete sections subject to a combination of loadings. spSection considers a polygonal section
reinforced with bars located at any location. The section may contain one opening. In addition, spSection
allows easy modification of a circular section by converting it into an approximate polygon.

spSection is accessed from within spColumn. Once spColumn is started, you can activate spSection by
selecting the Section | Irregular command from the Input menu. This starts spSection, minimizes and locks
the spColumn window and maximizes the spSection window. The section geometry may then be defined by
drawing it on the screen or by inputting the coordinates of the polygon nodes. Once the section definition is
complete, return to spColumn by selecting Save and Exit from the Main menu.

Once the irregular section is defined, its reinforcement is input using spSection as well. This is done by
selecting the Reinforcement | Irregular command from the Input menu of spColumn. The section
reinforcement may also be defined graphically.

Main Menu

Drawing Area

Set the limits for the drawing area and control the grid and snap settings.

Save and Exit

Accept the input and/or modifications made in spSection and return to spColumn.

Exit without Saving

Discard the input and/or modifications made in spSection and return to spColumn.

Edit Menu

Section

Toggles the input/editing session to the section.

Opening

Toggles the input/editing session to the section opening.

Reinforcement

Add

Delete

Move

Toggles the input/editing session to the section reinforcement.

Switches to the Add mode to graphically insert section or opening nodes or reinforcing bars.

Switches to the Delete mode to graphically delete section or opening nodes or reinforcing bars.

Switches to the Move mode to graphically move section or opening nodes or reinforcing bars.
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Modify
Allows manual editing of the section or opening node coordinates or the reinforcing bar area and coordinates.

View Menu

Zoom
Magnifies or reduces the graphical image.

Pan
Translates or moves the graphical image.

Redraw
Redraws the displayed section and resets the Zoom and Pan actions.

Grid
Shows or hides the grid.

Snap
Toggles the Snap On and Off. With the SNAP ON, the cursor snaps (sticks) to exact locations.

Labels
Shows or hides the internal numbering of section (or opening) nodes and bars.

Status bar
Shows or hides the Status bar.

Help Menu

spSection Help
Lists all the available help topics about the program.

spColumn Manual
Opens spColumn Manual in the default PDF viewer.

About X
. . . . . Drawing A
Displays copyright information and the version number of the program. (FRHE J[ed :
Lirniits
¥
Defining the Drawing Area Mirimum: L 50 in

e Select Main | Drawing Area. A dialog box appears. This step is not M awimum: |50 80 i
needed the first time spSection is started wusing spColumn’s =
Section | Irregular command. The box is automatically displayed.

b Y
Step: 10 10 in

e Input the limits (MINIMUM and MAXIMUM) of the area within which the

section is to be drawn in both directions. IV Show Grid
e Input the interval (step) for the grid system. The grid is used as a guideline | " % v
when drawing. Step |5 5 &
e Select or clear the SHOW GRID option to show or hide the grid. ¥ SnapOn
e Input the interval (STEP) for the snap. The snap settings may be different
than the grid settings and may be different in each direction (x and y). aK Cancel |
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Select or clear the SNAP ON option to activate or disable the Snap.

Choose the OK button.

Graphical Editing of the Section or Opening

In spSection, the section (or opening) must be a closed polygon. It is defined by inputting the nodes at each
corner or vertex of the polygon. No two segments (sides) may overlap or cross and no two nodes may
coincide. An opening must lie completely within the section.

The coordinates that correspond to the cursor location are always displayed in the Status bar. To force the
cursor to “stick” to exact locations, turn the SNAP option on. The program will snap to locations whose
coordinates are multiples of the snap steps.

To add section or opening nodes:

Switch the input session to Section (or Opening) by selecting Edit | Section (or Edit | Opening).
Switch the input mode to ADD by selecting Edit | Add.

If you are editing a section (or opening), you must first click on an existing node. Once this is done, you
can insert subsequent nodes.

Adding a node is done by moving the cursor to a desired location within the Graphics area and clicking
the left-mouse button.

After inserting a node, a line extending from the last added node follows the cursor. Click at another
location to insert subsequent nodes. A line connecting the two nodes is drawn.

To end the drawing, click the right-mouse button or press the ESC key. The first and last nodes are
connected to close the section. Also note that while in the ADD mode, moving the cursor outside the
Graphics area ends the drawing.

To delete section or opening nodes:

Switch the input session to Section (or Opening) by selecting Edit | Section (or Edit | Opening).
Switch the input mode to DELETE by selecting Edit | Delete.

Marquee select the node (or nodes) to be deleted. This is done by moving the cursor to one location,
pressing the left-mouse button and while holding the button down, moving to another location. While
moving, a dotted rectangle (called the marquee) is drawn. Releasing the left-mouse button end the
marquee. All nodes that are enclosed with the marquee are deleted and the section (or opening) is
redrawn. To cancel a marquee action while holding down the left-mouse button, press the ESC key or
click the right-mouse button. Also, leaving the Graphics area cancels the marquee operation.

To move section or opening nodes:

Switch the input session to Section (or Opening) by selecting Edit | Section (or Edit | Opening).
Switch the input mode to Move by selecting Edit | Move.

Place the cursor over the node to be moved then press and hold the left-mouse button. As long as the
button is held down, moving the cursor moves the selected node to the cursor location. Once the node is
at the new desired location, release the mouse button. To cancel a move action while holding down the
left-mouse button, press the ESC key or click the right-mouse button. Also, leaving the Graphics area
cancels the move operation.

Graphical Editing of the Reinforcement

In spSection, the reinforcing bars may be located anywhere. The only restriction imposed in the program is
that no two bars may overlap. The coordinates that correspond to the cursor location are always displayed in

spSection Module 6-3
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the Status bar. To force the cursor to “stick” to exact locations, turn the Snap option on. The program will
snap to locations whose coordinates are multiples of the snap steps. While in the Reinforcement session, you
cannot switch to the Section or Opening sessions without returning to spColumn. Therefore, the
Edit | Reinforcement command will have a check mark to its left. You use the command to specify the bar
size or area and the number of bars to be added.

To add one single bar at a time:

Switch the input mode to Add by selecting Edit | Add. Reinforcement E]
Select Reinforcement from the Edit menu. A dialog box appears. Number ofbars: [T
In the Number of bars box, input 1. * Barsize: |H7 ¥

Choose the Size option and select the size of the bar or choose the Area ® Bejeres in
option and input the bar area in the edit box.

Choose the OK button. K | el |

In the Graphics area, point to the desired location and click. A bar is inserted.

Repeat the step above to insert more bars.

To generate multiple bars:

Switch the input mode to Add by selecting Edit | Add. The command must have a check mark left of it.
Select Reinforcement from the Edit menu. A dialog box appears.
Input the number of bars to be generated (should be greater than 1).

Choose the Size option and select the size of the bar or choose the Area option and input the bar area in
the edit box.

Choose the OK button.

In the Graphics area, click at a location (let us call it point A), move the cursor to another location and
click (let us call it Point B). The specified number of equally-spaced bars is added, along the line
connecting the points A and B. For subsequent generations, point B becomes A and you only need to
click at the second point (B) to generate more bars.

To end the multiple bar generation or move to another location (without adding bars), click the right-
mouse button or press the ESC key. Also note that while in the multiple bar generation of the Add mode,
moving the cursor outside the Graphics area aborts the generation.

To delete bars:

Switch the input mode to DELETE by selecting Edit | Delete.

Marquee select the bar(s) to be deleted. This is done by moving the cursor to one location, pressing the
left-mouse button and while holding the button down, moving to another location. While moving, a
dotted rectangle (called the marquee) is drawn. Releasing the left-mouse button end the marquee. All
bars that are enclosed with the marquee are deleted. To cancel a marquee action while holding down the
left-mouse button, press the ESC key or click the right-mouse button. Also, leaving the Graphics area
cancels the marquee operation.

To move a bar:

Switch the input mode to Move by selecting Edit | Move.

Place the cursor over the bar to be moved then press and hold the left-mouse button. As long as the
button is held down, moving the cursor moves the selected bar with it. Once the bar is at the new desired
location, release the mouse button. To cancel a move action while holding down the left-mouse button,

6-4

spSection Module



sfcolumn

press the ESC key or click the right-mouse button. Also, leaving the Graphics area cancels the move

operation.

Manual Editing of the Section or Opening

Switch the input session to Section (or Opening) by selecting
Edit | Section (or Edit | Opening).

Select Edit | Modify. A dialog box appears. If you have already
defined a section (or opening), the coordinates of its nodes are shown
in the list.

To add a node, enter its x and y coordinates and choose the INSERT
button. The entry is inserted in the list box following the selected entry.

To edit an entry, select it from the list box, modify its values in the text
boxes, and choose the MODIFY button.

To delete an entry, choose it from the list box and choose the DELETE

X

| Delete

Opening

H-coord: [ i
r-coond: |15 in
Inzert | todify

|

1 -0 i)
20 il
i B 20
4 5 5
]

button. 0K Cancel
e Choose the OK button.
Manual Editing of the Reinforcement
e Seclect Edit | Modify. A dialog box appears. ,
Reinforcement §|
e To edit an entry, select it from the list box, modify its values in the text —
boxes, and choose the MODIFY button. You can change the area of a | #4rea i in"2
group of bars by selecting them from the list, enter the new area and W-coord: |-45 in
choose MODIFY. voood [ i
. Eﬁtg)eri.ete an entry, choose it from the list box and choose the DELETE m Modiy | Dekete
I
e Choose the OK button. 3 06 10 10 A
4 06 10 20
) ) 5 06 0 20
Zooming and Panning the Image 5 88 1 %0
g 06 0 30
Zooming is the enlargement or reduction of the graphical image. Panning is 306 10 20
the translation or movement of the image.
Zooming:
. 0K LCancel
e Select View | Zoom.
e To enlarge the view (zoom-in): using the left-mouse button, click anywhere within the Graphics area.
Click again for further magnification.
e To reduce the view (zoom-out): using the right-mouse button, click anywhere within the Graphics area.
Click again for further reduction.
e To reset the Zoom and return to the default, select View | Redraw.
Panning:

Select View | Pan.

Place the cursor over the Graphics area. Press the left-mouse button and, while still holding the button,
move the cursor in the direction you wish to pan. A line showing the amount and direction of panning is

drawn.

spSection Module
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e Release the mouse button. The view is panned and the image is redrawn.

e To reset the Pan and return to the default, select View | Redraw.

Keyboard shortcuts:
The following keyboard assignments are always active:

Key combination Action

Ctrl + Page Up Zoom-in

Ctrl + Page Down Zoom-out

Ctrl + Cursor key Pan

Enter Reset zoom/pan (Redraw)

Example 5 - Capacity of an Irregular Section

Compute horizontal moment capacity Mx of the unsymmetrical beam cross section’® shown below. Use 3-ksi
concrete and 60-ksi reinforcing steel.

General Information E|
Labels
% 24" Froject:
4 |spEnIumn t anual Example &
Column: Engineer:
T |MacGregol4 T SP
21.5" 24" Units Run Option
% English % |nvestigation
" Metric o
(2)_#8 1 1 e Run Az Design Code
(1)-#9 Q -° " Abaut ¥-ds
2.142" —»| lt— " AboutY-Axis " ACI 318-08
—> FZ.OO" @ Biaial " ACI318-05
" " ACI 31802
12 ﬂ 054422304
(" CSAAZI3-94

Consider slendemess? © Yes & No

Note: when instructed to move to a location (15, 25), move the cursor until the
cells in the Status bar show “x=15 and “y=25". e Lancel_|

From the File menu, choose New. Any input data is cleared and

the default values are restored. Meterial Propertics X

1. From the Input menu, choose General Information. Concrete Reinforcing Stesl
e Select English units and ACI 318-11 code. Stength, fo: | ksi | Swength.fy: |80 ki

. . Elasticity, Ec: (31220 ksi Elasticity, Es: (25000 ksi
e Select BIAXIAL for RUN AXIS, Investigation for run

option and NO for CONSIDER SLENDERNESS?

e Choose OK.

Max stress, fo: |255 ks
Beta[1]: 085

Ultirnate strain: {0.003
2. From the Input menu, choose Material Properties.

e  Under CONCRETE, input 3 for the STRENGTH. Other pro-
perties are computed and will be accepted. s el

e Choose OK.

78 Based on Example 4.7, pp 161 from Reinforced Concrete: Mechanics and Design by James G. Wight and James K. MacGregor, Fifth
Edition, 2009, Pearson Prentice Hall, Pearson Education Inc.
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3. From the Input menu, choose Section | Irregular. The spSection module is
loaded, its window occupies the desktop, and the DRAWING AREA box
appears.

4. The default input session is Section and the default input mode is Add (the

Drawing Area E|
Lirnits
K Y
Mirimum: -40 in

Under Limits, input 0 and 20 for the MINIMUM X and MINIMUM Y,
Mawimum: |40 40 in

respectively.

Under limits, input 24 and 4 for the MAXIMUM X and MAXIMUM Y, o ® v

respectively. Sep 4 4 i

Under GRID, input 4 and 4 for X and Y grid STEP, respectively and check | | *"**™

the SHOW GRID option. snep w -

Under SNAP, input 4 and 4 for X and Y STEP, respectively and check the der —
I¥ ShapOn

SNAP ON option.

Choose OK.

LCancel

Edit | Section and Edit | Add options are checked).

In the Graphics area, move the cursor to the location (0, 0) and click the left mouse button. A node is
inserted.

Move to (12, 0) and click the left mouse button.
Move to (12, -20) and click the left mouse button.
Move to (24, -20) and click the left mouse button.
Move to (24, 4) and click the left mouse button.
Move to (0, 4) and click the left mouse button.

Move to (0, 0) and click the left mouse button.

e  Click the right-mouse button to end drawing the section. P — X
5. From the Main menu, choose Save and EXxit. You are returned to spColumn | yuuberotbass 1

and the section is shown in the Information bar. 5 Benctr =
6. From the Input menu, choose Reinforcement|Irregular. The spSection | ¢ pases [ in

module is loaded, its window occupies the desktop.

7. The default input session is Reinforcement and the default input mode is Add
(the Edit | Reinforcement and Edit | Add options are checked).

Lancel

8. Define some bars using multiple bar generation:

Reinforcement E|
Area 1 in"2
14142 i
175 in

Inzert |

From the Edit menu, choose Reinforcement. Input 1 for the NUMBER
OF BARS and select #9 for the BAR SiZE. Choose OK.

Move the cursor to any location and click the left mouse button. Recoord:

“-coord:

From the Edit menu, choose Modify. Input 14.142 for X-COORD and -

17.5 for Y-COORD. Click MODIFY and then OK. Moy | Delete |

From the Edit menu, choose Reinforcement. Input 1 for the NUMBER
OF BARS and select #8 from BAR SIZE. Choose OK.

Move the cursor to any location and click the left mouse button. A #8
bar is generated at that location.

From the Edit menu choose Modify. Input 18 for X-COORD and -17.5
for Y-COORD. Click MODIFY and then OK.

ok Lancel

From the Edit menu, choose Reinforcement. Input 1 for the NUMBER
OF BARS and select #8 from BAR SIZE. Choose OK.

spSection Module 6-7
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9.

10.
11.
12.

13.

14.

15.

e Move the cursor to any location and click the left mouse button. A #8 bar is generated at that

location.

e From the Edit menu choose Modify. Input 22 for X-COORD and -17.5 for Y-COORD. Click Modify

and then Ok

Main Edit View Help

#=17 48in y=712in Zoom ir: click left buttan, hold, diag, and release. Use right button ta zoo

m out.

From the Main menu, choose Save and EXxit. You are returned to spColumn and the section is shown in

the Information bar.

From the Input menu, choose Input | Loads | .Factored

Enter LOAD as 0 (zero), X-MOMENT as -225 ft-kips and Y-MOMENT as 0.
From the Solve menu, choose Execute.

e A message is displayed saying “Reinforcement ratio is less than 1%
Consider column as architectural (i.e. fc is reduced by reinforcement
ratio?)”. Click NoO for this option.

e The solver of the program is started and, upon completion, displays
the interaction diagram of the section.

From the View menu, choose Results.

e  Page through the results file.

e Choose Exit to quit the spView program and get back to spColumn.
From the File menu, choose Print Results.

e Select the printer to send the text results to.

e Choose PRINT.

From the File menu, choose Print Screen.

e Select the printer to send the graphical results to.

e  Choose PRINT

Load

H-Moment “r-Moment

o
[kip)

Inzert |

|-225
[leA]

Modiy | Deete |

o
[k-Ht]

| Mo,

P

[GH]

My

e  Change the interaction diagram to show the P-M diagram at 180° using the icon.

6-8
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24 % 24 in

Code: ACI 318-11

Units: English

Run axis: Biaxial

Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: ASTM A615

Date: 06/22/11

Time: 18:48:41

400 — My (k-ft)

P =0 kip

-400 —-

spColumn v4.80. Licensed to: StructurePoint. License |D: 00000-0000000-4-25900-25900

Project; spColumn Manual Example 5

Column: MacGregord.7

Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

fec=3ksi fy =60 ksi

Ec = 3122 ksi Es = 29000 ksi
fc = 2.55 ksi

e_u=0.003 infin

Betal =0.85

File: C:\Program Files\StructurePoint\spColumn\Examples\Example05.col

Engineer: SP

Ag =336in"2 3 bars

As =2.58in"2 rho =0.77%

Xo =16.29in Ix =18002.3 in"4
Yo =-6.57in ly = 9956.56 in"4

Min clear spacing = 2.79 in Clear cover = N/A

spSection Module
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24 % 24 in

Code: ACI 318-11

Units: English

Run axis: Biaxial

Run option: Investigation
Slenderness: Not considered
Column type: Structural
Bars: ASTM A615

Date: 06/22/11

Time: 18:50:18

P (kip)
700 +
Pmaxy {1 (Pmax)
f 1 f i i f f —1—
250
M 0°) (k-ft)
G R (Pmin)
-200 +

spColumn v4.80. Licensed to: StructurePoint. License |D: 00000-0000000-4-25900-25900

Project; spColumn Manual Example 5

Column: MacGregord.7

fec=3ksi fy =60 ksi

Ec = 3122 ksi Es = 29000 ksi
fc = 2.55 ksi

e_u=0.003 infin

Betal =0.85

Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

File: C:\Program Files\StructurePoint\spColumn\Examples\Example05.col

Engineer: SP
Ag =336 in"2
As =2.58in"2
Xo =16.29in
Yo =-6.57in

Min clear spacing = 2.79 in Clear cover = N/A

3 bars

rho =0.77%

Ix =18002.3 in"4
ly = 9956.56 in"4

6-10
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STRUCTUREPOINT - spColumn v4.80 (TM) Page 2
Licensed to: StructurePoint. License ID: 00000-0000000-4-25900-25%00 06/22/11
C:\Program Files\StructurePoint\spColumn\Examples\Example05.col 06:48 PM
General Information:
File Name: C:\Program Files\StructurePoint\spColumn\Examples\Example05.col
Project: spColumn Manual Example 5
Column: MacGregord4.7 Engineer: SP
Code: ACI 318-11 Units: English
Run Option: Investigation Slenderness: Not considered
Run Axis: Biaxial Column Type: Structural
Material Properties:
f'ec = 3 ksi fy = 60 ksi
Ec = 3122.02 ksi Es = 29000 ksi
Ultimate strain = 0.003 in/in
Betal = 0.85
Section:
Exterior Points
No. X (in) ¥ (in) No. ¥ (in) Y (in) No. X (in) ¥ (in)
1 0.0 0.0 2 12.0 0.0 3 1z2.0 -20.0
4 z24.0 -20.0 5 24.0 4.0 6 0.0 4.0
Gross section area, Ag = 336 in"2
Iz = 18002.3 in™4 Iy = 9956.56 in*4
rx = 7.31972 in ry = 5.44359 in
Xo = 16.2857 in Yo = -6.57143 in
Reinforcement:
Bar Set: ASTM A615
Size Diam (in) Area (in"2) Size Diam (in) Area (in"2) Size Diam (in) Area (in"2)
# 3 0.38 0.11 ¥ 4 0.50 0.20 # 5 0.63 0.31
¥ 8 0.75 0.44 £ 7 0.88 0.60 # 8 1.00 0.7%
$# 9 1.13 1.00 # 10 1.27 1.27 # 11 1.41 1.586
# 14 1.69 2.25 £ 18 2.26 4.00
Confinement: Tied; #3 ties with #10 bars, #4 with larger bars.
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65
Pattern: Irregular
Total steel area: As = 2.58 in”2 at rho = 0.77% (Note: rho < 1.0%
Minimum clear spacing = 2.7% in
Area in"2 X (in) ¥ (in) Area in"2 X (in) Y (in) Area in"2 X (in) ¥ (in)
1.00 14.1 -17.5 0.79 18.0 -17.5 0.79 22.0 -17.5
Factored Loads and Moments with Corresponding Capacities:
Pu Mux Muy PhiMnx PhiMny PhiMn/Mu NA depth Dt depth eps_t Phi
No. kip k-ft k-ft k-ft k-ft in in
1 0.00 -225.00 0.00 -224.43 -0.00 0.997 7.21 23.53 0.00685 0.900 #

# Section capacity exceeded. Revise design!

*%% End of output **¥

spSection Module
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Appendix

Import File Formats

Geometry, reinforcement or load data may be imported from a text file. The import file must be saved in pure
ASCII (text) format. Data fields on each line should be separated by spaces or TABs. Comments or blank
lines should not be placed within the import file.

Service Loads Data:

No Of Load Points

P1 D Mlx DT M1lx DB Mly DB Mly DB

P1 L M1x LT Mlx LB Mly LT Mly LB

P1 W M1x WT M1x WB Mly WT Mly WB
P1_EQ M1xX EQT Mlx EQB Mly EQT M1y EQB
P1_S Mlx ST Mlx SB Mly ST Mly SB

Pn D Mnx DT Mnx DB Mny DB Mny DB
Pn L Mnx LT Mnx LB Mny LT Mny LB
Pn W Mnx WT Mnx WB Mny WT Mny WB
Pn_EQ Mnx EQT Mnx EQB Mny EQT Mny EQB
Pn S Mnx ST Mnx SB Mny ST Mny SB

Each service load point has five lines of data (one line for each load case, i.e. Dead, Live, Wind, Earthquake,
and Snow). Each data line has five values. For a service load point i, P1_D, Mix DT, Mix DB, Miy DT,
and Miy DB are the axial load, My at top, My at bottom, M, at top and M, at bottom, respectively. The
notation D, L, W, EQ, and S designate the Dead, Live, Wind, Earthquake, and Snow load cases,
respectively.

Factored Loads Data:

No Of Load_ Points
P1 M1x Mly
P2 M2x M2y

Pn Mnx Mny

For a factored load point i, P1i is the factored axial load, Mix is the factored moment about x and Miy is the
factored moment about y.

Reinforcement Data:

No Of Bars
Al X1 Y1

An Xn ¥Yn
For a bar i, Ai is the bar area, X1 is its x-coordinate, and Y1 is its y-coordinate.

Geometry Data:
No Of Section Nodes
Xsl Ysl1
Xs2 Ys2
Xsn Ysn
No Of Opening Nodes
Xol Yol
Xo2 Yo2

Xon Yon



sfcolumn

For a section node si, Xs1i is the x-coordinate of the node and Ys1i is its y-coordinate.
For an opening node oi, Xo1 is the x-coordinate of the node and Yo1 is its y-coordinate.

If the section does not contain an opening, you must have a zero for the value of No_ Of Opening Nodes.

A-2 Appendix
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spColumn Text Input (CTI) file format

spColumn is able to read and save its input data into two file formats, COL file or CTI file. CTI files are plain
text files that can be edited by any text editing software.

Caution must be used when editing a CTI file because some values may be interrelated. If one of these values
is changed, then other interrelated values should be changed accordingly. While this is done automatically
when a model is edited in the spColumn user graphic user interface (GUI), one must update all the related
values in a CTI file manually in order to obtain correct results. For example, if units are changed from
English to Metric in GUI, all the related input values are updated automatically. If this is done by editing a
CTI file, however, not only the unit flag but also all the related input values must be updated manually.

The best way to create a CTI file is by using the spColumn GUI and selecting CTI file type in the Save As
menu command. Then, any necessary modifications to the CTI file can be applied with any text editor.
However, it is recommended that users always verify modified CTI files by loading them in the spColumn
GUI to ensure that the modifications are correct before running manually revised CTI files in batch mode.

The CTI file is organized by sections. Each section contains a title in square brackets, followed by values
required by the section. The CTI file contains the following sections.

[spColumn Version]
[Project]

[Column 1D]

[Engineer]

[Investigation Run Flag]
[Design Run Flag]
[Slenderness Flag]

[User Options]

[Irregular Options]

[Ties]

[Investigation Reinforcement]
[Design Reinforcement]
[Investigation Section Dimensions]
[Design Section Dimensions]
[Material Properties]
[Reduction Factors]

[Design Criteria]

[External Points]

[Internal Points]
[Reinforcement Bars]
[Factored Loads]
[Slenderness: Column]
[Slenderness: Column Above And Below]
[Slenderness: Beams]

[El]

[S1dOptFact]

[Phi_Delta]

[Cracked I]

[Service Loads]

[Load Combinations]
[BarGroupType]

[User Defined Bars]
[Sustained Load Factors]

Each section of a CTI file and allowable values of each parameter are described in details below.
Corresponding GUI commands are presented in parenthesis.

#spCollumn Text Input (CTI) File
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The number sign, #, at the beginning of a line of text indicates that the line of text is a comment. The # sign
must be located at the beginning of a line. Comments may be added anywhere necessary in a CTI file to make
the file more readable. If a comment appears in multiple lines, each line must be started with a # sign.

[spColumn Version]
Reserved. Do not edit.

[Project]
There is one line of text in this section.

Project name (menu Input | General Information...)

[Column 1D]
There is one line of text in this section.

Column ID (menu Input | General Information...)

[Engineer]
There is one line of text in this section.

Engineer name (Menu Input | General Information...)

[Investigation Run Flag]
Reserved. Do not edit.

[Design Run Flag]
Reserved. Do not edit.

[Slenderness Flag]
Reserved. Do not edit.

[User Options]

There are 26 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right.

1. 0-Investigation Mode; 1-Design Mode; (Run Option on menu Input | General Information...)
. 0-English Unit; 1-Metric Units; (Units on menu Input | General Information...)
3. 0-ACT 318-02; 1- CSA A23.3-94; 2-ACI 318-05; 3-CSA A23.3-04; 4-ACI 318-08; 5-ACI 318-11;
(Design Code on menu Input | General Information...)

4. 0-X Axis Run; 1-Y Axis Run; 2-Biaxial Run; (Run Axis on menu Input | General Information...)

5. Reserved. Do not edit.

6. 0-Slenderness is not considered; 1-Slenderness in considered; (Consider slenderness? on menu Input |
General Information...)

7. 0-Design for minimum number of bars; 1-Design for minimum area of reinforcement; (Bar selection

on menu Input | Reinforcement | Design Criteria...)

Reserved. Do not edit.

9. 0-Rectangular Column Section; 1-Circular Column Section; 2-Irregular Column Section; (menu Input |
Section)

10.  0-Rectangular reinforcing bar layout; 1-Circular reinforcing bar layout; (Bar Layout on menu Input |
Reinforcement | All Sides Equal)

11.  0-Structural Column Section; 1-Architectural Column Section; 2-User Defined Column Section;
(Column Type on menu Input | Reinforcement | Design Criteria...)

12. 0-Tied Confinement; 1-Spiral Confinement; 2-Other Confinement; (Confinement drop-down list on
menu Input | Reinforcement | Confinement...)

13.  Load type for investigation mode: (menu Input | Loads)

*®
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0-Factored; 1-Service; 2-Control Points; 3-Axial Loads
14.  Load type for design mode: (menu Input | Loads)
0-Factored; 1-Service; 2-Control Points; 3-Axial Loads
15.  Reinforcement layout for investigation mode: (menu Input | Reinforcement)
0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern
16.  Reinforcement layout for design mode: (menu Input | Reinforcement)
0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern
17.  Reserved. Do not edit.
18.  Number of factored loads (menu Input | Loads | Factored...)
19.  Number of service loads (menu Input | Loads | Service...)
20.  Number of points on exterior column section
21.  Number of points on interior section opening
22.  Reserved. Do not edit.
23.  Reserved. Do not edit.
24.  Cover type for investigation mode: (menu Input | Reinforcement)
0-To transverse bar; 1-To longitudinal bar
25.  Cover type for design mode: (menu Input | Reinforcement)
0-To transverse bar; 1-To longitudinal bar
26.  Number of load combinations; (menu Input | Load | Load Combinations...)

[Irregular Options]

There are 13 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (menu Input | Section | Irregular | Section Editor menu Main | Drawing
Area)

Reserved. Do not edit.

Reserved. Do not edit.

Reserved. Do not edit.

Reserved. Do not edit.

Area of reinforcing bar that is to be added through irregular section editor
Maximum X value of drawing area of irregular section editor
Maximum Y value of drawing area of irregular section editor
Minimum X value of drawing area of irregular section editor
Minimum Y value of drawing area of irregular section editor
10.  Grid step in X of irregular section editor

11.  Grid step in Y of irregular section editor

12.  Grid snap step in X of irregular section editor

13.  Grid snap step in Y of irregular section editor

RN R W=

[Ties]
There are 3 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input | Reinforcement | Confinement...)

1. Index (0 based) of tie bars for longitudinal bars smaller that the one specified in the 3™ item in this
section in the drop-down list

2. Index (0 based) of tie bars for longitudinal bars bigger that the one specified in the 3™ item in this
section in the drop-down list

3. Index (0 based) of longitudinal bar in the drop-down list

[Investigation Reinforcement]

This section applies to investigation mode only. There are 12 values separated by commas in one line in this
section. These values are described below in the order they appear from left to right.

If Side Different (Menu Input | Reinforcement | Side Different...) is selected:

1. Number of top bars
2. Number of bottom bars
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00N oL A W

10.
11.
12.

Number of left bars

Number of right bars

Index (0 based) of top bars (Top Bar Size drop-download list)

Index (0 based) of bottom bars (Bottom Bar Size drop-download list)
Index (0 based) of left bars (Left Bar Size drop-download list)

Index (0 based) of right bars (Right Bar Size drop-download list)
Clear cover to top bars

Clear cover to bottom bars

Clear cover to left bars

Clear cover to right bars

If All Sides Equal (Menu Input | Reinforcement | All Sides Equal...) or Equal Spacing (Menu Input |
Reinforcement | Equal Spacing...) is selected:

VN UL

10.
11.
12.

Number of bars (No. of Bars text box)
Reserved. Do not edit.

Reserved. Do not edit.

Reserved. Do not edit.

Index (0 based) of bar (Bar Size drop-down list)
Reserved. Do not edit.

Reserved. Do not edit.

Reserved. Do not edit.

Clear cover to bar (Clear Cover text box)
Reserved. Do not edit.

Reserved. Do not edit.

Reserved. Do not edit.

If Irregular Pattern (Menu Input | Reinforcement | Irregular Pattern...) is selected:

Reserved. Do not edit.

[Design Reinforcement]

This section applies to design mode only. There are 12 values separated by commas in one line in this section.
These values are described below in the order they appear from left to right.

If Side Different (Menu Input | Reinforcement | Side Different...) is selected:

DO N YR L

10.
11.
12.

Minimum number of top and bottom bars

Maximum number of top and bottom bars

Minimum number of left and right bars

Maximum number of left and right bars

Index (0 based) of minimum size for top and bottom bars
Index (0 based) of maximum size for top and bottom bars
Index (0 based) of minimum size for left and right bars
Index (0 based) of maximum size for left and right bars
Clear cover to top and bottom bars

Reserved. Do not edit.

Clear cover to left and right bars

Reserved. Do not edit.

If All Sides Equal (Menu Input | Reinforcement | All Sides Equal...) or Equal Spacing (Menu Input |
Reinforcement | Equal Spacing...) is selected:

AR

Minimum number of bars

maximum number of bars

Reserved. Do not edit.

Reserved. Do not edit.

Index (0 based) of minimum size of bars
Index (0 based) of maximum size of bars

A-6
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7. Reserved. Do not edit.
8. Reserved. Do not edit.
9. Clear cover

10. Reserved. Do not edit.
11.  Reserved. Do not edit.
12.  Reserved. Do not edit.

[Investigation Section Dimensions]

This section applies to investigation mode only. There are 2 values separated by commas in one line in this
section. These values are described below in the order they appear from left to right.

If rectangular section (Menu Input | Section | Rectangular...) is selected:

1. Section width (along X)
2. Section depth (along Y)

If circular section (Menu Input | Section | Circular...) is selected:

1. Section diameter
2. Reserved. Do not edit.

If irregular section (Menu Input | Section | Irregular) is selected:

1. Reserved. Do not edit.
2. Reserved. Do not edit.

[Design Section Dimensions]

This section applies to design mode only. There are 6 values separated by commas in one line in this section.
These values are described below in the order they appear from left to right.

If rectangular section (Menu Input | Section | Rectangular...) is selected:

Section width (along X) Start
Section depth (along Y) Start
Section width (along X) End
Section depth (along Y) End
Section width (along X) Increment
Section depth (along Y) Increment

A

If circular section (Menu Input | Section | Circular...) is selected:

Diameter start

Reserved. Do not change.
Diameter end

Reserved. Do not change.
Diameter increment
Reserved. Do not change.

AN S

[Material Properties]

There are 8 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input | Material Properties...)

Concrete strength, f’c

Concrete modulus of elasticity, Ec
Concrete maximum stress, fc
Beta(1) for concrete stress block
Concrete ultimate strain

Steel yield strength, fy

Steel modulus of elasticity, Es
Reserved. Do not edit.

P_NAN DR DD =

Appendix A-7



sfcolumn

[Reduction Factors]

There are 4 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input | Reinforcement | Confinement...)

Phi(a) for axial compression

Phi(b) for tension-controlled failure
Phi(c) for compression-controlled failure
Reserved. Do not edit.

eSS

[Design Criteria]

There are 4 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input | Reinforcement | Design Criteria...)

Minimum reinforcement ratio
Maximum reinforcement ratio
Minimum clear spacing between bars
Design/Required ratio

L=

[External Points]

This section applies to irregular section in investigation mode only. The first line contains the number of
points on exterior section perimeter. Each of the following lines contains 2 values of X and Y coordinates
(separated by comma) of a point.

Number of Points, n
Point_1 X, Point 1 Y
Point_2 X, Point 2 Y

ﬁéint_n_x, Point n Y

[Internal Points]

This section applies to irregular section in investigation mode only. The first line contains the number of
points on an interior opening perimeter. Each of the following lines contains 2 values of X and Y coordinates
(separated by comma) of a point. If no opening exists, then the first line must be 0.

Number of Points, n
Point_1 X, Point 1Y
Point_2 X, Point_2_Y

Point_n_X, Point_n Y

[Reinforcement Bars]

This section applies to irregular section in investigation mode only. The first line contains the number of
reinforcing bars. Each of the following lines contains 3 values of area, X and Y coordinates (separated by
comma) of a bar.

Number of bars, n
Bar_1 area, Bar_1 X, Bar_1Y
Bar_2 area, Bar_2 X, Bar_ 2 Y

Bar_n_area, Bar_n X, Bar_n_Y

[Factored Loads]

The first line contains the number of factored loads defined. Each of the following lines contains 3 values of
axial load, X-moment, and Y-moment separated by commas. (Menu Input | Loads | Factored Loads...)

Number of Factored Loads, n
Load 1, X-Moment 1, Y-Moment 1

A-8
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Load 2, X-Moment_ 2, Y-Moment 2
Lééd_n, X-Moment_n, Y-Moment_n

[Slenderness: Column]

This section contains 2 lines describing slenderness parameters for column being designed. The first line is
for X-axis parameters, and the second line is for Y-axis parameters.

There are 8 values”” separated by commas in each line. These values are described below in the order they
appear from left to right. (Menu Input | Slenderness | Design Column...)

Column clear height

k(nonsway)

k(sway)

0-Nonsway frame; 1-Sway frame

0-Compute ‘k’ factors; 1-Input k factors

(ZP)/P,

(ZPy)/P,

0-Do not ignore moment magnification along column length in sway frames; 1-Ignore moment
magnification along column length in sway frames. Use for ACI 318-11 and ACI 318-08 only. For all
other codes the value must be 0.

PN R WD

[Slenderness: Column Above And Below]

This section contains 2 lines describing slenderness parameters for column above and column below. The first
line is for column above, and the second line is for column below. (Menu Input | Slenderness | Columns
Above/Below...)

There are 6 values separated by commas in line 1 for column above. These values are described below in the
order they appear from left to right.

Concrete compressive strength, f’c
Concrete modulus of elasticity, Ec

l. 0-Column specified; 1-No column specified
2. Column Height

3. Column width (along X)

4, Column depth (along Y)

5.

6.

There are 6 values separated by commas in line 2 for column below. These values are described below in the
order they appear from left to right.

Concrete compressive strength, f’c
Concrete modulus of elasticity, Ec

1. 0-Column specified; 1-No column specified
2. Column Height

3. Column width (along X)

4. Column depth (along Y)

5.

6.

[Slenderness: Beams]
This section contains 8 lines. Each line describes a beam.

Line 1: X-Beam (perpendicular to X), Above Left
Line 2: X-Beam (perpendicular to X), Above Right
Line 3: X-Beam (perpendicular to X), Below Left
Line 4: X-Beam (perpendicular to X), Below Right
Line 5: Y-Beam (perpendicular to Y), Above Left
Line 6: Y-Beam (perpendicular to Y), Above Right

™ Value No 8 introduced in spColumn v4.60.
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Line 7: Y-Beam (perpendicular to Y), Below Left
Line 8: Y-Beam (perpendicular to Y), Below Right

There are 7 values separated by commas for each beam in each line. (Menu Input | Slenderness | X-Beams...,
Input | Slenderness | Y-Beams...) These values are described below in the order they appear from left to right.

1. 0-beam specified; 1-no beam specified
2. Beam span length (c/c)

3. Beam width

4. Beam depth

5. Beam section moment of inertia

6. Concrete compressive strength, f’c

7. Concrete modulus of elasticity, Ec
[El]

Reserved. Do not edit.

[S1dOptFact]

There is 1 value in this section for slenderness factors. (Code Default and User Defined radio buttons on
menu Input | Slenderness | factors...)

0-Code default; 1-User defined

[Phi_Delta]

There is 1 value in this section for slenderness factors. (Menu Input | Slenderness | factors...)

Stiffness reduction factor

[Cracked 1]

There are 2 values separated by commas in one line in this section. These values are described below in the
order they appear from left to right. (Menu Input |

Slenderness | factors...)

1. Beam cracked section coefficient
2. Column cracked section coefficient

[Service Loads]

This section describes defined service loads. (Menu Input | Loads | Service...) The first line contains the
number of service loads. Each of the following lines contains values for one service load.

There are 25 values for each service load in one Line separated by commas. These values are described below
in the order they appear from left to right.

Dead Axial Load

Dead X-moment at top
Dead X-moment at bottom
Dead Y-moment at top
Dead Y-moment at bottom
Live Axial Load

Live X-moment at top
Live X-moment at bottom
Live Y-moment at top
Live Y-moment at bottom
Wind Axial Load

Wind X-moment at top
Wind X-moment at bottom
Wind Y-moment at top
Wind Y-moment at bottom
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16. EQ. Axial Load

17.  EQ. X-moment at top

18. EQ. X-moment at bottom
19.  EQ. Y-moment at top

20. EQ. Y-moment at bottom
21.  Snow Axial Load

22.  Snow X-moment at top

23.  Snow X-moment at bottom
24.  Snow Y-moment at top

25.  Snow Y-moment at bottom

[Load Combinations]

This section describes defined load combinations. (Menu Input | Loads | Load Combinations...) The first line
contains the number of load combinations. Each of the following lines contains load factors for one load
combination.

Number of load combinations, n
Dead_1, Live 1, Wind_1, E.Q._1, Snow_1
Dead 2, Live 2, Wind 2, E.Q._ 2, Snow_ 2

Dead n, Live n, Wind_n, E.Q._n, Snow_n

[BarGroupType]
There is 1 value in this section. (Bar Set drop-down list on menu Options | Reinforcement...)

0-User defined
1-ASTM615

2-CSA G30.18
3-prEN 10080
4-ASTM615M

[User Defined Bars]
This section contains user-defined reinforcing bars. (Menu Options | Reinforcement...) The first line contains
the number of defined bars. Each of the following lines contains values for one bar separated by commas.

Number of user-defined bars, n
Bar_1 size, Bar_1 diameter, Bar_1 area, Bar_1 weight
Bar_2 size, Bar_2 diameter, Bar_2 area, Bar_2 weight

Bar_n_size, Bar_n_diameter, Bar_n_area, Bar_n_weight

[Sustained Load Factors]

There are 5 values separated by commas in one line in this section. Each value respectively represents
percentage of Dead, Live, Wind, EQ, and Snow load case that is considered sustained (Menu Input | Loads |
Service...).
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Conversion Factors - English to SI

To convert from To Multiply by

in. m (1000 mm) 0.025400

ft m 0.304800

Ib N (0.001 kN) 4.448222

kip (1000 Ibs) kN 4.448222
pIf (Ib/ft) N/m 14.593904

psi (Ib/in.?) kPa 6.894757
ksi (kips/in.”) MPa 6.894757
psf (Ib/ft?) N/m? (Pa) 47.88026
pef (Ib/ft%) kg/m’ 16.018460
ft-kips kN «m 1.355818
Conversion Factors - Sl to English.
To convert from To Multiply by

m (1000 mm) in 39.37008
m ft 3.28084

N (0.001 kN) Ib 0.224809
kN kip (1000 Ibs) 0.224809

kN/m plf (Ib/ft) 68.52601

MPa psi (Ib/in?) 145.0377

MPa ksi (kips/in?) 0.145038
kN/m? (kPa) psf (Ib/ft%) 20.88555
kg/m’ pef (Ib/ft’) 0.062428

kN «m ft-kips 0.737562
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Contact Information

Web Site: http://www.StructurePoint.org

E-mail: info@StructurePoint.org
support@StructurePoint.org

StructurePoint, LLC.

5420 Old Orchard Road
Skokie, IL 60077
USA

Phone: (847) 966-4357

Fax: (847) 966-1542
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